
1

 

CrossDJ
Product
Range

USER MANUAL

- CrossDJ
- Cross
- CrossDJ LE
- Using MixVibes Hardware

Fine DJ Solutions.

C

M

Y

CM

MY

CY

CMY

K

User_Manual_Coverpage_template_CPage 1   08/08/2012   11:11:46



2

Contents

MixVibes

 

•	 Contact  
For all technical or sales information, please contact your local reseller 
or MixVibes directly:

MixVibes 
4, rue de la Sablière 
92230 Gennevilliers 
FRANCE 
www.mixvibes.com

•	 Technical Support 
Please visit our online forum at http://forum.mixvibes.com

•	 Sales Questions  
Please send an email to sales@mixvibes.com
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1/  
Welcome

Welcome

Thank you for choosing MixVibes Cross and welcome to the world of digital DJing. 

MixVibes Cross is a great, compact, plug and play, digital vinyl and MIDI DJ soft-
ware for Windows and for Mac oS X. MixVibes Cross will satisfy the expectations of 
professional DJs who need a powerful and reliable DJ tool.

MixVibes Cross was designed to provide a simple and easy to use environment, so 
you can focus on mixing tracks and having fun.

Take a few minutes to run through this manual and you’ll be on your way to making 
great mixes on Cross in no time at all!

Be part of the MixVibes online community and share your experiences with other 
DJs, find help and advice, and also check for available updates. See you online on 
the forum (http://forum.mixvibes.com) or on the website (http://www.mixvibes.com).

Cross — The Software Versions
MixVibes Cross is available in different software versions and packages. The three 
software versions are:

•	 Cross Cross is the most comprehensive version of the MixVibes Cross prod-
uct family. Some feature highlights: Cross provides two players for playback 
of normal tracks, two samplers with eight sample pads each to playback loops 
and 1-shot samples. Playback can be controlled either with a controller or with 
timecode vinyl and CDs. A big collection of effects allows creative mixing. The 
ultra-precise beat synchronization will lock your mix forever with one click. The 
professionals tools for media management and the user definable smart lists 
with dynamic update help you to keep your tracks under control.

•	 CrossDJ The feature set of Cross and CrossDJ is almost identical: The  only 
thing you cannot do with CrossDJ is control playback with timecode vinyl or 
timecode CDs.

•	 CrossDJ LE CrossDJ lE is only available bundled with various controllers or 
other products from different manufacturers. CrossDJ lE offers less features 
than Cross and CrossDJ. Additionally, CrossDJ lE can only be used with the 
controller the software was bundled with. you cannot load or create MIDI pre-
sets for other controllers. More details can be found on the MixVibes website: 
http://www.mixvibes.com/content/products/cross-comparison-chart
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These three software versions are available in different packages and bundles: 

•	 Cross Software only you can buy the Cross software only package from the 
MixVibes Download shop. Buying the software only might better suit your needs if 
you already own an older MixVibes DVS system including timecode control vinyl/ 
CD and if you wish to update to Cross. your control media from earlier MixVibes 
DVS systems can be used with Cross as well. If you wish to start using Cross 
without timecode, you can download the Cross software now and buy the time-
code control vinyl/CD later at your MixVibes reseller.

•	 Cross PACK This package consists of the MixVibes Cross software, the USB 
audio interface U46MK2 with 4 inputs (2x stereo, line/Phono switchable) and 6 
outputs (3x stereo), control vinyl and control CDs as well as the cables.

•	 CrossDJ Software Only CrossDJ is the software only package. CrossDJ is 
compatible with every DJ MIDI controller and it includes many built-in MIDI 
presets for a broad range of DJ controllers.

•	 U-MIX CONTROL PRO 2 DJ Package This package consists of the DJ con-
troller U-MIX CoNTRol PRo 2 with integrated soundcard and the CrossDJ soft-
ware.

•	 U-MIX CONTROL 2 DJ Package This package consists of the DJ controller 
U-MIX CoNTRol 2 and the CrossDJ lE software.

•	 CrossDJ LE CrossDJ lE is only available bundled with various controllers or 
other products from different manufacturers

Box Contents Cross PACK 

•	 Cross installation disc

•	 U46MK2 USB audio interface

•	 2x control CDs

•	 2 x control vinyl (33 rpm, 12 inch)

•	 1 x USB cable; 2 x RCA cable; 1 x RCA y-adaptor

U-MIX CONTROL PRO 2 Box Contents 

•	 CrossDJ installation disc

•	 U-MIX CoNTRol PRo 2 – USB DJ MIDI controller with four channel (2 x stereo) 
internal audio interface

•	 1 USB cable; 1 RCA cable; 1 male RCA to male mini jack (3.5 mm)
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U-MIX CONTROL 2 Box Contents 

•	 CrossDJ lE installation disc

•	 U-MIX CoNTRol 2 - USB DJ MIDI controller

•	 1 USB cable

CrossDJ LE Box Contents 

•	 CrossDJ lE installation disc

•	 Controller of your manufacturer

•	 Further content may vary depending on the package you own

CrossDJ — Minimum System Requirements  
(no timecode control)

•	 Windows 7 or Mac oS X 10.6

•	 Intel Core 2 Duo @ 2.1 GHz or equivalent

•	 2 GB RAM

•	 Screen resolution 1280 x 720 pixels or higher

•	 one available USB port 

•	 Hard drive space for music

Cross — Minimum System Requirements  
(with timecode control)

•	 Windows 7 or Mac oS X 10.6

•	 Intel Core 2 Duo @ 2.8 GHz or Intel Core i3 @ 2.1 GHz 

•	 4 GB RAM

•	 Screen resolution 1280 x 720 pixels or higher

•	 one available USB port 

•	 Hard drive space for music

Please have look at the safety notes for U46MK2 USB, U-MIX CoNTRol PRo 2, and 
U-MIX CoNTRol 2 before using the audio interface or the controllers. The safety 
notes can be found at the end of this manual. 
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2/  
Software  
Installation

Please login to our forum (http://forum.mixvibes.com) in order to register your 
product and to check for the latest download version of MixVibes Cross. 

Insert the installation disc into the CD-RoM drive of your computer and open the 
drive in Windows Explorer or Mac Finder. Check the filename of the installer ap-
plication as it contains the version number of the software that will be installed. 

If the version available on the MixVibes website is newer than the version on your 
CD-RoM, we recommend installing the newer version instead of the one on the 
CD-RoM.

2.1 Installation on Windows
1 Insert the installation disc into the CD-RoM drive of your computer. The 

installation program will launch automatically. or launch the installer that 
you have downloaded from the MixVibes website.

ATTENTIoN Make sure that the hardware bundled with your version 
of MixVibes Cross (for example U46MK2 if you are using Cross PACK, 
or U-MIX CoNTRol PRo 2, U-MIX CoNTRol 2, or any other bundled 
controller or audio interface), is not connected during the installation 
on Windows.

This ensures that the drivers are installed first, before Windows de-
tects the audio interface and performs the Plug&Play device installa-
tion. Without the drivers being installed first, Windows tries to search 
for drivers, which should be avoided, as they are not installed yet.

 

 If the installer does not start, open Windows Explorer, navigate to the Cross 
installation disc and open it. Double-click on InstallCross.exe to launch the 
installer manually.

2 Select your language and click oK.
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3 Read the license agreement and accept it by clicking I Agree.

4 Select the components you wish to install and click Next.
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5 Select the folder where Cross shall be installed. Click Next.

6 Select the folder in your Start menu where the Cross shortcut shall be cre-
ated. Click Install to start the installation.
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7 once the installation is complete click Finish. If the checkbox Run Cross is 
activated, Cross will launch automatically.

2.2 Installation on Mac OS X
1 Insert the Cross installation disc into the CD-RoM drive of your Mac.

2 Double-click the Cross icon on your desktop.

3 Drag and drop Cross onto your “Applications” folder.
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2.3 Launching Cross
Please connect your MixVibes device (audio interface U46MK2, hybrid controller 
U-MIX CoNTRol PRo 2) before you launch Cross. Cross supports the automatic 
audio configuration of all MixVibes devices which means that you do not need to 
setup your audio routing manually.

NoTE FoR CrossDJ LE If you use CrossDJ lE then connect the control-
ler from the software/hardware bundle to your computer before you launch 
CrossDJ lE. If the controller is not connected CrossDJ lE will not start. If you 
use CrossDJ it is not necessary to connect your controller before launching 
CrossDJ.

Windows Go to Start > All Programs > MixVibes > CRoSS and click the Cross 
icon.

Mac OS X Go to Applications > Cross and double-click on Cross.

2.4 License Key
During the first launch of Cross you need to enter your license key in the following 
dialog box:

The license key can be found on the sleeve of your installation disc. Enter it and 
click Submit.
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3/ 
Basic Concepts  
of Digital DJing

MixVibes Cross is an extremely flexible DJ solution that can be used in various 
setup scenarios. This flexibility can be a bit confusing at first sight. This chapter 
provides a general overview of some of the basic concepts and terms used in the 
world of digital DJing. If you are already familiar with the concepts of digital DJing 
you may wish to skip this chapter. If you are using a digital DJ setup for the first 
time, this chapter will help you to understand the different setup scenarios and 
audio routing options that Cross has to offer.

3.1 Internal Mixer vs. External Mixer
Cross can be used with either an external mixer or by using the internal (= soft-
ware) mixer that is integrated into the Cross software. The main differences be-
tween these setups are 

•	 whether the audio from the Cross players and from the Cross samplers is 
mixed in the internal software mixer or in the external hardware mixer

•	 what audio signal is sent from Cross to the outputs of your audio interface.

Internal Mixer Mode
In internal mixer mode the audio from the Cross players and the Cross samplers is 
sent to the internal software mixer in Cross. The internal software mixer mixes the 
audio signals depending on the position of the volume fader of the players/sam-
plers, on the equalization you have made and depending on the cue/headphone 
buttons of the players. Any audio changes resulting from activated FX will also be 
mixed into the signal.

The internal mixing process of Cross sends two audio streams to your audio in-
terface: one stream contains the MIX/MASTER signal that shall be made publicly 
audible; the second stream contains the CUE signal that shall be audible in your 
headphones. 

To get optimum results you will need an audio interface that has two stereo out-
puts, like the MixVibes audio interface U46MK2. one of the outputs is used for the 
mix/master signal, the other output channel is used for the cue signal. Because of 
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the two stereo outputs needed, this routing architecture is called Dual Stereo. The 
signal flow in this routing mode is illustrated in the following figure: 

Cross Players
and Samplers

Audio Interface

USB

INPUT OUTPUT

L

1/2 1/2 3/43/4

LR R L LR R

Mix SignalCue Signal

L

R

Cue Signal

Mix Signal

A

B

D

C

Cross Mixer
(Cue, Gain, EQ, FX)

External Mixer Mode for Cross Players only
In external mixer mode the audio from the Cross players/samplers is mixed in 
the external (hardware) mixer. When you are using a setup with two Cross play-
ers only, you will need an audio interface with two stereo outputs and a 2-channel 
mixer. The signal flow for this configuration is shown in the following image:

Cross Player Cross Mixer (FX)

Audio
Interface

INPUT OUTPUT

L

1/2 1/2 3/43/4

LR R L LR R

Player BPlayer A

Player B

Player A

Mix Signal

Cue Signal

MY

L

R

USB

A

B

The audio signal from player A and player B runs through the mixer/audio engine 
of Cross; here only the effect signal is added to the signal. Then the audio of each 
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player is sent via the USB port to the connected audio interface: the audio signal of 
player A is sent to outputs 1/2, and the audio signal of player B is sent to outputs 
3/4. 

Each stereo output of the audio interface is connected with an RCA cable to the 
external mixer. you will then use the mixer to perform equalization and to mix the 
audio of both Cross players. The mix out signal of the mixer is sent to the external 
speakers (or an amplifier) and the cue/headphone signal of the mixer sent to the 
connected headphone. 

External Mixer Mode for Cross Players and Cross Samplers
If you wish to use the Cross samplers in external mixer mode you can either use an 
audio interface with two or with three stereo outputs. 

For a soundcard with three stereo outputs you should select the routing mode 
External Mixer Sampler. In this routing mode the audio of player A and player B is 
routed to a separate output of the soundcard. The audio of sampler C and D will be 
combined and sent to the third channel. you then can use the two volume faders 
of the Cross mixer to set the volume of sampler C and sampler D (or even use the 
volume faders that are available for each sample pad). 

Cross Players/Samplers Cross Mixer (FX)

Audio
Interface

Player B

Player A

Player B

Player A

Mix Signal

Cue Signal

L

R

USB

A

B

C

D

Sampler C & D

Sampler C & D

Each stereo output of the audio interface is connected with an RCA cable to the 
external mixer. you can then use the mixer to perform equalization, and to mix 
the audio of both Cross players and the combined audio of both Cross samplers. 
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The mix out signal of the mixer is sent to the external speakers (or an amplifier) 
and the cue/headphone signal of the mixer is sent to the connected headphone.

If you wish to use both Cross players and the Cross samplers, but only have an 
audio interface with stereo channels, you should use routing mode External Mixer 
Cue. In this routing mode the audio of player A and sampler C are sent to one 
output of your soundcard, and the audio of player B and sampler D is sent to the 
second output. In this setup you will use the channel faders of the mixer to control 
the volume of the combined player/sampler output and the volume faders in the 
Cross mixer and the volume faders of each sample pad to control the volume of 
the samples. The signal flow for this configuration is shown in the following figure:

INPUT OUTPUT

L

1/2 1/2 3/43/4

LR R L LR R

 Cross Players/Samplers Cross Mixer (FX)

Audio
Interface

Player B
Sampler D

Player A
Sampler C

Player B
Sampler D

Player A
Sampler C

Mix Signal

Cue Signal

L

R

USB

A

B

C

D

MY

3.2 Audio Sources: Audio Files vs.  
External Sources

Up to this point the setup scenarios describe use media files (wav, mp3, etc) as 
audio sources. These files are loaded into the Cross players or into the Cross sam-
plers. Start playback of the player or the sample pad to hear the track or sample.

As well as using media files you can also use external audio sources in Cross. 
These external audio sources can come from any device that provides an audio 
signal: a turntable, a CD player, an MP3 player such as an iPod™, an effect device, 
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and so on. To be able to use external audio sources your audio interface needs to 
be equipped with at least one input that you can connect the external source to.

The MixVibes audio interface U46MK2 for example provides two stereo inputs that 
can be used to connect external devices and to integrate them into your setup. As 
Cross is basically built on a setup with two players/decks, you can use a maximum 
of two external audio sources at the same time. The external devices are internally 
routed to one of the two Cross players.

The following figure illustrates the signal flow in internal mixing mode when using 
external audio sources.

Cross Player A/B
Cross Mixer 

(Cue, Gain, EQ, FX)

INPUT OUTPUT

L

1/2 1/2 3/43/4

LR R L LR R

Mix Cue

L

R

Cue Signal

Mix Signal
USB

CD Audio
to Player A 

In this example a CD player is connected to the inputs 1/2 of the audio interface. 
The input mode of player A (left part of the mixer panel) was set to line In. you can 
change the input mode  by clicking on the letter A or B in the Cross mixer. When 
the input mode is set to line In the audio coming from the CD player is routed into 
the Cross mixer and you can use the equalizer, the Cue button and the FX from 
player A to modify the incoming CD audio. once the audio from the external source 
is inside the mixer the rest of the game is identical to using both players with me-
dia files: the Cross mixer sends the Mix out signal and the Cue signal to the two 
output ports of your audio interface.

of course, you can use external audio sources in external mixer mode as well. In 
external mixing mode the incoming audio is passed through to the audio interface 
output, making a little detour through the Cross audio engine.

3.3 Using Timecode to control Playback
Another choice you have with Cross is using control vinyl or control CDs to control 
playback of the two players. In this timecode setup you will still play your digital 
audio files, but the playback of the files is controlled by timecode media. 
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NoTE Please note that the timecode functionality can only be used with the 
Cross software, and not with CrossDJ or CrossDJ lE.

What’s inside the Timecode Signal?
The control media does not contain music, but a control signal constructed from 
two sinus waves. The Cross timecode engine extracts three different types of in-
formation from the incoming timecode signal:

•	 Playback speed of the control vinyl or control CD, respectively,

•	 Playback direction (forward, backwards) and 

•	 Current playback position of the control vinyl or of the control CD

The detection of the current playback speed isn’t too complicated because the 
timecode engine knows the original frequency of the timecode signal. If the play-
back speed is slower than the original tempo, then the frequency of the incoming 
timecode signal is lower than the original frequency. If the rotation speed of the 
turntables or CD player is higher than 100%, then the frequency increases. The 
timecode engine analyses the frequency of the incoming signal and uses the dif-
ference between the original and the incoming frequency to calculate the current 
tempo. Cross can then adjust the playback speed of the deck to the playback speed 
of the timecode medium.

Because Cross uses the frequency to calculate the speed you must never activate 
the Master Tempo feature available on many CDJ players, because the Master 
Tempo function corrects the tone pitch. This is unwanted when using timecode.

If you are using turntables, that always flutter, the BPM display on a Cross player 
controlled by timecode is never stable; this reflects the flutter of the turntables.

For forward playback the frequency information is sufficient but it is not enough 
to determine whether the timecode medium is moving forward or backwards. This 
information is absolutely necessary when scratching or manual beat matching. To 
detect the playback direction, the timecode signal is constructed from two sinus 
waves, one for the left and another one for the right channel. The phases of both 
waves are slightly shifted. This can be seen in the following figure that simulates 
this (let’s assume the upper wave is for the left and the lower one for the right 
channel).



3/ Basic Concepts of Digital DJing

21

Left Channel

Right Channel

Cross uses this phase shifting to detect forward and backwards playback. When 
the control vinyl is playing forward, the right channel will be ahead of the left chan-
nel. And when the control vinyl is playing backwards, the right channel will be 
behind the left channel. Simply put, this is the trick by which the timecode engine 
in Cross  can detect the playback direction.

This is also the reason why Cross always requires the timecode signal of the left 
and the right channel to function properly. If one channel is missing (maybe be-
cause one cable is not connected or because the contacts of the cartridge are 
black or dirty) playback will not be possible. 

How does Cross recognise the current playback position? Here timestamps are 
used, which are binary coded into the timecode signal. If you have a very close look 
at a piece of timecode vinyl you will see little data packages as small boxes, where 
the position information is hidden.

The position detection is the most enhanced part of using timecode, and it is error-
prone so this is why all digital vinyl systems use some kind of error detection and 
correction. However, the better and clearer the timecode signal is, the more ac-
curately the current position can be detected. Dusty or worn needles, dirty vinyl 
or an unclean audio signal resulting from ground hum, defect cabling between 
the turntable/CDJ and the audio interface or between the pick-up and cartridge 
all have an impact on the timecode signal received by the timecode engine inside 
Cross. In order to be able to use timecode properly not only should you make sure 
that all Cross software settings are correct, but also that your “physical tools” are 
in good condition.

Admittedly, the description above is greatly simplified. The goal was not to cover 
the complex timecode processing in Cross, but rather to provide some technical 
background about how a Digital Vinyl System (DVS) works in general, what is going 
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on before the initial sound comes out of the speakers and to provide some helpful 
knowledge for troubleshooting purposes.

The Signal Path when using Timecode
When using control media with timecode information the signal flow between the 
different components is slightly different than in a setup without timecode. The fol-
lowing figure illustrates the signal path of the timecode signal and the audio signal 
when Cross is configured for timecode usage with an external mixer.

Timecode

Timecode

Audio

Audio

MixerUSB

In this setup the signal flows through the following four stations:

•	 The turntable and the CD player in the figure send timecode data to the con-
nected audio interface, here the U46MK2. Both devices are connected to the 
inputs of the audio interface. Even when using turntables do not use phono 
preamps; if you use an audio interface with a line/Phono input switch like the 
U46MK2, set it to line. This ensures that Cross can deal with the raw input 
signal:

•	 The incoming timecode data is sent from the inputs of the audio interface via 
the USB connection to Cross and inside Cross to the players that are configured 
for timecode usage.

•	 The timecode engine of Cross  modifies the audio signal of the assigned player 
according to the tempo and direction and position of the timecode data. The 
resulting audio signal is sent via the USB connection to the outputs of the audio 
interface.

•	 The outputs of the audio interface are connected to the inputs of the mixer 
where the audio signal is received. For both timecode vinyl and timecode CDs 
the outputs of the audio interface need to be connected to the line inputs of 
the mixer.
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This means for cabling:

•	 Connect the turntable/CDJ player to the inputs of your audio interface.

•	 Connect the outputs of the audio interface with the line inputs of your mixer 
even if you are using turntables/timecode vinyl.

3.4 Controlling Cross with the Keyboard and with 
DJ controllers

you can use CrossDJ with the mouse alone. However this is not the quickest way to 
access all the features. Things get much easier if you use a DJ controller. 

If you bought the U-MIX CoNTRol PRo 2 package, a controller that is perfectly 
integrated with the Cross software is part of the bundle. U-MIX CoNTRol PRo 2 is 
a hybrid controller with an integrated audio interface. Additionally, the jogwheels 
on the U-MIX CoNTRol PRo 2 are touch sensitive . 

CrossDJ lE can be bundled with controllers from various manufacturers. The lay-
out of the controls on the controller may vary, but you will find all controls that are 
needed to perform your set.

There are plenty of other DJ controllers available on the market today. If the DJ 
controller can send MIDI messages, it will work with Cross. 

How does the Cross software know which action should be triggered when you 
press a button on the controller or when you turn a knob or move a fader? Every 
time you press a button on your controller, or move a knob or fader, the controller 
sends a message to the Cross software. These messages are called MIDI mes-
sages as they use a protocol that is defined in the MIDI specification. MIDI is the 
abbreviation of Musical Instrument Digital Interface, an interface definition from 
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the early 80s. The MIDI protocol is one of the components of the MIDI specification 
and defines the structure and content of communication between a MIDI sender 
(master) and a MIDI receiver (slave).

Whenever Cross receives a MIDI message, the software looks into a table that ba-
sically consists of two columns: one column contains information about the mes-
sage and the second column contains information about the action, that shall be 
triggered when that message is received. If there is a match between the incoming 
message and a row in the table, the corresponding action is triggered.

The whole process of connecting a MIDI message to an action is called mapping. 
The term mapping, or better controller mapping, is also used for the “tables” ex-
plained above. The tables contain the information of how one particular controller 
is mapped to the action that Cross provides. 

For many controllers Cross already provides ready-to-use mappings; so you do 
not need to create the mapping yourself. The only thing you have to do is to tell 
Cross on which USB port which controller is connected. This is explained in the 
next chapter. The same mapping concept is also used for the keyboard. Cross con-
tains a standard mapping for your keyboard. It allows access to the most important 
actions. The default keyboard shortcuts are listed in the following chapters of this 
manual.
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4/ 
Connect and  
Configure your 
Hardware

This chapter explains how to connect your different hardware components. The 
steps you need to perform depend on whether you use a controller, and if you wish 
to use Cross in internal or external mixer mode. Also dependant is if you wish to 
use external audio sources like a turntable, a CDJ player or an MP3 player with 
your audio files on your computer and if you wish to use the timecode features of 
Cross.

In the default setting Cross will configure all MixVibes audio interfaces automati-
cally when they are plugged in. You can find the corresponding option Auto-select 
MixVibes devices at startup on the Preferences/Audio dialog. If you have multiple 
MixVibes audio interfaces Cross selects them in the following: U46MK2, U-MIX44 
U-MIX CoNTRol PRo 2, and U-MIX CoNTRol PRo. 

4.1 U-MIX CONTROL PRO 2 in Internal Mixer Mode
The U-MIX CoNTRol PRo2 2 hybrid controller has an integrated audio interface 
with two stereo outputs. one of the outputs is used for the Mix out signal, the other 
one is used for the Headphone/Cue signal. 

1 Use the RCA cable and connect outputs 1/2 of your U-MIX CoNTRol PRo 2 
to the sound system (amplifier, powered speakers, or home stereo).

2 Connect your headphones to one of the Headphones sockets on the front 
panel of your U-MIX CoNTRol PRo 2. 

3 If you wish to use a microphone connect it to the Microphone input on the 
front panel of your U-MIX CoNTRol PRo 2.

4 Connect the U-MIX CoNTRol PRo 2 with the USB cable to your computer.

5 Switch the U-MIX CoNTRol PRo 2 on by setting the on/off switch at the 
rear panel of the controller to USB. If you are using Windows and if this 
is the first time you have switched the controller on, please wait until the 
necessary drives are installed.
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6 launch Cross.

7 open the File menu and click Preferences or click on the Prefer-
ences button in the toolbar. Click the Audio tab to open the audio 
settings panel. Here you can configure your audio settings.

8 open the upper list box Audio Device and select MixVibes ASIo U-MIX CoN-
TRoL PRo 2. you can leave the settings for sample rate and buffer size at 
their default values.

9 open the list box Routing Mode and select Dual Stereo. This routing option 
is to be used for internal mixing mode and if you use an audio interface with 
two stereo outputs.

10 open the list box output 1. on Windows select U-Mix Control Pro 1/U-Mix 
Control Pro 2 and on oS X select output 1/2, if these outputs are not al-
ready selected. This output receives the Master out signal.

11 open the list box output 2. on Windows select U-Mix Control Pro 3/U-Mix 
Control Pro 4 and on oS X select output 3/4, if these outputs are not already 
selected. This output receives the Cue/Monitor signal.

 The routing image in the lower part of the dialog shows the how the audio 
is routed from the Cross mixer to your audio interface. The Audio panel 
should look as shown in the following figure:
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4.2 U-MIX CONTROL PRO 2 in External Mixer Mode
If you have an external mixer you can use this mixer to mix the audio coming from 
the two Cross players. The mixer section of the U-MIX CoNTRol PRo 2 controller 
is disabled in this setup. However, all other controls of the controller are available 
to add FX, to use the sample pads or to use locators, for example. The following 
steps explain how to connect the components and how to configure the audio rout-
ing in Cross.

1 Use an RCA cable and connect outputs 1/2 of your U-MIX CoNTRol PRo 2 
to line input 1 of your mixer.

2 Use another RCA cable and connect outputs 3/4 of your U-MIX CoNTRol 
PRo 2 to a line input 2 of your mixer.

3 Connect your headphones to the Headphones sockets on your mixer. 

4 If you wish to use a microphone connect it to the Microphone input on your 
mixer.

5 Connect the U-MIX CoNTRol PRo 2 with the USB cable to your computer.

6 Switch the U-MIX CoNTRol PRo 2 on by setting the on/off switch at the 
rear panel of the controller to USB. If you are using Windows and if this 
is the first time you have switched the controller on, please wait until the 
necessary drives are installed.
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7 launch Cross.

8 open the File menu and click Preferences or click on the Prefer-
ences button in the toolbar. Click the Audio tab to open the audio 
settings panel. Here you can configure your audio settings.

9 open the upper list box Audio Device and select MixVibes ASIo U-MIX CoN-
TRoL PRo 2. you can leave the settings for sample rate and buffer size at 
their default values.

10 open the list box Routing Mode and select External Mixer Cue. Take a look 
at the diagram in the lower part of the dialog box. you can see that the 
CRoSS MIXER connects the output of player A and sampler C to output 1 of 
your soundcard. Player B and sampler D are connected to output 2.
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11 open the list box output 1. on Windows select U-Mix Control Pro 1/U-Mix 
Control Pro 2 and on oS X select output 1/output 2. This output receives 
the signal from player A and from sampler C. 

12 open the list box output 2. on Windows select U-Mix Control Pro 3/U-Mix 
Control Pro 4 and on oS X select output 3/output 4. This output receives 
the signal from player B and from sampler D.

4.3 U-MIX CONTROL PRO 2 and External Audio 
Sources 

It is very easy to integrate external audio sources into your Cross setup. An internal 
audio source can be a turntable, a CD player, an MP3 player or any other device 
that provides a line level audio signal. you need an audio interface that has at least 
one input; otherwise it is not possible to use external audio sources.

To configure external audio sources three steps need to be performed:

•	 Make the cable connection and configure the input mode of your audio interface 
input port 

•	 Route the external audio source as input channels into the Cross software 
mixer

•	 Set the player input mode to line In
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ATTENTIoN Before proceeding with the configuration of external audio 
sources make sure that you have configured Cross for either internal or exter-
nal mixer mode as explained in the previous section.

Making the Cable Connections
The following steps explain how to connect the different components.

1 If you wish to connect a turntable, connect the ground of your turntable to 
the ground lug on the U-MIX CoNTRol PRo 2.

2 Connect the outputs of your external audio source to the RCA inputs of your 
U-MIX CoNTRol PRo 2. Plug the left device into inputs 1/2 and the right 
device into inputs 3/4.

 Make sure that the left channel (plug is usually white) is connected to the 
white RCA sockets on the U-MIX CoNTRol PRo 2, and that the right chan-
nel (usually red) is connected to the red sockets.
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3 Perform one of the following actions:

•	 Turntable with Phono output Set the input selector for the inputs 
where the turntable is connected to, to PHoNo.

•	 Turntable with Line output, CDJ Player, MP3 Player  Set the input 
selector for the inputs where the line device is connected to lINE. 

Routing External Audio into the Cross Mixer
once your external audio source is connected to your audio interface you need to 
tell Cross, which input port of your audio interface shall be assigned as left Input 
and as Right Input. 

1 open the File menu and click on Preferences or click on the Pref-
erences button in the toolbar. open the Audio tab of the Cross 
Preferences dialog.
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2 open the list box Input 1 and select the input ports of your audio interface 
to which the external device is connected. Input channel 1 can be used as 
line-In input for mixer channel  A.

 If you use U-MIX CoNTRol PRo 2 select U-Mix Control Pro 1/U-Mix Con-
trol Pro 2 on Windows or select input 1/input 2 on oS X.

3 open the list box Input 2 and select the input ports of your audio interface 
to which the external device is connected. Input channel 2 can be used as 
line-In input for mixer channel B.

 If you use U-MIX CoNTRol PRo 2 select U-Mix Control Pro 3/U-Mix Con-
trol Pro 4 on Windows or select input 3/input 4 on oS X.

4 open the Line/Phono dropdown list in section Input 1 and/or section Input 
2. Select Line, if you connect a line-level device or select Phono if you con-
nect a turntable without a pre-amplifier.

5 Use the Input Gain sliders next to the Line/Phono dropdown list to adjust 
the input gain for your audio device. Make sure that the input level is high 
enough but also that audio clipping is avoided. Setting the input gain is es-
pecially useful if you connect an MP3 player like the iPod.

Setting the Channel Source to Line-In
The last step that needs to be done is to set the Input Mode of the Cross channel to 
line-In, if you wish the external audio source to be heard through the mixer. The 
input mode button can be found in the upper section of the Mixer panel. 
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Please note that the line-In input of channel strip A is always fed by stereo input 1 
and that line-In input of channel strip B is always fed by stereo input 2.

Player A is set to
Input Mode Player

Player B is set to
Input Mode Line-In

you can set the input mode to Player or to line-In.

•	 Player When the input mode is set to Player the audio from the media file is 
sent to the Cross mixer.

•	 Line-In When the input mode is set to line-In, the external audio signal is 
sent to the Cross mixer. Which of the external inputs is sent to either player A 
or B depends on the selection you made in the Cover panel of the player (see 
previous section).

If you use either U-MIX CoNTRol PRo 2 or U-MIX CoNTRol 2 you can set the input 
mode on the controller by holding the SHIFT button and pressing the Headphones/ 
Source button.

4.4 Cross and U46MK2 in Internal Mixer Mode
If you have Cross PACK with the U46MK2 audio interface and wish to configure 
your setup for internal mixer mode without using timecode, perform the following 
steps. 

In this configuration one of the stereo outputs of U46MK2 is used for the Master/
Mix out signal, the other one is used for the Headphone/Cue signal. 

1 Use the RCA cable and connect outputs 1/2 of your U46KM2 to the sound 
system (amplifier, powered speakers, or home stereo).

2 Connect your headphones to outputs 3/4 of your U46MK2 by using the RCA 
to mini-jack y adapter included in the package.
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3 Connect the U46MK2 with the USB cable to your computer.

4 Switch the U46MK2 on by using the PoWER button on the front side. If you 
are using Windows and if this is the first time you have switched the sound-
card on, please wait until the necessary drives are installed.

5 launch Cross.

6 open the File menu and click Preferences or click on the Prefer-
ences button in the toolbar. Click the Audio tab to open the audio 
settings panel. Here you can configure your audio settings. 

7 open the upper list box Audio Device and select MixVibes ASIo U46MK2 
(Windows) or U46DJ (Mac oS X). you can leave the settings for sample rate 
and buffer size at their default values.

8 open the list box Routing Mode and select Dual Stereo. This routing option 
is to be used for internal mixing mode and if you use an audio interface with 
two stereo outputs.

9 open the list box output 1. Select U46DJ 1/U46DJ 2 on Windows or output 
1/2 on oS X if these outputs are not already selected. This output receives 
the Master out signal.

10 open the list box output 2. Select U46DJ 3/U46DJ 4 on Windows or output 
3/4 on oS X if these outputs are not already selected. This output receives 
the Cue/Monitor signal.



4/  Connect and Configure your Hardware

34

The routing image in the lower part of the dialog shows the how the audio is routed 
from the Cross mixer to your audio interface.

4.5 Cross and U46MK2 in External Mixer Mode
If you have an external mixer you can use this mixer to mix the audio coming from 
the two Cross players. The following steps explain how to connect the components 
and how to configure the audio routing in Cross.

1 Use an RCA cable and connect outputs 1/2 of your U46MK2 to line input 1 
of your mixer.

2 Use another RCA cable and connect outputs 3/4 of your U46MK2 to line 
input 2 of your mixer.

3 If you use a three channel mixer or a mixer with an FX return bus, use 
another RCA cable and connect outputs 5/6 of your U46MK2 to the third 
line input of your mixer. you can use this third channel for the two Cross 
samplers.

4 Connect your headphones to the Headphones sockets on your mixer. 

5 If you wish to use a microphone connect it to the Microphone input of your 
mixer.
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6 Connect the U46MK2 with the USB cable to your computer.

7 Switch the U46MK2 on by using the PoWER button on the front side. If you 
are using Windows and if this is the first time you have switched the sound-
card on, please wait until the necessary drives are installed.

8 launch Cross.

9 open the File menu and click Preferences or click on the Prefer-
ences button in the toolbar. Click the Audio tab to open the audio 
settings panel. Here you can configure your audio settings.

10 open the upper list box Audio Device and select MixVibes ASIo U46MK2 
(Windows) or U46DJ (Mac oS X). you can leave the settings for sample rate 
and buffer size at their default values.

11 Perform one of the following actions:

•	 If you have a two channel mixer open the list box Routing Mode and se-
lect External Mixer Cue. In this routing mode the audio of player A and 
sampler C is routed to one output, and the audio of player B and sampler 
D is routed to the second output (see the explanation on page 18). 

•	 If you have a three channel mixer, open the list box Routing Mode and 
select External Mixer Sampler. Take a look at the diagram in the lower 
part of the dialog box. you can see that the CRoSS MIXER connects the 
output of player A to output 1 of your soundcard. Player B is connected 
to output 2. The output of sampler C and D is connected to output 3.
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12 Check the list boxes output 1, output 2, and output 3 and make sure that 
the following options are selected:

•	 output 1: U46DJ 1/U46DJ 2 (Windows) or output1/output 2 (oS X)

•	 output 2: U46DJ 3/U46DJ 4 (Windows) or output3/output 4 (oS X) 

•	 output 3: U46DJ 5/U46DJ 6(Windows) or output5/output 6 (oS X)

4.6 Cross and U46MK2 with Timecode
As Cross is a Digital Vinyl System (DVS), you can use your turntable or your CDJ 
player to control the playback of the decks with the timecode control media (vi-
nyl and CD) from your Cross or Cross PACK package. This section explains which 
steps you need to perform to get this setup up and running:

•	 Make the cable connection and configure the input mode of your audio inter-
faces input ports 

•	 Perform your timecode setup and calibrate the timecode engine 

•	 Assign the timecode inputs to the players 

ATTENTIoN Before proceeding with the timecode configuration you should 
make sure that you have configured Cross either for internal or external mix-
er mode as explained in the previous section.
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Making the Cable Connections and Configuring the Inputs
The following steps explain how to connect the different components.

1 If you wish to connect a turntable, connect the ground of your turntable to 
the ground lug on the U46MK2.

2 Connect the outputs of your external audio source to the RCA inputs of your 
U46MK2. Plug the left device into inputs 1/2 and the right device into inputs 
3/4.

 Make sure that the left channel (plug is usually white) is connected to the 
white RCA sockets on the U46MK2, and that the right channel (usually red) 
is connected to the red RCA sockets.

RE
AR

USB

TURNTABLECD PLAYER

PHONO
LINELN  PH

SOFTWARE
MIXVIBES TURNTABLE CD PLAYER

FR
ON

T

3 Perform one of the following actions:

•	 Turntable with Phono output for Timecode Vinyl Set the input selec-
tor for the inputs where the turntable is connected to, to lINE. 

•	 Turntable with Line output, CDJ Player Set the input selector for the 
inputs where the line device is connected to, to lINE. 

4 open the File menu and click on Preferences or click on the Preferences 
button in the toolbar. open the Audio tab of the Cross Preferences dialog.

5 open the list box Input 1 and select the input ports of your audio interface 
to which the external device is connected.

 If you use U46MK2 select U46DJ 1/U46DJ 2 on Windows and select input1/
input2 on oS X.

6 open the Line/Phono dropdownlist in section Input 1 and select Line if you 
connect a line-level device or select Phono if you connect a turntable with-
out a pre-amplifier.



4/  Connect and Configure your Hardware

38

7 open the list box Input 2 and select the input ports of your audio interface 
to which the external device is connected.

 If you use U46MK2 select U46DJ 3/U46DJ 4 on Windows and select input3/
input4 on oS X.

8 open the Line/Phono dropdownlist in section Input 2 and select Line if you 
connect a line-level device or select Phono if you connect a turntable with-
out a pre-amplifier.

Configuring Timecode Settings
once your turntables/CDJ players are connected and their signal is routed, pro-
ceed as follows to configure the timecode settings and to calibrate the timecode 
engine:

1 open the File menu and click on Preferences or click on the 
Preferences button in the toolbar. open the Vinyl/CD tab of the 
Cross Preferences dialog.

2 Activate Control Deck 1 and/or Control Deck 2 to enable external 
timecode control.

 Activating these checkboxes enables the timecode engine for the left con-
trol deck and the right control deck respectively. If you do not activate them, 
the input signal is treated as an audio signal and not as a timecode signal.

3 open the list Control Media and select the timecode medium that you wish 
to use on the left/right control deck. Choose one of the following options: 
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MV Vinyl, MV CD, 7” MV Vinyl or Sinus 3 kHz. Use one of the first three op-
tions depending on the MixVibes timecode media you wish to use. 

 Select Sinus 3kHz if you use a Denon DN-S3700 or DN-S1200 media player 
in Hybrid MIDI mode and make sure that the player is set to the correct DVS 
output control signal. More information about how to configure your Denon 
media player can be found in the “Hybrid MIDI operation manual”, this can 
be downloaded from the Denon website. Also make sure that you have up-
dated your media player to the most current firmware version.

4 Start playback of your turntable/CDJ player. Set the pitch fader to zero and 
make sure that the playback direction is forward. If your player has a Mas-
ter Tempo function or any integrated effects, make sure that they are dis-
abled because they interfere with the calibration and with using timecode 
in general (see section 3.3, “Using Timecode to control Playback” on page 
19 for more information).

5 Click the Calibrate buttons in sections Control Deck 1 and Control Deck 2. 
Cross will automatically set the input gain level if you are using turntables 
to an appropriate value to optimize the decoding quality.

 once the calibration is done the calibration graphs will display rings similar 
to the ones shown in the following figure. Please note that the rings differ 
slightly for control vinyl (control deck 1) and control CDs (control deck 2).
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 Quality  The detected timecode quality is shown in percentage below the 
calibration graph. The value must be 90% or higher for timecode to function 
properly. If the value is between 70% and 90% the timecode signal detec-
tion is not optimal, but you should still be able to use timecode. If the value 
is below 70% timecode usage is not possible.

 L/R The Inv button in the l/R section can be used to invert the left and 
the right timecode channel. Cross needs this information to distinguish be-
tween forward and backward playback. If the left and the right channel are 
inverted (cabling, connections in the cartridge) Cross can detect this auto-
matically during calibration and the Inv button will be activated. However, it 
is better to connect the left and the right channel properly on the hardware 
side.

 P/A Some needles produce a phase inversion, that Cross can detect au-
tomatically during the calibration. In this case the Inv button in the P/A 
section will be activated.

 Threshold you can use the Threshold slider if there is rumbling, electri-
cal problems (hum), bad ground or other noise when you use turntables. 
The default setting for Threshold is –40dB. you can increase the value to 
maybe –35dB to tell Cross that this noise shall be interpreted as silence. 
To achieve better timecode sensitivity you may wish to lower the threshold, 
maybe to –45dB.

6 Close the Preferences window.

7 Click on the Show/Hide Cover button at the inner side of the player to open 
the cover panel. Use the buttons 1 and 2 to select which control deck (1 or 
2) will control which player (A, B)

Timecode
Quality

Assign Control Deck
to Player

Assign Control Deck
to Player

Show/Hide CoverShow/Hide Cover

 The above image shows a standard configuration: control deck 1 is as-
signed to player A and control deck 2 is assigned to player B. The quality 
meter in the lower section of the panel gives you a visual indication of the 
timecode quality during playback.
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4.7 Cross and U46MK2 with  
External Audio Sources 

It is very easy to integrate external audio sources into your Cross setup. An internal 
audio source can be a turntable, a CD player, an MP3 player or any other device 
that provides a line level audio signal. you need an audio interface that has at least 
one input; otherwise it is not possible to use external audio sources.

To configure and use external audio sources several actions need to be done:

•	 Make the cable connection and configure the input mode of your audio interface 
input port 

•	 Route the external audio source as input channels into the Cross software 
mixer

•	 Set the player input mode to line In

ATTENTIoN Before proceeding with the configuration of external audio 
sources make sure that you have configured Cross for either internal or ex-
ternal mixer mode as explained in the previous section.

Making the Cable Connections
The following steps explain how to connect the different components.

1 If you wish to connect a turntable, connect the ground of your turntable to 
the ground lug on the U46MK2.

2 Connect the outputs of your external audio source to the RCA inputs of your 
U46MK2. Plug the left device into inputs 1/2 and the right device into inputs 
3/4.

 Make sure that the left channel (plug is usually white) is connected to the 
white RCA sockets on the U46MK2, and that the right channel (usually red) 
is connected to the red RCA sockets.
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3 Perform one of the following actions:

•	 Turntable with Phono output for Audio Vinyl Set the input selector 
for the inputs where the turntable is connected to, to PHoNo. The input 
selector can be found on the front panel of the U46MK2.

•	 Turntable with Line output, CDJ Player, MP3 Player Set the input  
selector for the inputs where the line device is connected to, to lINE. 

Routing External Audio into Cross
once your external audio source is connected to your audio interface you need to 
tell Cross, which input port of your audio interface shall be assigned as left Input 
and as Right Input. 

1 open the File menu and click on Preferences or click on the 
Preferences button in the toolbar. open the Audio tab of the 
Cross Preferences dialog.

2 open the list box Input 1 and select the input ports of your audio 
interface to which the external device is connected. Input 1 can be used as 
input for channel strip A.

 If you use U46MK2 select U46DJ 1/U46DJ 2 on Windows and select input1/
input2 on oS X.

3 open the list box Input 2 and select the input ports of your audio interface 
to which the external device is connected. Input 2 can be used as input for 
channel strip B.

 If you use U46MK2 select U46DJ 3/U46DJ 4 on Windows and select input3/
input4 on oS X.
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4 open the Line/Phono dropdown in section Input 1 and/or section Input 2. 
Select Line, if you connect a line-level device or select Phono if you connect 
a turntable without a pre-amplifier.

5 Use the Input Gain sliders next to the Line/Phono dropdown list to adjust 
the input gain for your audio device. Make sure that the input level is high 
enough but also that the audio clipping is avoided. Setting the input gain is 
especially useful if you connect an MP3 player like the iPod.

6 open the Vinyl/CD tab of the Cross Preferences dialog.

7 Deactivate both Control Deck 1 and Control Deck 2 checkboxes. 
The Vinyl/CD panel should look like this:

 This step is necessary so that Cross knows the input contains an audio sig-
nal and not a timecode signal.

Set Source of Mixer Channel to Line-In
Once you have configured the routing for the Input 1 and Input 2 as described in the 
previous section, you now can set the source of the mixer channel to line-In. See 
page 31 for a detailed description on how to proceed.

4.8 Configuring other Soundcards 
If you use any audio interface other than the U46MK2 this section will provide all 
the information that is necessary to get your soundcard up and running with Cross. 
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In general you can use any soundcard with Cross. However, using a soundcard 
that has at least two stereo outputs gives the best results and a better experience. 
If you wish to use Cross with timecode control media or if you wish to integrate 
external audio sources, like a turntable, CD player, MP3 player etc into your setup, 
then you will need an audio interface that has one stereo input for each device you 
wish to connect.

1 Connect your equipment (audio interface, speakers/amplifier, headphones) 
by performing one of the following actions:

•	 If you use Cross in internal mixer mode connect the speakers/your am-
plifier and your headphones to the corresponding outputs of your au-
dio interface. Some DJ audio interfaces have a designated headphone 
output, sometimes you can assign one of the available outputs as the 
headphone output. Please consult the manual of your audio interface 
for more information. 

•	 If you use Cross in external mixer mode connect each stereo output of 
your audio interface to a stereo input on your mixer.

2 If you wish to integrate external audio sources, like a turntable, a CD player 
or an MP3 player, into your setup, perform the following actions:

•	 Connect the components you wish to use to the inputs of your audio 
interface. 

•	 If you are using a turntable that provides a Phono level signal and if your 
audio interface has a switch to toggle the input between Phono and line, 
make sure that the switch is set to Phono.

3 open the File menu and click on Preferences. open the Audio tab 
of the Cross Preferences dialog.

4 open the Audio Device dropdown list and select the audio inter-
face/driver that Cross shall use.

 Windows If you are running Cross on Windows, the dropdown list shows 
all audio drivers installed on your computer, even when the audio interface 
is not currently connected. 

 The dropdown list on Windows contains two sections. one section is la-
belled DirectSound and the second one ASIo. Two drivers are often in-
stalled for the same audio interface; one using the ASIo protocol and the 
other one using the DirectSound driver architecture. If both drivers are 
available you should use the ASIo driver as ASIo drivers generally offer 
better performance than DirectSound drivers (see sidebar on page 48 ).
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TIP If no ASIo driver for your audio interface is available you can 
use the ASIo4All driver as an alternative. ASIo4All is a hardware 
independent low latency ASIo driver for Windows audio devices and 
acts as a layer between the DirectSound driver and the audio ap-
plication, which here is Cross. once you have installed ASIo4All 
you need to configure the driver and tell it, which Windows audio 
drivers it should use. Then you should select the ASIo4All driver in 
the Cross audio setup.

Using ASIo4All can lead to better audio performance, to lower la-
tency time and can help to avoid clicks and pops. Even though a 
guarantee cannot be given, checking ASIO4ALL is definitely worth 
while.

Please note that the latency time when using ASIo4All is always 
greater than with a generic ASIo driver because the audio data from 
Cross is first sent via the ASIO protocol to ASIO4ALL and then via the 
WDM protocol to the audio interface. For this reason using ASIo-
4All should be seen more as a workaround.

 oS X If you are running Cross on oS X only the currently available and 
connected audio interface is shown. All drivers you see in the list are Core 
Audio drivers.

5 Click the Sample Rate button with the sample rate you wish to use. 
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 The default setting is 44.1 kHz, which is the same sampling rate used by 
audio CDs. In most cases this default setting is acceptable.  

 By changing the sample rate you instruct Cross that all audio data it sends 
to your audio interface has to be at the selected sample rate. This means 
that even compressed audio file formats (like MP3), need to be re sampled 
by Cross before the audio is sent to the outside world.

 If you only use standard WAV files that have a sample rate of 44.1 kHz the 
sound will not be improved when you change the sample rate to 88.2 kHz, 
for example. However, if you use your own audio material that has a higher 
sample rate it makes sense to change the sample rate that Cross will use.

6 Use the slider Buffer size to change the latency time of your audio inter-
face. The default buffer size is 256 samples. 

 The latency time is a measure of the time it takes until an action in Cross 
(like jumping to a locator) is audible. Generally speaking a latency time 
around 10 milliseconds is considered an adequate and decent value.

TIP If you hear clicks and pops in the audio output of Cross or if the 
audio output is interrupted then in most cases the solution is to in-
crease the latency time. Why this helps and the reasons for the distor-
tions are explained in the sidebar on page 48.

7 If you are using external audio sources open the list boxes Input 1 and Input 
2 and select the inputs of your audio interface that the devices are con-
nected to.

 once you select an input port you will see a slider that you can use to 
change the input gain of that input, and a list box to select whether a Phono 
level or a line level device is connected.

8 open the list output 1 and perform one of the following actions:

•	 If you use Cross in external mixer mode select the outputs of your audio 
interface where Cross shall send the audio from player A to.

•	 If you use Cross in internal mixer mode select the outputs of your audio 
interface where Cross shall send the Master/Mix signal to. 

9 open the list output 2 and perform one of the following actions:
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•	 If you use Cross in external mixer mode select the outputs of your audio 
interface where Cross shall send the audio from player B to.

•	 If you use Cross in internal mixer mode select the outputs of your audio 
interface where Cross shall send the Cue/Headphone signal to. 

9 If you are using external mixer mode. and if your mixer has at least three 
channels and if your soundcard has at least three stereo outputs, open the 
list output 3 and select the third stereo output of your soundcard. This out-
put will receive the audio of sampler C and D.

 

The outputs available in the list boxes depend on the audio interface/ 
driver that you selected in step 4. The screenshot above uses an  
M-Audio FireWire soundcard as an example.

10 open the Routing Mode list box and select the routing mode you wish to 
use.

 Cross provides four different routing modes where each option supports a 
different usage scenario:

•	 Dual Stereo Use this option if you have an audio interface with two ste-
reo outputs and if you wish to use the internal Cross mixer. one output 
is used for the Master/Mix out signal; the other one is used for the Cue/
Headphone signal.

•	 External Mixer Sampler Use this option if you use Cross in external 
mixer mode and if you have a three channel mixer and a soundcard with 
three stereo outputs. In this mode the output of each Cross player is 
sent to a dedicated output on your audio interface and the audio of sam-
pler C and D is sent to the third output.

•	 External Mixer Cue Use this option if you use Cross in external mixer 
mode and if you have a two channel mixer and a soundcard with two 
stereo outputs. In this mode the audio of player A and of sampler C is 
sent to one output and the audio of player B is sent to the second output.

•	 Simple Stereo In this mode the sum of the Master and Cue/Monitor 
signals are routed to one output on your audio interface. you can use 
this option when using an audio interface with only one output (normally 
the internal soundcard of your laptop). 
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•	 Split Mono Use this option if you only have one stereo output. This is 
usually the case with almost all soundcards that are integrated into lap-
tops. Cross sends the Master/Mix out signal to the left channel of the 
output and the Cue/Headphone signal to the right channel of the output. 
You get two mono signals in this configuration but you are still able to 
use the cue/monitor feature of Cross.

NoTE When using Split Mono or Simple Stereo you need only to 
perform step 9 (setting output 1), as with both routing modes, only 
one output is needed.

Sidebar: ASIO, Latency and Buffer Size
As a general rule the lower the latency time, the better. But: a low latency time can 
cause some issues. one is caused by the method by which the audio data is sent 
from the application (in our case Cross) to the audio interface (to be more precise: 
to its digital-to-analogue converter, which transforms the audio data into audible 
sound).

To guarantee a continuous data stream the audio drivers provide a data buffer. 
Cross writes the generated audio data into this buffer. The audio driver then trans-
fers the received data to the audio interface hardware and the hardware makes 
the data audible. To achieve a lower latency the data buffer needs to be as small 
as possible. With a small buffer the amount of audio data is very small and Cross 
needs to update the data buffers more often to make sure that the data stream is 
not interrupted. 

The buffers need to be refreshed very rapidly after each action that is performed 
in Cross, and the result of this action is audible because of the small size of the 
buffers.

However, the problem here is that Cross needs to share the processor time with 
other applications and the operating system. If Cross cannot update the data buf-
fers quickly enough the data stream is interrupted. This can lead to either, dis-
turbing clicks and popping noises or in the worst case to real “holes” in the audio 
signal. And: a smaller buffer results in a higher CPU load because Cross needs to 
write data into the buffers more frequently.

When larger data buffers are used, the clicks and pops disappear; the disadvan-
tage is that this also increases the latency. Because of the larger buffers, it takes 
more time for Cross to write new audio data into the buffers (i.e. until the data in 
the buffers is “consumed”).

The actual latency time is also dependant on the buffer size and the number of 
operating system layers the audio data needs to walk through until it reaches the 
audio interface hardware. Mac users do not need to worry about this. The Core 
Audio drivers were originally designed in a way that their latency time is quite low.
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To overcome these latency and other issues with earlier Windows audio drivers 
(and as a way to improve sale of their own products) German company Steinberg 
developed the ASIo protocol (Audio Stream Input/output), which in 1997 became 
an open standard, whereby other manufacturers could develop hardware and driv-
ers that used this protocol. The main goals for the development of ASIo were to 
give applications direct access to the input and output functions of the audio inter-
face and so to avoid the need for data to be transported via several layers in the 
operating system first. This results in a better data throughput and in a decrease 
in latency time. At the same time, ASIo removed the previous restriction that only 
one stereo output and one stereo input could be used and made it possible to cre-
ate and support audio interfaces with several inputs and outputs.

4.9 Using the MIDI Presets for DJ Controllers
Cross comes with many MIDI presets which allow you to control the software from 
your DJ controller. If you wish to use a DJ controller, please connect it to your 
computer before launching Cross. once you see the main window, perform the fol-
lowing steps to assign the MIDI port of your controller to one of the MIDI presets:

1 open the File menu and click Preferences. Click MIDI to open the 
 MIDI tab. For each MIDI port/controller Cross could detect, you will see a 
tab with the controller name/port name at the top of the panel.

2 Click the tab with the controller name/port name, for which you wish to as-
sign a MIDI preset.

3 Scroll through the list Controller and click the MIDI preset you wish to as-
sign. The following image shows an example with one detected controller 
(here MixVibes U-MIX CoNTRol PRo). This controller is assigned to the 
MIDI preset with the same name. 
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4 Repeat steps 2 and 3 if you wish to use more than one controller. 

MIDI Presets Documentation
To have the documentation of the MIDI preset at your fingertips you can print the 
corresponding PDF file. On Windows browse to the folder with the Cross program 
files and open the subfolder Documentation\MIDI Controllers. Search for the PDF 
file with the documentation of your controller.

On Mac the PDF files are not installed by default. To access them insert your Cross 
installation disc into the CD RoM drive. Double-click the Cross icon on your desk-
top. Finally open the Documentation/MIDI Controllers folder on the installation 
disc and all available PDF files are shown.

All PDF files are also available on the MixVibes website (www.mixvibes.com). Open 
the page Documentation in section Support and Downloads for your Cross prod-
uct.

4.10  Defining your own Presets and Controls
The standard MIDI presets, also called controller mappings, that come with Cross 
cannot be changed. Presets that cannot be changed are marked with the lock icon 
in list Controller (see previous page).

However, you can create a duplicate of a standard MIDI preset and then use this 
duplicate to make your own changes, such as deleting and adding controls. If there 
is no MIDI preset available for the controller you wish to use, you can create your 
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own, or you can import a MIDI preset that another CrossDJ has shared on the 
MixVibes Forum. 

Creating a Duplicate of a MIDI Preset
Perform the following steps to create a duplicate of one of the standard MIDI pre-
sets:

1 open the File menu and click Preferences. Click MIDI to open the MIDI tab. 

2 Click the tab with the controller name/port name of the controller, which 
MIDI presets shall be duplicated.

3 Scroll in list Controller and select the MIDI preset you wish to duplicate.

4 Click the button Duplicate Controller Mapping at the bottom of the 
Controller list. 

 Cross opens the Controller Info dialog.
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5 Enter a name for the MIDI preset, like “My CDJ 400 Preset”, change the 
version number and the author name in the two text boxes in the lower part 
of the dialog. If you wish to change the icon for the duplicate, click Browse, 
open the folder with the image file and click open.

 Finally click oK.

6 The duplicated preset is added to the end of list Controller. you can now 
change and edit the mapped controls (see section “„Editing a MIDI Preset“ 
on page 53 ). 

TIP If you wish to change the controller information, select the pre-
set in list Controller and click the button Edit Controller Info.  
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Creating a new MIDI Preset
If there is no default MIDI preset available for the controller you wish to use, you 
can create your own. First add an empty mapping (this section) and then add the 
controls to this mapping (next section). Perform the following steps to create a 
new controller mapping:

1 open the File menu and click Preferences. Click MIDI to open the MIDI tab. 

2 Click the tab with the controller name/port name of the controller, which 
MIDI presets shall be duplicated.

3 Click the button Add Controller Mapping at the bottom of the Con-
troller list. Cross opens the Controller Info dialog.

4 Enter a name for the MIDI preset like “Trigger Finger”, change the 
version number and the author name in the two text boxes in the lower part 
of the dialog. If you wish to change the icon for this controller mapping, 
click Browse, open the folder with the image file and click open.

 Finally click oK.

5 The new controller mapping is added to the end of list Controller. 

you can add controls to your new mapping (see section “Editing a MIDI Preset” 
below).

Editing a MIDI Preset 
Each MIDI preset/controller mapping consists of one or more controls. A control 
is a function of Cross that can be controlled with a MIDI controller. All available 
controls are grouped by the function categories that are shown in list Mappings of 
the Preferences/MIDI dialog. you can open a category by clicking the Plus button 
in front of the category name.

Inside each category you can see the controls that can be mapped to the buttons, 
faders and knobs of your controller. In the following image the category FX 1 is 
opened. There are different controls that you can assign to your controller, like 
oN/oFF, Input Channel, Depth and Amount, for example.
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The control FX 1 | oN/oFF has been assigned to the controller. A grey button 
shows information about the MIDI message that the button on the controller sends 
to Cross. you can click this button to change the assignment between the control 
and the button/knob/fader on your controller. At the very right you can see buttons 
with a Minus sign and a Plus sign. Clicking the Minus button removes the mapping 
for a control; clicking the Plus button opens a dialog where you can create a new 
mapping.

let’s have a look at some examples that will explain the basic steps and the differ-
ent options for mapping a control. 

1 Click the Plus button before the category with the control that you wish you 
map. For this example open category FX 1.

2 Click the Add mapping button next to oN/oFF. The MIDI 
control mapping windows is opened.
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3 Press/move the MIDI button/MIDI control that you want to assign to FX1 | 
oN/oFF. Cross receives a MIDI event from your controller. 

 In section MIDI event you can see information about the MIDI event that was 
received. In this example we have pressed a button. Buttons normally send 
Note messages (here 0x46; the prefix 0x is shown as the shown number is 
a hexadecimal value). MIDI events are sent on a particular MIDI channel; in 
this example the controller was configured to send its messages on chan-
nel 10.

 Now have a look at section Available Presets. For an event that was trig-
gered by a button and that is mapped to a Cross control with on/off states, 
Cross provides two different presets. you can select one of the available 
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presets to define how Cross shall react when this MIDI event is received. If 
you choose Toggler Button then this event toggles the state of the mapped 
control: if the current status is oFF the status will be set to oN; if the cur-
rent status is oN then pressing the mapped button will set the state to oFF.

 If you choose Holder Button, then the status of the control will change for 
as long as the mapped button is held. 

 Additionally, you can activate the Invert check box in section Preset op-
tions. If you have mapped a control as a Holder Button, the mapped feature 
is on while the mapped button is held. However, if Invert is activated, the 
mapped feature is off, while the mapped button is held.

4 Click oK to add the mapping to the MIDI preset.

5 Click the Add mapping button next to Amount. The MIDI control mapping 
windows is opened.

6 Move a fader or a knob on your controller and have a look at the available 
options.

 For controls that are used to set a Cross control to a particular value and 
where a fader or a knob is moved, the MIDI control mapping windows offers 
the presets Direct Fader/Knob and Inc.-Dec Normal Fader/Knob. In gen-
eral you should use Direct Fader/Knob for faders and knobs with a defined 
start and end point and you should use Inc.-Dec Normal Fader/Knob for 
endless encoders.

 In section Preset options you see the Invert option that you know already 
from the first example. Use Invert for faders and knobs if you wish to invert 
the meaning of the left/right or up/down movement or position of the MIDI 
control.
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7 For controls like Amount that set a value, not only faders and knobs but 
buttons can be used if you wish to set the value stepwise. Make sure that 
the MIDI control mapping dialog for the Amount control is still open and 
press a button on your controller. The available Preset options change as 
shown in the following figure:

 Use the preset Direct Normal Button if you wish to set the control to a par-
ticular value. Use the Value field in the section Preset Option to define the 
value in the range from 1 to 100.

 Use the preset Normal Inc. Button or Normal Dec. Button if you wish to 
change the value stepwise. Using Normal Inc. Button increases the value 
and Normal Dec. Button decreases it. Then enter the step size into the 
field Value. The step size can be in the range from 0.00 to 1.00. Addition-
ally you can activate the AUTo-REPEAT option, if you want the value to be 
decreased/increased not just once, but for as long as the mapped button is 
held. 

 The two presets Normal Inc. Trigger and Normal Dec. Trigger lead to the 
same result as using the corresponding button presets. However, for a 
control mapped to a Trigger function Auto-Repeat options are not available.

8 Now open the category Application and click the Add Mapping button next 
to Activate Next Player. Activate Next Player can be used to set the input 
focus to one of the players. All commands that are mapped in the category 
Current Player are sent to the player that is currently active.

9 Press a button on your controller and take a look at the available presets.
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 Some of the controls do not have an on/off state, like the FX on/off control 
you saw earlier. They are used only to trigger an action, like setting the in-
put focus as Activate Next Player does. For these controls the presets Trig-
ger Button and Trigger Note are available. If you use the preset Trigger 
Button you can activated the Auto-Repeat option as shown in the previous 
image. For the Trigger Note preset this option is not available.

This ends the introduction into how to map your own controls. 

Importing a Mapping 
If you have found a MIDI preset for your controller on the MixVibes forum or if you 
received one from another Cross user, perform the following steps to import the 
mapping.

1 open the File menu and click Preferences. open the MIDI tab on 
the Preferences dialog.

2 Select your MIDI device by clicking on its tab.

3 Click the Import Controller Mapping button in the lower part of 
the Controller list.

4 Browse to the folder with the mapping file (file extension .map-
pings), select the file you wish to import and click open.

5 Assign the imported mapping to the MIDI device by clicking the picture of 
the mapping in list Controller.
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Exporting a Mapping
If you created a mapping for a controller and wish to share it on the MixVibes fo-
rum, perform the following steps to export the mapping into a file that can be up-
loaded.

1 open the File menu and click Preferences. open the MIDI tab on 
the Preferences dialog.

2 Select your MIDI device by clicking on its tab.

3 Click the Export Controller Mapping button in the lower part of the 
Controller list.

4 Browse to the folder where you wish to save mapping file (file ex-
tension .mappings) and click Save.

4.11  Using the Keyboard 
If your DJ controller is not currently available, or if you are preparing tracks or 
playlists you can use your keyboard to access many of the Cross features. Cross 
includes a keyboard mapping that is automatically activated when you launch the 
software. Please have a look at the tables on page 110 and onwards for a complete 
overview of the integrated shortcuts.

Player related shortcuts
Many of the keyboard shortcuts control the features of the two players, but only 
one keyboard shortcut has been assigned. In these cases the mapped command is 
sent to the currently activated player. Please have a look at the yellow and red bar 
respectively that is visible above the track title if that player is active.

you can toggle the active status of the players by pressing the (ÿ) key.

Defining your own Shortcuts 
If you wish to access a Cross feature for which a shortcut is not included in the 
default mapping, you can define the shortcut yourself. This example shows how to 
define a shortcut for the Kill Bass feature in the mixer.

1 open the File menu and click on Preferences. Click the Keyboard 
tab.

 The Controller list shows all keyboard mappings that are avail-
able. Please note the lock icon, it indicates that the mapping is 
embedded and cannot be changed. The Mappings list shows the different 
command categories that can be assigned.
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 As we wish to add two new keyboard shortcuts to an existing mapping the 
easiest way is to duplicate an existing mapping and make the desired 
changes there.

2 Click the Duplicate Controller Mapping button in the lower part of 
the Controller list. The Controller Info dialog becomes opened.

3 Enter a descriptive text into the Model field and click oK. 

 Have a look at the list Controller. There are now three different keyboard 
mappings available: the two embedded mappings and the duplicate you just 
created. only one of the mappings can be active at one time. 
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4 Make sure that the duplicated mapping is selected in the list Controller. 

5 Click the Plus button before the category Mixer to expand this node. you 
now see all mappable commands and the shortcuts that are already de-
fined for some of the commands.

 6 Click the Add mapping button next to Bass Kill A. The 
keyboard control mapping windows is opened.

7 Press the (F8) key. The pressed key is shown as a 
keyboard event. you can now choose between two different presets. These 
presets are identical to those you see when you create a mapping for a MIDI 
controller.



4/  Connect and Configure your Hardware

62

•	 Toggler Button A toggler button toggles the status of the mapped 
command between on and off.

•	 Holder Button A holder button activates the mapped command only 
for as long as the key is held.

•	 you can use option Invert if you wish to invert the functionality of the 
control (see page 45).

8 leave preset Toggler Button activated and click oK to close the Keyboard 
control mapping window.

9 Repeat steps 6 to 8, but this time add a mapping for the Bass Kill B com-
mand and assigned it to the [F9) key.

10 Close the Preferences dialog and check, if the new keys are working.

Importing and Exporting Keyboard Mappings
Keyboard mappings can be imported and exported in the same way as explained 
for controller mappings (see page 47 and onwards). Make sure, that the Keyboard 
panel of the Preferences dialog is open if you wish to import or export a keyboard 
mapping.

 



63

5/ 
Configuring the 
Cross 
Remote Apps

With the Cross remote apps you can control Cross remotely from your iPad, your 
iPod touch, or from your iPhone. The remote apps simulate an external Wi-Fi ex-
ternal DJ controller.  All mixing is done in the Cross software running on your 
Mac or on your PC. In this setup your standard audio interface is used so you will 
achieve the sound quality that you expect from professional DJ software.

Communication between Cross and the remote apps is bi-directional. This allows 
sending commands from the remote app to Cross as you would expect. At the 
same time the names of the loaded tracks and all playback information (current 
tempo, current playback position, remaining play time and so on) are visible on the 
remote app screen, because Cross can send this information to your remote app.

The Cross remote apps are available in the Apple App Store. once you have pur-
chased and installed the remote app you need to configure the wireless adapter 
of your laptop. The steps you need to follow are slightly different depending on the 
operating system you are using for Cross. The following sections contain detailed 
information for Windows XP, Windows 7, and Mac oS X. once the Wi-Fi network has 
been created you can connect your Cross remote app to Cross.
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5.1 Setting up the Ad Hoc Network on Windows XP

Perform the following steps to configure an Ad Hoc network on Windows XP

1 open Control Panel and open the Network Connections applet.

2 Deactivate all internet connections. you can use your remote app while 
your internet connections are active. However, for performance reasons 
we recommend deactivating your internet connections.

 Also deactivate your antivirus software and your firewall to make sure that 
your remote app can connect to Cross via the wireless connection.

3 Right-click on Wireless Network Connection and select Properties.

4 open the Wireless Networks tab and click Add.

5 Enter a name for the network into the Network Name (SSID) field, deacti-
vate the option The key is provided for me automatically, select WEP as 
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data encryption mode and enter a password of 5 or 13 characters into the 
Network Key field. Finally click oK.

 The new network should appear in the networks list, as shown in the fol-
lowing image.

6 Click on Advanced to open the Advanced dialog box. Make sure that op-
tion Computer-to-computer (ad hoc) networks only is selected and click 
Close.
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7 Right-click the icon Wireless Connection icon in the notification area of the 
Windows task bar. Select View Available Wireless Networks in the context 
menu. 

8 If the network you just created is not yet connected, select it in the networks 
list and click Connect. 

 Windows will show the following dialog box informing you that the network 
is activated and that it is waiting for devices to connect.
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9 open the Settings app on your iPad, go to Wi-Fi, turn Wi-Fi on if it is cur-
rently off and select the network you just created from the list of networks. 
Enter the password you selected while creating the Ad Hoc network in Win-
dows and tap Join. 

Now continue as explained on page 61 to connect your remote app and Cross.

5.2 Setting up the Ad Hoc Network on Windows 7

Perform the following steps to configure an ad hoc network on Windows 7:

1 Right-click the icon Wireless Connections in the notification area of the 
task bar. Select open Network and Sharing Center in the context menu. 

2 Deactivate all internet connections. you can use your remote app while 
your internet connections are active. However, for performance reasons 
we recommend deactivating your internet connections.

 Also deactivate your antivirus software and your firewall to make sure that 
your remote app can connect to Cross via the wireless connection.

3 In the Network and Sharing Center window click on Setup a new connec-
tion or network.
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4 In the Setup a new connection or network dialog click on Set up a wireless 
ad hoc (computer-to-computer) network.

5 Enter a network name, select WEP in list Security type and enter a pass-
word of either 5 or 13 characters into the Security key field. Click Next.
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6 Windows will show the dialog you see in the following image. Click on Close 
to return to the Network and Sharing Center. 

 The new network is created and is waiting for devices to connect: 

7 open the Settings app on your iPad, go to Wi-Fi, turn Wi-Fi on if it is cur-
rently off. Then, in the list of networks select the network you just created. 
Enter the password you selected while creating the Ad Hoc network in Win-
dows and tap Join. 

The Network and Sharing Center should now look as shown in the follow-
ing figure:
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 It takes a while (often between 2 and 5 minutes) until the Network and 
Sharing Center is updated and will show the connected status:

8 Close the Network and Sharing Center.

Now continue as explained on page 61 to connect your remote app to Cross.
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5.3 Setting up the Ad Hoc Network on Mac OS X

Perform the following steps to configure an ad hoc network on Mac OS X.

1 Click the AirPort icon in the menu bar and then click on Create Network.

2 Enter a name for the new network. Select 40-bit WEP in list Security, enter 
a password into the Password and Verify fields and click oK.
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Now continue as explained in the next section to connect your remote app to Cross.

5.4 Connecting the Remote App to Cross
once you have created the Ad Hoc network you need to connect your computer and 
your iPad and then you must establish the connection between your remote app 
and Cross by performing the following steps:

1 open the Settings app on your iPad, iPod touch, or iPhone, go to Wi-Fi, and 
turn Wi -Fi on if it is currently off. Select the network you have just created 
from the list of networks. Enter the password you selected while creating 
the Ad Hoc network and tap Join. 

2 Go to Cross.

3 open the File menu and click Preferences. Click Remote to open the Re-
mote tab.
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4 Make sure that the check box Use Remote Apps is activated.

5 launch the remote app on your on your iPad, iPod touch, or iPhone. 

6 The start screen of your remote app shows the names of all computers 
(not the network names) that are connected to the Ad Hoc network and that 
are running Cross with Use Remote Apps activated on the Preferences/ 
Remote tab.
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7 Select the computer you wish to connect.

8 Return to Cross. on the Remote tab you see that a connection request from 
your remote app has arrived. Click Accept to accept the connection.

 The remote app will connect to Cross and the app should be ready to go.

TIP If the connection lags for more than 30 seconds, uncheck the Use Re-
mote Apps checkbox in Cross and re-check it to reinitialize the connection. If 
this does not help, restart Cross.
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6/ 
The Cross  
User Interface

The user interface of Cross is composed of several panels, with each panel having 
its own functionality. The feature set of some of the panels, such as the mixer, is 
based on the functionality known from classic analogue DJing. other features, as 
Beatmatcher and the automatic sync, are tools unique to digital DJing.

6.1 The Panels at a Glance
The following figure shows the different panels of the Cross user interface.

Beatmatcher

Player A (here: external control) 
and Locators panel

Player B (here: internal control)
without Locators Panel,

Sampler C

Browser and Preview Player

Sync Zone

Mixer

Toolbar

FX-Zone

Sampler D
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Selecting the User Interface Language
If the user interface is not in your language or the language you wish to use you 
can change it. open the File menu and click on Preferences. Make sure that the 
Display tab is open. open the list Language and select your preferred language.

The Toolbar
In the Toolbar at the top of the screen you find the Cross menu, the knobs to set 
the master/cue volume, and some buttons to open the Preferences dialog, and to 
start the Recorder. All elements of the toolbar are shown in the following figure:

Fullscreen Mode
Open Preferences     

Start/Stop Recorder           

                                      Master Volume               Limiter on/off
                      Cue/Master Ratio
Headphones Volume         

 

The Volume section has three knobs where you can control the Master out volume, 
the Headphone volume and the ratio between the Monitor and the Mix signal that 
is sent to the headphones. 

The Master Volume can be set on U-MIX CoNTRol PRo 2 with the Master knob 
on the top panel of the controller. The right side of the front panel contains two 
knobs to set the ratio between the Monitor and the Mix signal and the volume of 
the headphones.

Cue/Master Ratio   Headphones Level

Master Volume

you can use the button Start/Stop Recorder to record your mix, to record the audio 
of the players, or to record both at the same time. More information about the Re-
corder can be found in section “Recording” on page 128 and onwards.
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The Beatmatcher and the Sync Zone
Below the toolbar you can see the Beatmatcher. If the Beatmatcher is not visible 
on your screen, open the View menu and select Beatmatcher.  

The Beatmatcher serves as a visual guide for getting your tracks beat synchro-
nised. It displays the peak/transient information of the tracks currently playing in 
the two players. For tracks that have a beatgrid, Cross can also show the grid on 
the Beatmatcher. To enable the beatgrid, open the Preferences dialog, switch to 
the Display tab and enable the activate the Beatgrids option.

Additionally, you can enable the Sync zone by opening 
the View menu and selecting Sync Zone. The Sync zone 
contains the Sync Meter and the settings for Snap and 
Quantize. These options are explained in more detail in chapter 7 and chapter 9.

The FX Zone
Below the Beatmatcher you can see the FX zone. If you do not see the FX zone on 
your screen, open the View menu and select FXs. The FX zone allows you to con-
trol the two FX of Cross: select the effect you wish to use, activate the FX and use 
the knob(s) in the FX zone to change the effect parameter.

                                      Assign FX to Channel                                  Assign FX to Channel           
                      Set Effect Parameter                                                             Set Effect Parameter
     Select Effect                                                                                                                          Select Effect          

FX On/Off

FX 1 FX 2

The FX zone has two assignment lists: use them to assign the two FX to the players 
or the samplers. It is also possible to use two effects on the audio of one player/one 
sampler. Simply select the same player/sampler in both lists.

If you are using Cross in internal mixer mode, you can use the assignment option 
Master: in this mode the audio from all players/samplers is changed by the effect.

More information about the Cross effects can be found in chapter 10 starting on 
page 132.

Player A and B
The largest area of the Cross user interface is occupied by the two players and, if 
enabled, by the two samplers. 
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The player on the left is player A (yellow); the player on the right is player B (red). 
The waveform area shows a section from the track currently playing. you can use 
the outer buttons to zoom in, zoom out and to reset the waveform to the default 
zoom factor. The white vertical line is the play marker and marks the part of the 
track that is currently audible.

Pitch Fader 

Loop Section
Transport/Control Modes

Playback Info

Waveform with Beatgrid

Full Track Display

Locators 

The outer panel of the players contains the pitch faders that work similarly to the 
pitch faders that can be found on turntables and CDJ players. 

The section in the header area of the players shows some vital playback informa-
tion: the name of the track and the artist, the current time or the remaining time, 
the current BPM and the current tempo change as a percentage value.

If a player is configured for timecode control, the transport section contains the 
buttons to switch between the different timecode control modes (see image above). 

Use the loop section to create automatic and manual loops. you can use the Smart 
Seek buttons in the Transport section to jump forward/backward in a track and 
define the jump length in beats or fractions of a beat. Click the button Locators 
to open the locators panel. locators are saved and named cue points in a track 
that you can jump to. Chapter 9 starting on page 118 takes a closer look at these 
features.

Pitch Fader

Loop Section
Transport/Control Modes

Playback Info

Waveform with Beatgrid

Full Track Display

If a player is configured for internal control, then the transport section contains the 
Play/Pause and the Cue button; they work in a similar way to the corresponding 
buttons on a CDJ player. The image above shows as an example the elements of 
player, when the player is setup for internal control and when the locators area 
is hidden. 
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Samplers C and D
In the following image you see one of the two samplers in Cross. If the samplers 
are not visible on your screen, open the View menu and select Samplers.

Select Sample Bank

Open Link Settings

One Sample Pad

Each sampler provides eight sample pads. you can load one sample into each of 
the pads. To make loading samples easy, you can create your own sample banks. 
Each sample bank can contain up to eight samples; they can be loaded into a sam-
pler at the same time. You can define various playback parameters for each sam-
ple in the pad: what type of sample it is, whether the sample is a loop or a 1-Shot 
and whether the sample shall be played continuously, or until the end is reached 
or only while you press the Play button for the pad.

All information about the samplers can be found in chapter 11, starting on page 
137.

Mixer
There are two different views for the Mixer panel: one for internal mixer mode and 
another one for external mixer mode. The Mixer panel in internal mixer mode has 
all the controls that you would find on a classic DJ mixer:

•	 A Gain knob to set the Gain level and a Mute button to mute the audio of the 
corresponding player/sampler.

•	 A 3 band equalizer for each player/sampler to control the cut/boost of the three 
frequency ranges and a Kill button for each range to completely cut it.

•	 A bi-polar filter for each player/sampler.

•	 The Cue/Monitor buttons for each player and sampler. Activating the Cue but-
ton of a player sends the audio to the Headphones; the channel fader of the 
corresponding player does not need to be up for the audio to be heard.

•	 The four channel faders control the volume of the two players and the two sam-
plers.
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Internal Mixer Mode                                      External Mixer Mode

Equalizer

Gain/Mute

Filter

Channel Fader
Level Meter

Channel Fader/
Level Meter C/D

Filter A/B

Filter C/D

Level Meter A/B

Crossfader•	 The crossfader controls the ratio between the left player/sampler and the right 
player/sampler. The crossfader curve can be freely configured. You find the 
crossfader settings on the General tab of the Preferences dialog. 

If you use U-MIX CONTROL PRO 2 you can configure the shape of the crossfader 
curve with the knob on the rear panel of the controller from a quick cut for 
scratching or to a longer fade for mixing. 

More information about the crossfader can be found in chapter 7 on page 99 
and onwards.

In both mixer modes the Mixer panels show the pre-fader level of the player/sam-
pler. Pre-fader means that the position of the channel fader and the cross fader 
does not affect the level meter. 

Again, in both mixer modes you can click in the header of the mixer on A or on B to 
select the input mode for that channel fader. 

Browser and Preview Player
The Browser panel allows you to access the tracks in your collection and your 
iTunes library. This panel offers some sophisticated search features so you can 
quickly find the track you wish to play next. The browser is explained in more detail 
in chapter 7 on page 82 and onwards.

The preview player can be used to preview the track that is currently selected 
in the browser. you do not need to load a track into the preview player, simply 
press its Play button. The audio from the preview player can be heard in your head-
phones if you use internal mixer mode. If you use the routing mode External Mixer 
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Cue the audio of the preview player is routed to the audio interface port configured 
as output 3.

6.2 Changing the Screen Layout
you can use the commands in the View menu or the corresponding keyboard 
shortcuts to change the layout of Cross.

        

Using the Collection View Expanded command to toggle between the Browser 
View and Mix View. In Browser View the players, samplers,  and the mixer are 
hidden to allow easier and faster browsing in your collection and playlists. In Mix 
View the players and the mixer are visible and the browser occupies the remaining 
space.

The Full Screen command does exactly what is says: it maximises the Cross win-
dow so that it occupies the complete screen.
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7/ 
Importing and  
Mixing  
your Music

Before you can play and mix your audio files with Cross, the files should be im-
ported into the track collection. Cross supports the following file types: MP3, WAV, 
oGG, FlAC, AIFF, M4A and AAC. This chapter explains the basic steps that need to 
be done and will then show you how to mix two tracks with Cross.

7.1 Importing Folders
Perform the following steps to import an entire music folder or disc:

1 open the File menu and click Import Directory.

2 Select a folder or a drive with the audio files you wish to import. Click oK.

3 Cross will import all audio files from the selected drive or folder and its 
subfolders into the collection. Once the import has been done, the files are 
shown in the Collection panel of the browser.

TIP If you wish to import a single file only or a group of files from within 
one folder, open the File menu, click Import File, select the file/s you wish to 
import and click open. To import a playlist in .m3u or .pls format open the File 
menu, click Import Playlist, select the playlist file and click open.

7.2 Importing Tracks from iTunes
If you use Apple’s iTunes® software to manage your track collection, you can ac-
cess your iTunes® library and playlists by clicking on the iTunes® tab in the Dock. 
Perform the following steps to import tracks from iTunes®:

1 Click the iTunes® icon in the browser dock to open your iTunes 
library. (If the iTunes icon is not visible, right-click the dock and 
select iTunes.)

2 Select the tracks you wish to import.
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3 Perform one of the following actions:

•	 Drag and drop your selection onto the Collection icon in the dock.

•	 Right-click the selection and choose Add to Collection from the context 
menu.

7.3 Importing Collections from other DJ Software
Cross makes it easy to import collections and tracks from Traktor, Rekordbox, and 
from Virtual DJ. During the import not only the audio files are imported, but also 
any playlists that you have created in the supported third party applications. Also 
imported is certain track information, like beatgrids, cue points and – if applicable 
– the first loop you set in the third party tool.

Perform the following steps to import the collection from another DJ software:

1 open the File menu and select Import Third Party Database. Cross opens a 
dialog box where you can select the database file of the third party applica-
tion.

2 Browse to the folder with the third party collection file:

•	 To import a Traktor collection, open the folder Native Instruments/
Trak tor x.x.x below your documents folder. x.x.x represents the Trak-
tor version you are using. If you changed the default location of the col-
lection file (on the Preferences/File Management tab), open this folder 
instead. Then select the file collection.nml. 

•	 To import a Rekordbox playlist, open the folder where you exported 
the Rekordbox playlist information to, and the select the file created by 
Rekordbox.

•	 To import a Virtual DJ database, open the folder VirtualDJ below your 
documents folder and select the file VirtualDJ Database vX.xml (X rep-
resents the version of the database format; the current version is 6). 

3 Click open to start the import process.

Cross will import all audio files from the third party library into the Cross collec-
tion. When the import is done, you will find all audio tracks inside the Music node 
of the collection. 

If the imported collection contains playlists, Cross will import them and create 
new entries directly below the Playlists node. The Traktor playlists can be found 
in the node Playlists/import-Traktor, the Rekordbox playlists in the node Playl-
ists/import-Rekordbox, and the VirtualDJ playlists in the node Playlists/import-
VirtualDJ. you can drag and drop the imported playlists to a new position in the 
tree or rename them, if you wish to.
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Import of tracks that are already in the Cross collection
If the imported collection contains a track that is already in your collection, Cross 
will open a message box as shown in the following figure:

•	 Click Yes if you wish Cross to read the tags from the file; these tags will replace 
the tags already in the Cross collection. 

•	 Click No, if you do not wish Cross to keep the tags that are already in the Cross 
collection.

•	 Activate the check box Don‘t ask me again if you wish that all imported tracks 
shall be handled in the same way as your current selection (yes/No). 

7.4 Analyzing imported Files
The tracks in your collection need to be analyzed before Cross can show the full 
track display and the transient view of the track in the Beatmatcher. In order to use 
the automatic beat and cycle synchronisation Cross provides, the BPM and the 
beatgrid of the track also need to be analyzed. Tracks that are not analyzed when 
you load them into the players will be automatically analyzed. 

While the track is being analyzed, 
the text “Analyzing” is shown in the 
full track display.

However, it is a good practise to trigger the analysis of newly imported tracks be-
fore you load them. The advantage of analysis before use is that the transient view 
and the full track display are available immediately after loading. If you load a track 
that has not yet been analyzed it can take a while until the full track display and 
the waveform in the Beatmatcher are visible. Also, as track analysis consumes 
CPU time it could lead to crackling sounds and this is something you do not want 
to hear during your set.

Perform the following steps to analyze tracks:

1 Make sure that the Collection tab is opened in the Browser.

2 Select the track/s you wish to analyze.

3 Right-click the selection and open the Analyze menu. 
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4 Select one of the following options depending on what Cross is to analyze:

•	 Analyze all  Use this option to analyze tracks that are new additions 
to the collection. During the analysis Cross will do a gain analysis to 
check, whether the signal strength needs to be raised or lowered when 
the track is played. Furthermore, a peak analysis is done and the in-
formation collected is used to display the waveform of the audio in the 
Beatmatcher and in the full track display on the player. Then, the BPM 
of the track is detected and Cross sets the beatgrid for the track. The 
beatgrid will help you to perform different kinds of beat sync operations 
(more to be found below).

•	 Analyze Beatgrid/BPM only  Use this option to make Cross analyze 
the beatgrid and the BPM of the track only. 

•	 Analyze Gain only Use this option if you only wish to analyze the gain 
of the track, maybe if you have changed the gain and wish to restore it 
to the default analysis. 

•	 Analyze Peak only Use this option to only analyze the peaks of the 
track. This is useful when you do not need the beatgrid or gain informa-
tion, maybe because you use timecode. 

 Have a look at column A. (short for Analysis Status) and the column with the 
icons, the Status column to see which tracks have been analyzed (a check 
mark in column A.) or not. In the image above, the fifth track is currently 
being analyzed and 2% of the analysis is complete.
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BPM Detection Range
Detecting the tempo of a track can sometimes be a bit tricky. Cross performs a 
peak analysis to detect the beats, and then uses the data about the peaks to cal-
culate the BPM. As not all transients/peaks in a track need to be beats, you can 
“help” Cross by setting the BPM Detection Range on the Preferences/General 
dialog.

Use the range that best fits your music genre: Slow is the best setting for Hip Hop, 
Standard is the best choice for House/Techno, and you should to set the range to 
Fast if you mainly spin Drum ’n’ Bass. Using a BPM detection range that does not 
fit the genre of your tracks sometimes leads to a BPM value that is either, half as 
small or twice as large then the real BPM of the track. These kinds of errors can be 
easily corrected by using the beatgrid tools that are explained in the next section.

7.5 Using the Beatgrid Tools 
As you can see in the previous section, Cross performs a BPM and beat analysis: 
both values are used to define the initial beatgrid of a track. The beatgrid is initial, 
because Cross offers several tools that you can use to change the beatgrid if nec-
essary.

Before we take a close look at the beatgrid tools of Cross, we should start by de-
fining some important terms and have a look at the visual representation of the 
beatgrid as it is shown on the Beatmatcher and on the waveform of the players. 

NoTE In order to see the beatgrid, you need to activate the checkbox Show 
Beatgrids on the Display tab of the Preferences dialog. Activating this option 
makes the grid visible on the Beatmatcher and on the waveform. of course, 
if no beatgrid has been analyzed, Cross cannot show it. In this case use the 
command Analyze Beatgrid/BPM only as explained in the previous section.

The beatgrid information on the player is shown as vertical lines. A vertical line 
with the height of the complete waveform represents a downbeat (i.e. the first beat 
of a 4 beat bar). The first downbeat gridline that you see on the waveform serves 
as the reference point of the grid and is marked with yellow triangles at both end-
points. All vertical gridlines that are marked with white triangles at the endpoints 
represent another downbeat. The gridlines of the beatgrid have the same spacing 
as Cross assumes that the tempo of the track is fixed and that it does not change 
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over the duration of the track. The following rules apply to the beatgrid: The great-
er the spacing of the individual gridlines, the lower the track tempo. The smaller 
the spacing, the higher the track tempo is.

The individual beats, half beats and quarter beats of one bar are symbolized by 
shorter vertical lines. The number of shorter vertical lines that are visible depends 
on the current zoom factor of the waveform display on the player and the Beat-
matcher. The more zoomed in you are, the shorter the lines will appear. The grid 
that was analyzed by Cross is called the base grid. 

The Beatgrid Toolbar on the Player
The lower right corner of the player A and the lower left corner of player B contain 
the button Show/Hide Beatgrid Editor. If you click the button to make the beatgrid 
editor visible, a toolbar is displayed in the lower part of the waveform. This toolbar 
contains all the buttons that you need, to make changes to the beatgrid.

When the Beatgrid toolbar is visible, Cross changes the display of the gridlines on 
the player as well. As you can see in the following image, each beat is now repre-
sented by a vertical gridline with the same height of the waveform. These longer 
grid lines make it easier to see whether the grid fits perfectly to the track or not.

you can use the following buttons of the beatgrid editor to change the active grid:

 The first two buttons of the toolbar can be used to expand or to shrink the 
distance between the gridlines. Shrinking the beat intervals increases the BPM of 
the track: the gridlines are now closer to each other and this will lead to an in-
crease in the tempo. Expanding the beat intervals decreases the BPM of the track: 
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the gridlines are now further apart from each other and this will lead to a decrease 
in the tempo.

 With these two buttons you can move the first downbeat (the line that is 
used as the reference point of the grid) to the left or to the right. When this down-
beat is sitting at the right position (exactly on the transient) it makes it easier to use 
the automatic sync features of Cross. It is good practice to zoom into the waveform 
before you move the first downbeat or the grid. 

 Use this button to convert the beat closest to the current playback position 
into a new downbeat. The button Define Downbeat is only active if the track has a 
beatgrid; otherwise it is disabled. The new downbeat resets the cycle/bar/beat-
counter of the track. This is useful if you use the “sync to cycle” feature of Cross. 
let’s have a look at an example track that shows how this works.

on the track in the following image a beatgrid analysis was performed. Cross has 
set the downbeat at the very beginning of the track, even though the track starts 
with 4 beats = 1 bar of silence. If we number the first beats of this track with a 
Cycle.Bar.Beat schema, the counter for the beats is 1.1.1, 1.1.2, 1.1.3, 1.1.4, 1.2.1.

 

1.1.1   1.1.2   1.1.3   1.1.4      1.2.1

Because the track starts with 4 beats of silence, this numbering is wrong and does 
not reflect the real musical structure of that track. The fifth beat, which is the first 
audible beat, should be 1.1.1. If you drag the waveform to this beat and click on 
Define Downbeat, Cross adds a new downbeat marker to the grid (marked with 
yellow triangles on player A and red ones on player B), and resets the internal 
beatcounter. 

1.1.1   1.1.2   1.1.3   1.1.4      1.2.1

The internal beatcounter that Cross uses to automatically sync to the cycle/bar/
beat of the track in the other player, now has a correct value to do this synchro-
nisation.

 If the configured BPM detection range does not fit to the tempo of the 
genre, you often get BPM values which are twice as large or half as small as the 
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real tempo. To correct this kind of BPM error, you can use these two buttons to 
halve or double the BPM value of the currently loaded track. 

 To delete all beatgrid information, click the Clear Beatgrid button. When the 
track has no beatgrid, the button Analyze Beatgrid is shown. Click this button to 
perform a BPM and a beatgrid analysis. 

Using User Beatgrids
Sometimes tracks do not use a strict 4/4 signature throughout the whole track. 
let’s assume you have a track with a beat length that cannot divided by 4 without a 
remainder, or another track with a tempo change where one part of the track has 
a different BPM than the other. For those tracks you can add a user beatgrid. The 
number of additional user beatgrids that you can add is unlimited.

When you add a user grid you actually set the position of a new downbeat (the first 
beat of a bar) and this downbeat can be set to any position of the track. 

 To set a user beatgrid, drag the waveform to the desired position and click the 
Add Beatgrid button on the Beatgrid Editor toolbar. The new user beatgrid serves 
as the reference point of the grid from the position of the marker towards the end 
of the track. The waveform before the user beatgrid marker is shown in grey indi-
cating that this segment is not affected by the current downbeat marker. The 
waveform behind the user beatgrid marker is shown in yellow/red (depending on 
the player), indicating that this segment of the track is affected by the current 
downbeat marker.

Setting a new user beatgrid also resets the bar and beat counter value to 1. you 
can change the tempo of a new segment with the shrink/expand buttons only. Each 
user beatgrid can have a different tempo.

 If you wish to delete a user beatgrid, drag the waveform and make sure, that 
the current playback position is behind the user beatgrid downbeat you wish to 
delete. Then click the Delete Beatgrid button on the Beatgrid Editor toolbar.

Section „A closer look at the Beat Matcher“ on page 95 in this manual will show 
you, how the beatgrid of the track will help you, to either manually or automatically 
synchronize the tracks in the two players.
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7.6 Playback Control Modes 
You can configure the Cross players for either internal control or external control. 
In internal control mode you use the software only to playback the tracks. In exter-
nal control mode you use timecode control media to control playback of the tracks.

NoTE The external playback control modes described in this section are 
only available in Cross, and not in CrossDJ or CrossDJ lE. Please have a look 
at chapter 1 for more information about the different software versions of 
MixVibes Cross.

Internal Control Mode
Internal control mode for a player is activated, if 

•	 no input has been assigned to the player with the 1/2 assignment buttons in the 
cover panel of the players, or if

•	 the checkbox Control Deck 1 and/or Control Deck 2 on the Vinyl/CD panel of 
the Preferences window is deactivated, or if

•	 no input is configured on the Audio tab or the Vinyl/CD tab of the Preferences 
window.

In this mode, use the software to control the playback independently of the control 
vinyl/discs. Use this mode when you wish to control the playback using the mouse 
& keyboard, and/or a MIDI controller.

you can see on the player if internal control mode is 
active: in this case the Transport section of the player 
shows the CUE, PLAY/PAUSE and the SYNC button.

External Control Modes
If Cross is configured for timecode usage as explained in chapter 4, the transport 
section of the players contain three buttons which you can use to switch between 
the different external control modes.

Absolute Mode In this mode, the playback position of the control vinyl/
disc corresponds precisely with the playback position of the audio file in 
the player. So, if you lift the needle and drop it one minute further to-
wards the end of the vinyl, the track will be played back from the new detected 
position. Use the Absolute mode when you wish to use your turntable’s needle (or 
the seek function on your CD player) to skip thru the track. If you are using CD 
decks, you can also use their cueing and looping capabilities.

Relative Mode In this mode, the playback position of the control vinyl/
disc does not correspond with the playback position of the audio file in 
the player. In relative mode the Cross timecode engine only detects the 
playback speed and the playback direction, not the position information. If you lift 
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the needle, the deck stops. If you then drop the needle at another location playback 
resumes from the same position where the needle was lifted. It does not matter 
where you drop the needle.

Flexible Mode In this mode, the timecode is disabled altogether, al-
lowing you to pick up the needle or stop playback on your deck. Use the 
Flexible mode when you need to deactivate the external control for any 
reason without interrupting a mix:

•	 when Cross is in Relative mode, switch to Flexible to return to the beginning of 
the time code without interrupting your mix. 

•	 Cross will automatically switch to Flexible mode when the end of the time code 
is reached while a track is still playing.

When in Flexible mode, clicking on the Flexible button stops playback.

External Control Modes and Non-Linear Features
The Cross players provide several non-linear features. Their use will lead to a 
state, where the playback position of the timecode media and the playback posi-
tion in the decks are no longer the same. These non-linear features are the hot 
cues (locators), the Smart Seek feature, the looping feature, the pitch fader, and 
the SYNC button. If you are in relative mode these features are always available.

However, in absolute mode these features can only be used, if Cross can switch to 
relative mode automatically. This setting can be found on the Vinyl/CD panel of the 
Preferences window. It is called Automatic Control Mode Switching and must be 
activated if you wish to use the non-linear features mentioned above.

7.7 Loading Tracks into the Players
once your audio tracks are imported into the collection you can load them into the 
players. Depending on your setup you can use a DJ controller, the timecode control 
media (only available with Cross and not with CrossDJ and CrossDJ lE), the mouse 
or the keyboard to load tracks. Almost any DJ controller like U-MIX CoNTRol 
PRo 2, will most likely have Browse and load functions. Please have a look at the 
manual of your controller or at the PDF file documenting the MIDI preset of your 
controller (see section “Controlling Cross with the Keyboard and with DJ Control-
lers” page 23 for more information).

Loading Tracks with U-MIX CONTROL PRO 2/U-MIX CONTROL 2
Perform the following steps to select and load a track with the controller:

1 Use the Browse encoder to scroll through your collection.
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2 Press Load A to load the selected track into player A, or press Load B to 
load it into player B.

If you use a different controller than U-MIX CoNTRol PRo 2, it will most likely 
have Browse and load controls as standard. Please have a look at the manual of 
your controller or at the PDF file documenting the MIDI preset of your controller 
(see „MIDI Presets Documentation“ on page 50 for more information).

Loading Tracks with the mouse
Perform one of the following actions to select and load a track:

•	 Drag and drop a track from the collection onto one of the players or onto the 
upper (for player A) or lower (for player B) area of the Beatmatcher.

•	 Right-click the track and select Load in Player A or Load in Player B.

Loading Tracks with the Keyboard
Perform the following steps to select and load a track:

1 Use the keys (¼) and (½) to scroll through your collection and to select 
the track you wish to load.

2 Hold (Ctrl)+(ª) (Windows) or (cmd)+(alt) (Mac). Then press (æ) to load 
the track into player A or press (Æ) to load the track into player B.

NoTE By default Cross loads the track completely into the memory of your 
computer for quick access, which puts some load on the CPU. The amount of 
memory that may be used by Cross can be configured with the Audio Cache  
slider in Preferences/General. In most cases you will not need to change 
the default setting. If you prefer your tracks to be streamed directly from the 
audio files, set the Audio Cache slider to 0%.

Loading Tracks with Control Vinyl 
The last track on both sides of the 12 inch control vinyl and on the B 
side of the 7 inch record can be used to scroll in the browser: Put the 
needle in the scroll zone and turn the vinyl to browse in your collection 
until the track you wish to load is selected. While the needle is in the 
scroll zone you can see the scroll icon on the timecode platter in the 
cover area of the player. 

Stop the record on the desired track, lift the needle and put it back to the beginning 
of the vinyl to load the track.
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Loading Tracks with Control CDs
If you use control CDs you can skip to track 2 on the control CD to scroll through 
your collection. once track 2 is playing use the pitch fader on your CDJ player to 
scroll: A negative pitch will scroll down and a positive pitch will scroll up. 

NoTE The scrolling speed will vary with the pitch, so you should be careful 
not to go too fast.

once you have found the track you wish to load, reset the pitch to 0 to stop scrolling 
and select track 1 to load it into the player.

Loading into playing Decks
Please note that the default security setting does not allow you to load a new track 
if a deck is currently playing. This setting can be changed by deactivating the Secu-
rity Mode checkbox on the General tab of the Preferences dialog. 

However, this setting can protect you from accidentally loading a track into the 
wrong player and it is best left activated.

7.8 Your First Mix
once you have imported some tracks into the collection you are ready for your 
first mix.

1 load a track into player A by using one of the techniques explained in the 
previous section.

2 Start playback of the loaded track by starting playback of the control vinyl 
(external control mode) or by clicking the Play button on player A.

3 open the channel fader for player A.

•	 If you are using one of the U-MIX CoNTRol controllers or another DJ 
MIDI controller, move the volume fader for player A upwards. Also make 
sure that the cross fader is in the middle position or at the outer left 
position.

•	 If you are using an external mixer, open the volume fader for the chan-
nel where you routed output 1 to.

•	 If you do not use a controller, use the mouse and move the volume fader 
for player A in the mixer upwards.

 you should now hear the music in your speakers. 

4 load your second track into player B and start playback of player B.
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5 While the track on deck A is playing to the public, press the Cue/Monitor 
button for player B in internal mixer mode, or the corresponding Cue but-
ton on your mixer if you are using external mixer mode.

 you now can pre-listen to the next track on deck B in your headphones 
while the audience listens to the track being played on deck A over the 
speakers. 

6 The tempo of the tracks loaded in the two players is most likely not the 
same. you need to match the tempo of both tracks, and synchronize the 
beats of player B to player A to get a smooth transition. Use one or several 
of the following techniques and tools:

•	 Adjust the tempo/BPM of the new track to match the one that is current-
ly playing by using the pitch fader on the player (internal control mode) 
or the pitch fader on your turntable/CDJ player (external control mode).

•	 once the two tracks are being playing at the same BPM, you need to 
make sure, that their beats match. 

you can achieve this by slowing down the record or by speeding it up. 
In relative timecode mode and in internal control mode you can use the 
pitch bend buttons on the user interface or the controller (see section 
“Using the Pitch Controls” on page 118 for more information). The 
pitch bend buttons are also used for slowing down/speeding up the play-
back of a deck temporarily. This shifts the playback position of the beats. 
If you use U-MIX CoNTRol PRo 2/ U-MIX CoNTRol 2 or another con-
troller with a jogwheel, use the jogwheel to perform the same action.

•	 If you wish Cross to take care of the tempo and beat adjustment, click 
the SYNC button on the player with the new track. If you use U-MIX CoN-
TRol PRo 2/ U-MIX CoNTRol 2, press the SYNC button for player B.

Which action that is triggered by the SYNC button depends on the Sync 
Mode setting that you can select in the General tab of the Preferences 
dialog. Clicking SYNC always matches the tempo of the track to one or 
the other player, and either, syncs to the beat, the bar or the cycle of the 
other track. (See section „Using the Sync Meter“ on page 97 for more 
information about the sync modes.) 

•	 Use the Beatmatcher in combination with the Sync Meter in the Sync 
zone. The next section shows some examples of what you can read in 
the Beatmatcher and how the Sync Meter can help you to synchronize 
your tracks.

7 Adjust the volume level by using the Gain knob. The Gain knob allows you to 
set the overall level to match that of the track playing on the other deck.
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NoTE If you change the Gain level of a track, Cross stores the new 
value in the collection file. If you load the track again, the changed gain 
setting is automatically applied by default. you can disable the default 
behaviour by opening the Preferences/General dialog and unchecking 
the option Read track gain at load.

8 To make the blend from one track to another, move the crossfader from left 
to right, or use the channels faders on your controller or external mixer.

NoTE  The crossfader curve can be freely configured. You can use 
either one of the predefined settings or configure a custom crossfader 
curve. More information about the crossfader settings can be found in 
section “Configuring the Crossfader” on page 99.

9 you can also change the channel equalization of the mixer to make the 
transition between the two tracks more smoothly.

10 Additionally you can use the effects and loops to highlight different parts of 
an audio track.

7.9 A Closer Look at the Beatmatcher and the 
Sync Meter

First let’s have a closer look at the Beatmatcher so we can understand what in-
formation it provides and how it can assist you in achieving the synchronisation of 
two tracks. If the Beatmatcher is not visible, open the View menu and select Show/
Hide Beatmatcher. The Beatmatcher can display the peaks and the beatgrid of the 
tracks loaded into the Cross players.

Then we will look at the Sync Meter that you can see in the middle part of the 
Sync-zone. If the Sync zone is not visible, open the View menu and select Show/
Hide Sync Zone.

Peaks of the Track
The peaks display in the Beatmatcher shows a kind of level information of the 
tracks currently loaded in the players. The peaks view is always on and cannot be 
disabled. The peaks data is analyzed when you drag a new track onto one of the 
players, or when you select Analyze all or Analyze Peak only in the context menu 
for the tracks in the track browser.
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In both waveforms you can see several vertical lines. These lines represent the 
peaks, or transients, in the track. Depending on the rhythm of the track, these 
peaks may be the beats of the track, but they may not always be where the beats 
are. The track in player A (upper waveform) shows some longer and some shorter 
peak lines. In most cases the longer lines are there where the beats are. The beats 
in player B are much more obvious; the part you see in the image is from the track 
intro which has a clear beat.

If you move the waveform of player B by pitch bending to get two peak lines aligned 
it becomes very clear, as you can see in the following image.

The larger distance between beats in player B implies that the tempo of that track 
is slower than the track in player A. If you were to start playback of both tracks with 
the image above as a starting point, the beats would only match for a short period 
of time; quite soon the beats in player B will be heard later than the one in player 
A. To correct this you would need to raise the playback BPM of player B.

The following image of the Beatmatcher shows a situation where the tempo of 
both players is the same and where the beats are aligned: both tracks are now 
synchronised. 

 

However, the peaks view gives us no information as to whether the downbeat of 
the track in player A and the downbeat of the track in player B are audible at the 
same time. This information can be made visible by enabling the beatgrids for the 
Beatmatcher.

Beatgrids of the Track
Since the introduction of the beatgrid features you can additionally display the 
beatgrid of the track on the Beatmatcher as well. To make the beatgrid visible, ac-
tivate option Show Beatgrids on the Display tab of the Preferences dialog. (Please 
note, that this option makes the beatgrid visible both on the Beatmatcher and on 
the waveform of the players.)
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The long vertical lines with the yellow triangles for player A and the red triangles 
for player B at their endpoints represent the first downbeat of a 4 bar (=16 beats) 
cycle. All other long vertical lines represent the downbeat of a bar (i.e. the first 
beat of a 4 beat bar). 

The shorter lines that you see at the top and the bottom of the peak display repre-
sent either another beat or a fraction of one beat. The number of shorter lines that 
are shown varies depending on the zoom factor that you have set with the zoom 
slider at the right side of the Beat Matcher.

Using the Sync Meter
The Sync Meter in the Sync zone shows the playback position of the two tracks in 
the players, either related to one bar or to one cycle ( = 4 bars, 16 beats). The cur-
rent mode of the Sync Meter is shown in the middle of the Sync Meter as 4 or 16. To 
switch between the modes click the current Sync Meter value.

Sync-Meter Mode
4 Beats = 1 Bar

Sync-Meter Mode
16 Beats = 4 Bar

If the Sync Meter value is set to 4 the Sync Meter shows one quarter segment of 
a circle for each beat in one bar. The yellow circle shows the playback position of 
player A and the red circle shows the playback position of player B. As long as the 
playback position of both tracks are not in sync related to one bar, you see the two 
overlapping circles as shown in the following figure: 

once both players are playing the same beat of a bar, then the Sync Meter draws 
one orange circle. This is shown in the following figure:
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If you take a look at the peaks in the Beatmatcher (with beatgrid display enabled), 
you can see that the long vertical lines representing the downbeats are now verti-
cally aligned. The Sync Meter in 4-beat mode (= Bar mode) and the peaks view 
show the same kind of information and you can decide which one you wish to use 
to get your tracks synchronized.

If you click the current Sync Meter value and switch it to 16-beat mode (= Cycle 
mode), the Sync Meter shows whether the two tracks are playing the same beat of 
the same bar, in relation to a cycle of four bars/16 beats. Imagine a beatcounter 
that uses the following format to display the current playback position: Cycle.Bar.
Beat. If the playback position of player A is x.3.2 and the position of player B is x.3.4, 
then they are not in sync in relation to the bar and beat number. For this scenario 
the Sync Meter when in 16-beat mode will draw one yellow circle for the position of 
player A and one red circle for showing the position of player B. In the Sync Meter 
each quarter segment represents one bar; this means that one full circle is equal 
to four bars.

once the number of the bar and the number of the beat of both players are same, 
then the Sync Meter in 16-beat mode will draw one orange circle only. If the cycles 
of the two tracks are in sync, then the beats in a bar are also in sync.

The introduction of the three different synchronisation modes in Cross can help 
you, to get both tracks automatically synced.

Setting the Synchronisation Mode
If you press the SYNC button on the players in Cross, the software always performs 
a beat synchronisation; resulting in the beats of both tracks are played back at the 
same time.

Because Cross uses beatgrids for all tracks it is possible to select between three 
different synchronisation modes. The selected sync mode defines what will hap-
pen when you press/click the SYNC button. In order for this to work the tracks in 
both players do need a beatgrid.
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You can configure the sync mode of Cross by opening the Preferences/General tab 
and select the desired mode in list Sync Mode:

•	 Beat If you select Beat mode, then pressing SYNC only syncs to the other 
player’s beat. Both tracks are then running beat or phase synchronous.

•	 Bar If you select Bar mode, then pressing SYNC synchronizes the track in 
the player to the same beat number in a bar that is playing in the other player. 
Both tracks are running bar synchronous.

•	 Cycle If you select Cycle mode, then pressing SYNC synchronizes the track in 
the current player to the same bar and the same beat number in a cycle that is 
playing in the other player. Both tracks are running cycle synchronous.

7.10  Configuring the Crossfader
Cross has several options to configure the crossfader. One setting, the assignment 
between the left/right side of the crossfader and the Cross players and samplers 
can be done on the crossfader itself: Click the buttons A/C to assign player A and 
sampler C to the left side of the crossfader, and click the buttons B/D to assign 
player C and sampler D to the right side. If the volume of the corresponding chan-
nel is controlled by the crossfader, the button is highlighted. 

you can always use the channel faders C and D to change the volume of the two 
samplers, if you disabled both samplers even when using external mixing mode. 

More crossfader options can be found in the lower part of the Preferences/Gen-
eral dialog.

Use the checkbox Reverse crossfader to swap the assignments of the left/righ 
side of the crossfader.

The listbox Crossfader curve preset offers three different standard shapes for 
the crossfader curve. These presets should suit for most usage scenarios. In case 



7/  Importing and Mixing your Music

100

none of the presets is 100% suitable, you can select the Custom option and then 
use the slider below the listbox to shape your curve.

option Curve Description

Constant Volume This crossfader preset changes the volume of 
both channels at a constant rate, providing an 
even, neutral rise. 

Constant Power This crossfader preset creates a smooth, gradual 
transition. This crossfade decreases the volume 
slowly at first and then quickly toward the end of 
the transition.

Mix This curve leaves the volume of currently audi-
ble signal unchanged until the crossfader is in 
its middle position. During the movement from 
the outermost and the middle position the audio 
assigned to the other side of the crossfader is 
blended in linear. Behind the middle position the 
volume of the faded in side stays unchanged, and 
the volume of the channels assigned to the other 
side decreases.

Custom This is an example of a custom crossfader curve 
allowing fast cuts.

NoTE If you are using the U-MIX CoNTRol PRo 2 you can change the cross 
fader curve on the rear panel on the controller as well. To have good control 
of the crossfader curve you should change it either on the controller or in the 
software: If you wish to change the crossfader curve on the controller, select  
the Constant Volume preset in Cross. If you wish to change the curve setting 
in the software, set the crossfader curve knob on U-MIX CoNTRol PRo 2 to  
its min position, before making adjustments in the software.

7.11  Customising the Players
You can customise players to make them better fit your needs. Some of the options 
are available in the user interface.

Scroll Mode

Lead In

Waveform
Zoom

Vinyl Mode/CD Mode
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Waveform Zoom Use the three buttons at the outer side of the waveform to zoom 
in, to zoom out and to reset the  zoom to the default value.

Waveform Scroll Mode In the default setting the playback marker on the wave-
form is at a fixed position and the waveform moves underneath it during playback. 
Click the Waveform Scroll Mode button, if you want the playback marker to move 
and the waveform to be fixed. 

Vinyl Mode/CD Mode This button is only available in internal control mode and 
can be used to activate Vinyl mode. In Vinyl mode you can use the jogwheel of your 
MIDI controller to scratch your media. you can press the (V) key instead to toggle 
the Vinyl mode of the active player. 

More player related settings can be found on the General tab and on the Display 
tab of the Preferences dialog.

 

Lead In/Lead out  Use the two sliders Lead In and Lead out on the General tab 
to set the length of the lead In and the lead out Marker.

End of Track Alarm Use this slider on the Display tab to set the remaining play 
time of a track, during which the full track display shall blink red to warn you, that 
you will soon reach the end of the track. 

7.12  Moving in a Track
you have several options to change the playback position of a track:

•	 Use the jogwheel of U-MIX CoNTRol PRo2/U-MIX CoNTRol 2 to seek through 
the track as long as the track is not playing. Holding the SHIFT button on the 
controller seeks through the track at a higher speed.

•	 Click into the waveform or into the full track display. Playback continues from 
where you clicked.

•	 lift the needle and set it back at another position of the record if you are in 
absolute mode and using control vinyl.

•	 Use the jogwheel or the Seek buttons on your CDJ player, if you are using con-
trol CDs.

you can use the Smart Seek controls to perform a beat jump forward in a track. 
The Smart Seek controls reside in the transport section of the players. Click the 
Smart Seek Length indicator to select the seek length (in beats or fractions of a 
beat). Then click either on Smart Seek Backward or on Smart Seek Forward.
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Smart Seek Length

Smart Seek Backward               Smart Seek Forward

The Smart Seek actions can be performed with the keyboard and with U-MIX CoN-
TRol PRo 2/U-MIX CoNTRol 2 as well:

Action U-MIX CoNTRoL Windows Mac oS X

Select length
 +  (press)

— —

Smart Seek 
Backward  +  (turn left)

(Alt)+(æ) (Alt)+(æ)

Smart Seek 
Forward  +  (turn right)

(Alt)+(Æ) (Alt)+(Æ)

7.13  Using the Preview Player
If you have two tracks playing at the same time and are not sure, which track to 
play next, you can use the preview deck to help make your selection. 

Press the Play/Pause button to start playback of the track that is currently se-
lected in the browser. Use the Seek slider to move through the track: the top of the 
slider represents the beginning of the track. 

Play/Pause

Seek through Track

Volume

The Volume knob allows you to change the volume level of the preview deck. If you 
use Cross in internal mixer mode, the audio of the preview deck is sent to the Cue/
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Monitor output you configured. In external mixer mode you would need a mixer 
with three channels and an audio interface with three stereo outputs, as the audio 
of the preview deck is sent to the Cue output, which is routed to the outputs config-
ured as output 3 (on Preferences/Audio dialog).
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8/ 
organizing your 
Music with the 
Browser

The lower part of the Cross window contains the browser. you can use the brows-
er to organize your music, to search for tracks, to create and use playlists, and 
to manage your sample banks. You can use the following audio file formats with 
Cross: MP3, AIFF, WAV, oGG, FlAC, M4A and AAC.

Before you can work with the audio files in the browser you need to import them 
into the collection. The steps for importing tracks are explained in the sections on 
page 82 and onwards. How to use the sample banks is explained in chapter 11 
on page 137 and onwards.

8.1 Overview of the Browser
The browser section of Cross has two main panels: the dock panel and the browser 
panel itself. The dock and its buttons allow you to quickly open different views of 
your media. The main part of the browser section shows all media inside the list 
that you have selected by clicking its button in the dock.

8.2 The Dock
The dock is the central component of the track management as it allows you to 
open different views or different locations by clicking the corresponding button. 
The dock can be customized: you can add buttons, remove buttons and change 
their order.

By default the dock contains the following standard tabs:

•	 Collection opens the Collection. The Collection list contains all tracks that 
you have added to your collection. Additionally all your playlists and smart lists 
reside here.  

The History node contains information about the sets you have previously played. 
The lists inside the History node are organized by year and month. Inside the 
month node you will find a playlist for each session. 

you can change the naming pattern by opening the Preferences/General dialog 
and entering a new pattern into the text box History Node Naming Pattern. If 
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you hover over the text box Cross displays the placeholders that can be used 
in the pattern.

•	 Files  opens a list with all local and remote drives and folders of your com-
puter.

•	 iTunes opens the iTunes library on your computer including all playlists that 
you have created in iTunes.

•	 Prepare The Prepare button opens the Prepare window which is a holding 
area for tracks, similar to when a DJ sifts through records in a record bag. 
you can use the Prepare window to either prepare a set or to add tracks that 
you may wish to play through the course of your gig. you can drag tracks or 
complete folders from the track browser onto the Prepare icon in the dock. To 
create a playlist from your Prepare list, right-click the tracks and select Add 
to New Playlist.

•	 Autoplay The Autoplay list is a special playlist and can be used to let Cross 
mix the tracks for you. More information can be found on page 130.

Organizing and Customizing the Dock
The dock can be customized in various ways:

•	 Drag a button in the dock to a new position if you wish to change the display 
order of the buttons.

•	 Drag a button out of the dock to remove it.

•	 Right-click on the dock to open the context menu. 

•	 The upper part of the context menu contains all default lists. Click on a menu 
entry to show/hide the corresponding button in the dock.
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•	 The lower part of the context menu contains all user-defined entries/lists. Click 
the name of an entry to remove its button from the dock.

•	 Drag any playlist, smartlist, sample bank, or folder from the browser tree and 
drop it on the desired position on the dock to add a user-defined button.

8.3 The Browser Panel
In the default setting the browser area contains a tree view and a list view of the 
element you opened by clicking its button in the dock. 

Album Browser On/Off
Column Browser On/Off       

              
Dock               TreeView     

The list that is shown at the right side of the browser panel contains all tracks 
of the currently selected folder, playlist, sample bank, or any other element that 
has been selected in the treeview or the in the dock. When a track contains meta 
information, those are shown in the list. If no meta information is available then 
the filename is shown.

You have several options to change and configure the list view:

•	 Sorting the list Click on one of the column headers to sort the list by this 
column. The label of the clicked column will then contain a little arrow showing 
the sort order (ascending/descending).

•	 Selecting columns Right-click on the name of one of the columns. Cross 
opens a list with all available columns. Click the name of the column you wish 
to show/hide.

•	 Changing the order of the columns Click one of the column headers and drag 
it to another position to change the order of the columns.

The first column titled A. that you see in the previous figure informs you about the 
analysis status of the track. Here you will see a question mark if the track is not yet 
analyzed. A check mark tells you that the analysis has been done.

The second column indicates the quality of the track. The following icons are used:
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Icon Quality AAC MP3, WAV, AIFF etc.

Perfect Bitrate >= 256 kbps Bitrate >= 320 kbps

Great Bitrate >= 192 kbps Bitrate >= 256 kbps

Good Bitrate >= 160 kbps Bitrate >= 192 kbps

Average Bitrate >= 96 kbps Bitrate >= 128 kbps

Poor Bitrate >= 64 kbps Bitrate >= 96 kbps

Buggy Bitrate < 64 kbps Bitrate < 96 kbps

The third column from the previous browser image contains information about the 
status of the track. Here you can see if the track is loaded into player A or player 
B, if the track has been played after you have launched cross or the status of the 
track analysis and if the track is currently being analyzed.

The Title Bar
The title bar shows the current node name, the number of tracks and it contains 
the search field and the buttons to open and close additional panels.

The Column Browser
Click the Column Browser button in the title bar to open the Column Browser 
panel. In the default setting the column browser groups the tracks by three differ-
ent properties that Cross extracts from the media files: Genre, Artist and Album. 
You can refine and filter the list view by clicking an entry in any of the property 
lists. To remove a property selection, click the X in the title bar of the property list.

Right-click any of the title bars to open the Visible Properties menu. Here you can 
select another property for that list or you can click on Default to return to the 
standard setting with the Genre, Artist and Album properties. you can drag and 
drop the property header to change the order of the browsing columns.
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The Album Browser
If is easier for you to remember an album cover than the track name or artist, 
you can open the Album Browser by clicking the third button in the title bar. If the 
Column Browser is currently open, the attributes and the album covers also serve 
as filters. To see all album covers you either need to close the Column Browser or 
to deselect all currently activated properties. If you click on one of the covers, all 
tracks of the selected album are shown in the list.

8.4 Searching for Tracks
Another way other than using the filter functionality of the Columns Browser and 
Album Browser is entering the search criteria direct into the Search field that sits 
at the right side of the title bar. Entering search words triggers a dynamic search 
in your collection, i.e. Cross displays all tracks found that match the search criteria 
entered so far.

In the default setting Cross searches in the Album, Artist, Genre and Title proper-
ties of your tracks. you can change the properties that Cross should search in by 
clicking on the magnifying glass at the left side the Search field; this opens the 
Active Properties menu.
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•	 Click on one of the properties, to include/exclude it from the search.

•	 Click on All to have Cross search in all available properties.

•	 Click on Default to restore the default property selection that is shown in the 
previous image.

8.5 Using Playlists and Playlist Folders 
Playlists can help you to prepare for a gig or to organize your music collection. you 
can create playlists from scratch or use the playlists that you may have already 
made in iTunes. Playlists are created in the Playlists node of your collection. As 
with iTunes, this node can contain folders as well as playlists. This makes it pos-
sible to organise playlists hierarchically. 

Creating Folders 
To create a playlist folder, follow these steps:

1 Click the Collection button in the dock.

2 If you wish to create a folder at the highest level right-/ctrl-click the Playl-
ists node. If you wish to create a folder at a lower level right-/ctrl-click the 
parent folder.

3 Select Create New Folder from the context menu.

 A new folder with the name “Untitled Folder” is created and the name is 
selected.

4 Enter the desired folder name and press [¢].
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NoTE If you wish to rename an existing folder, double-click the name to 
enter edit mode, make your changes and press [¢].

Creating an Empty Playlist
To create an empty playlist, follow these steps:

1 Click the Collection button in the dock.

2 open the Playlists node if necessary.

3 If the new playlist is to reside in Playlists node, right-click node. If you wish 
to create the playlist inside a playlist folder, right-click this folder.

4 Select Create new Playlist in the context/action menu.

 A new playlist with the name “Untitled Playlist” is created and the name is 
selected.

5 Enter the desired playlist name and press [¢].

NoTE If you wish to change the name of an existing playlist, double-click its 
name to enter edit mode, make your changes and press [¢].

Creating a Playlist from inside the Listview
If you are currently in listview and see some tracks that should be at the beginning 
of a new playlist, proceed as follows:

1 Select the track or tracks in listview.

2 Right-click the selection and choose Add to new Playlist. Cross opens the 
following window:

3 Enter a name for the playlist and click oK.

 The new playlist is created and the selected tracks are added to the playlist.
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Creating a Playlist from iTunes
If you have already created a playlist in iTunes you can import the list easily into 
Cross by proceeding as follows:

1 Click the iTunes button in the dock.

2 Right-click the iTunes playlist that you wish to import.

3 Select Export to Playlists to put the playlist directly below the Cross Playl-
ists node. 

 or:

 Select Export to Playlists Folder and select the folder to where the iTunes 
playlist shall be exported.

Adding, moving and deleting Tracks
Tracks can be added to a playlist by selecting them in the listview, then by drag-
ging them onto the icon of the playlist icon in the Treeview. If you have added a 
playlist button for the target playlist to the dock, you can drag and drop the se-
lected tracks onto this button. 

Another way to add tracks to a playlist is by using the context menu in listview. 
Select the track/s you wish to add to an existing playlist. Then right-/ctrl-click the 
selection. Click Add to Playlist and then select the desired playlist in the submenu 
of this command.

New tracks are always added at the end of the playlist. To change the order of the 
tracks in a playlist use drag & drop. 

To delete a track from a playlist, right-/ctrl-click the track and choose Remove 
from Playlist.

8.6 Using Smartlists
Smartlists are another useful feature that help you to organize and find your 
tracks. Smartlists are filters that are applied to your collection. A smartlist filter 
can contain one or more conditions. Most of the conditions that can be used query 
the meta information of your tracks, like the title, artist or tempo. other conditions 
query data that is stored in your collection, like the date the track was added, for 
example.

Cross contains several pre-defined smartlists. To see which smartlists are avail-
able, click the Collection button in the dock and then open the Smartlists node in 
the treeview. 



8/  Organizing your Music with the Browser

112

Click on one of the smartlist names. The filter contained in the smartlist defini-
tion is applied to your collection and the resulting tracks are shown in the listview 
panel of the browser.

Let’s have a look at the inside of one of the pre-defined smartlists. This will help 
you to define your own smartlists.

1 Right-click on the smartlist 115–135 BPM.

2 Click Edit in the context menu.

 Cross opens the panel with the smartlist editor.
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 Filter Type: ALL or ANY

 Have a look at the title bar of the smartlist editor. The title reads “Match 
All of the following search criteria”. Cross supports two different types 
of smartlist filters. For the type that is used here, all of the defined search 
criteria must be met for a track to be displayed in the search results.

 For the second type you will read “Match ANy of the following search crite-
ria” in the title bar. With this type only one of the defined conditions must be 
met for a track to be displayed in the search results.

 You can simply change the filter type by clicking the title bar of the smartlist 
editor.

 Standard options for Smartlists

 The first three rows shown in the previous figure are standard options that 
are available in all smartlists. The checkbox at the very beginning of the 
row must be activated; otherwise the option is not applied.

 Activate Auto Refresh if Cross is to update the search results while you 
are defining the search criteria. If Auto Refresh is deactivated, the search 
results will not update until the next time the smartlist is opened. 

 you can use the second row, Limit to, to limit the search results. As well as 
the number of tracks, you can set a limit by file size (in MB or GB), or you 
can define a limit of the total playing time of the tracks (either specified in 
minutes or hours). You define a limit by opening the list box to select the 
criteria. Then enter the desired value into the text box of that row.

3 Change the number of tracks from 25 to 40.

4 The last standard option is the sort order. open the list box ordered by in 
the third row to get an idea of the available options.

5 All other rows contain the criteria that shall be used for this smartlist. In 
this example the BPM of the track shall be used, and the BPM must be in 
the range from 115 to 135. open the listbox where currently BPM is se-
lected to get an idea of the information fields that can be used.

6 Click the button with the Plus sign in the title bar of the smartlist Editor. A 
new row is added at the bottom of the editor. We want to refine this smart-
list and add a criteria that filters all House tracks.

7 Open the first listbox and select Genre.
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8 open the second listbox and select is.

9 open the third listbox and select House.

 If there are tracks in your collection that meet both criteria they are now 
shown in the listview.

10 Click the title bar to change the filter type from ALL to ANY.

 Now the listview will show all tracks where the genre is house or where 
the BPM of the track is inside the defined range.

11 Click the Minus button in front of the genre row. The row is deleted.

12 Click the oK button in the title bar to close the smartlist editor.

NoTE The button with the x in the title bar of the smartlist editor removes 
all criteria.

Creating a new Smartlist
Smartlists are created in a similar way as playlists. 

1 opening the collection by clicking the Collection button in the dock.

2 Right-/ctrl-click the Smartlists node and select Create New Smartlist if 
you wish to create a new smartlist. Cross creates a new smartlist with the 
name “Untitled Smartlist”. The name is selected and you can edit it.

NoTE If you wish to create a new folder node first, click Create New 
Folder and then use the command to create a new smartlist.

3 Enter the desired name for the new smartlist and press (¢).

4 Define the criteria for the new smartlist as shown in the previous section.
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8.7 Viewing and Editing Track Meta Information
Most of the audio file formats that can be used with Cross allow the storage of 
meta information about the file, like the artist or the release date of a track. You 
can view and edit this meta information in either listview or in the Info panel of 
the browser. 

Cross can write the changes you make either to the collection file only, or to the 
collection file and to the tags of your audio track files. You can configure whether 
Cross shall write the changes to the file tags or not on the Preferences/General 
dialog by checking or unchecking the option Save changes in Tags.

To make changes in Listview, double-click the field you wish to edit, enter your 
changes and press (¢). Some of the fields in Listview provide a listbox where you 
can select one of the options. Other fields, like the audio format, are static, and 
cannot be changed.

Another option is to use the Info panel of the browser to see all available informa-
tion about a track and to make changes to a track. Select the file you want to edit 
and click the Info button in the tool dock at the right side of the browser area.

The information about the selected track is grouped in categories. Click one of the 
category names to see detailed information about this category. Please note that, 
like in Listview, not all fields can be edited.

you can use the Info panel to add a cover image to a track. Click the ellipsis button, 
select the image file, and click open. If you wish to delete a cover image, click the 
Delete button (with the x) that is visible below the cover art.

As well as the “standard” tags for audio files, Cross allows you to attach a colour 
category to a track. Click the black square in the Labels section (or click the cor-
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responding square in listview), to open a listbox with the colours available. you 
could use one colour for warming up tracks, another colour for peak-time tracks 
or whatever kind of category you desire.

8.8 Locating Missing Tracks
If you move tracks from one folder to another or if you have changed the filename 
of a file that is already in the collection, Cross will no longer be able to find the 
track. The Status column in the listview then shows a red warning icon, like the 
one you see in the following image. 

Right-/ctrl-click this row and select Relocate from the context menu. Browse to 
the new file location, select the audio file and click open.

If there is more than one track missing it is easier to use the Missing Tracks Re-
solver: open the File menu and click Resolve all missing tracks. The Missing 
Tracks Resolver window opens. 

Select the file you wish to relocate, click Relocate and browse to the new location 
of the file. If you can no longer find the missing files, click Remove to delete the 
file from the collection.
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8.9 Using more than one Collection
In the default setting you will organize your tracks and audio files by using one col-
lection. However, if you use a great number of audio files, and if want to organize 
them into different collection files, you can do this easily.

Creating a new Collection
Follow these steps to create a new collection:

1 open the File menu and click on Create Collection, or press the shortcut 
(Ctrl]+[N) (Windows) or (cmd]+[N) (Mac). The Save new collection to dia-
log is opened.

2 Enter the name of the new collection.

3 Click Save.

 The new collection is created. Cross will open the new collection automati-
cally.

TIP If you wish to save the open collection with a different name, open the 
File menu, click Save collection as and enter the new filename for the cur-
rent collection.

Opening another Collection
Perform one of the following actions to open another collection:

•	 open the File menu, click on Recent Collection and click on the name of the 
collection, you wish to open.

•	 open the File menu and click on open Collection or press the shortcut 
(Ctrl]+[O) (Windows) or (cmd]+[O) (Mac). Select the collection file in the open 
dialog and click open.

NoTE On launch, Cross will automatically open the collection file that was 
last used.

8.10  Optimizing the Collection Database
Cross stores all tracks and all playlists of your collection are stored in a database 
file. When you make bigger changes to your collection, for example deleting mul-
tiple files, the database file can become fragmented. If the database file is frag-
mented it takes a bit longer to access your collection. you can defragment and op-
timize your collection by opening the File menu and selecting Optimize collection.
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9/ 
Advanced  
Features

This chapter explains the advanced features that are available in the Cross play-
ers. Some of these features will change the playback position in the track. These 
features are: the pitch controls, the loop feature, the hot cues (locators) and the 
cue point feature. If you are using timecode media, the first three features are 
always available in relative mode. you can use them in absolute mode only when 
the checkbox Automatic Control Mode Switching is activated. More information 
about this setting can be found in section “External Control Modes and Non-linear 
Features” on page 91.

9.1 Using the Pitch Controls
Each Cross player has its own pitch fader that works in a similar way as the pitch 
fader you know from a turntable or CDJ player. The main difference of the Cross 
pitch faders is that they offer three different pitch modes: Speed, Master Tempo 
and Hybrid. 

Selecting the Pitch Mode
Perform one of the following actions to set the pitch mode:

•	 Click the Mode button in the lower part of the pitch section of the players. The 
Mode button is labelled with the currently active pitch mode (i.e. Speed, MT for 
Master Tempo, or Hybrid).

•	 If you are using the U-MIX CoNTRol PRo 2 controller hold SHIFT and press the 
BEND– button below the pitch fader. 

•	 Press (ÿ) to switch to the player; then press (P).

What are the differences between the three pitch modes:

•	 Speed In Speed mode you can change the pitch like you would do with a nor-
mal DJ turntable. Changing the tempo of the player also changes the pitch of 
the audio. 

•	 MT, Master Tempo In Master Tempo mode you can change the playback 
tempo without affecting the tone pitch. The Tempo mode thus has a similar 
effect as the Master Tempo mode that is available on several CDJ-Players.   
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In Master Tempo mode Cross uses a time stretching engine, which allows play-
back of audio at different tempos without changing the tonal key. When Master 
Tempo mode is activated, the Pitch fader is no longer a pitch fader but more a 
tempo fader, because a tempo change will not affect the pitch.

•	 Hybrid The Hybrid mode is a combination of Speed mode and Master Tempo 
mode as it considers the percentage speed change.

-100%        -66%             -33%               0%            +33%            +66%           +100%

Master Tempo 
Mode

Speed
Mode

Smooth
Transitions 

Speed
Mode

Smooth
Transitions 

In the range from –33% to +33% the fader behaves like Master Tempo mode. 
Below -66% and above +66% the fader behaves like Speed mode. In the range 
from –66% to -33% and between +33% to +66% the pitch is gradually increased 
or decreased to smooth the pitch transitions. This mode delivers great results 
as you get the best from Speed mode and Tempo mode. The sounds stays more 
natural at extreme speed values, and you have a wide constant-pitch range 
around 0% speed.

Changing the Tempo with the Pitch Fader 
you can use the pitch faders or the Up-Arrow, Down-Arrow and Reset button in the 
Pitch section of the player to change the playback tempo. The range to adjust the 
tempo can be changed with the Range list on the Pitch section. If you use either 
U-MIX CoNTRol PRo 2 or U-MIX CoNTRol 2 hold the SHIFT button and press the 
BEND+/RANGE button to change the range of the pitch slider.

Click to change 
Pitch Range

Reset Tempo

Pitch Bend DownPitch Bend Up

Click above/below
fader knob to

change tempo

Cross offers five different ranges and the range can be set individually for each 
player. For example, if you select 16% and if the original tempo of a deck is 125 
BPM, then you can increase or reduce the tempo maximum by 20 BPM. 
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you can click above/below the pitch fader knob to change the tempo stepwise. The 
tempo is changed in smaller increments if you hold the (ª) key while clicking the 
button; you get larger increments if you hold the (ctrl) key. Click the Reset button 
(or press (ª)+(0)) to set the tempo back to the original BPM of the track. 

The two tempo fields below the Pitch section always show the current tempo as 
BPM value and the percentage difference to the original BPM.

If you use control vinyl/CD it is good practise to set the pitch fader on the Cross 
players to the middle position and control the tempo with the pitch faders on your 
turntable/CD player even though it is possible to use both at the same time. If the 
pitch fader on the player is not in its centre position, an exclamation mark is shown 
on the relative button.

Pitch Bending
Two of the buttons in the Pitch section can be used for pitch bending. These but-
tons temporarily slow down ( ) or speed up the tempo ( ). 

As soon as the buttons are released the previous tempo is restored. This corre-
sponds to nudging a spinning record on a turntable and to the two pitch bend but-
tons found on CDJs. on a technical level pitch bending is used to move the phase 
of a player. you may need this to get the beats of two tracks in sync, once they are 
playing at the same tempo.

The acceleration and deceleration factor is always relative to the current tempo of 
the deck. Cross provides options to configure three different percentage values, 
fine, normal and coarse which allow you to pitch bend.

Follow these steps to configure the three pitch bend factors:

1 Go to the menu and click File/Preferences. Make sure that the General tab 
is open 

2 Use the three sliders to set the pitch bend factors for the different ranges.

NoTE The factor for Fine must be smaller than the one for Normal 
and the factor for Normal must be smaller than the one for Coarse.

Pitch bending can be done with the U-MIX CoNTRol PRo 2 controller, in the Cross 
players with the mouse and with keyboard shortcuts, as the table on the following 
page shows.
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Action U-MIX CoNTRoL PRo 2 Player/Mouse Keyboard

Normal Up 
(D)

Normal Down
(E)

Coarse Up – (Ctrl)/(cmd)+ (Ctrl)/(cmd)+(D)

Coarse Down – (Ctrl)/(cmd)+ (Ctrl)/(cmd)+(E)

9.2 Snapping and quantizing Loops, Locators 
and Cue Points

With the beatgrid feature loops, locators, and cue points can be set either at the 
current playback position or they can automatically snap to the next beat, next 1/2 
beat, next 1/4 beat or next 1/8 beat of the tracks’ beatgrid. The snap on/off settings 
and the snap value settings are global parameters that can be configured in the 
Snap section of the Sync zone. If the Sync zone is not visible, open the View menu 
and select Sync Zone.

To enable the snap feature, click the SNAP button in the Sync zone. you can set the 
snap value by clicking the Snap Length indicator below the SNAP button.

Quantization
The quantize feature ensures that several actions you perform to change the play-
back position (like jumping to a locator or seeking through a track) are synchro-
nized to the reference beatgrid. For all player related actions the reference beat-
grid is the beatgrid of the track. The granularity for the quantization is defined by 
the current selected quantize value.
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To enable the quantize feature, click the QUANTIZE button in the Sync zone. open 
the list below the QUANTIzE button to select the quantize value.

9.3 Looping
Cross allows you to set loops in your tracks on the fly. You can either use the auto-
matic loop feature with one of the predefined standard loop sizes or you can create 
manual loops by setting the loop IN point and the loop oUT point.

Automatic Loops Manual Loops

Loop Activation

NoTE If Cross is configured for timecode usage and if absolute mode is ac-
tive when you create a loop, Cross will switch automatically to relative mode 
as you create a loop. This is because during looping the playback position of 
the control media and the playback position in the track are no longer the 
same.

Using Automatic Loops
Each Cross player contains a loop section below the waveform. you can use the 
loop section to set the length of automatic loops and to activate the loop at the 
same time. Cross provides several default loop sizes, ranging from 1/32 beat up 
to 32 beats. 

Follow these steps to create an automatic loop:

1 Perform one of the following actions:

•	 Click the button Plus or Minus in the loop section until the desired loop 
length is selected. Then click the Autoloop button.
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•	 Press (ÿ) to activate the player with the track you wish to set the loop. 
Press (J) and (K) until the desired loop length is shown on the Autoloop 
button. Press (U) to activate the auto loop.

•	 Turn the Loop encoder on the U-MIX CoNTRol PRo 2 controller to se-
lect the desired loop length. Press the Loop encoder to activate the loop.

TURN: Select Loop Length
PRESS: Activate/deactivate Loop

 Cross sets the loop start point at the current position of the playback mark-
er, if Snap is disabled, or snaps it to the currently selected snap length, if 
Snap is enabled. Then the loop is activated. 

 C

 on the waveform the section of the track that is looped is highlighted with a 
white triangle. In the full track display the looped part is shown in a bright 
colour and the rest of the track in a dark colour.

2 While the loop is active you can:

•	 Change the loop length, by using the (J) and (K) keys, or by clicking 
the buttons + (Expand Auto-Loop) or – (Shrink Auto-Loop) in the loop 
section of the players, or by turning the Loop encoder on your U-MIX 
CoNTRol PRo 2 controller.

•	 Deactivate the loop either by using the (L) key, or by clicking the  
Autoloop button, or by pressing the Loop encoder on your U-MIX CoN-
TRol PRo 2. 

Using Manual Loops 
The length of manual loops can be set as needed. To create a manual loop you 
need to define a loop in point as well as a loop out point.
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1 Move the waveform to the position of the desired loop in point, or wait until 
playback reaches the position, where the loop in point shall be set.

2 Click the In button or press the (I) key.

3 Move the waveform to the position of the desired loop out point, or wait until 
playback reaches the position, where the loop in point shall be set.

4 Click the out button or press the (O) key.

 The looped section of the track is marked in the waveform and in the full 
track display. Additionally the loop is activated: the loop button is now 
highlighted.

once they are created manual loops behave in the same way as automatic loops. 
To change the loop size of a manual loop you can either set a new loop out point or 
move the current one. This is explained in the next section.

Moving the Loop
Sometimes you will find that the loop is not exactly where you want it. The Smart 
Seek feature of Cross makes it easy to move an activated loop:

1 First you need to define the Jump length by performing one of the following 
actions:

•	 Click the Smart Seek Length display until the desired jump length is 
shown.

•	 Hold the SHIFT button on your U-MIX CoNTRol PRo 2 controller and 
press the Loop encoder until the desired jump length is shown in the 
Smart Seek Length display.

2 Now you can move the loop by performing one of the following actions:

•	 Click the Smart Seek Backward or the Smart Seek Forward button.

•	 Press (Alt)+(æ) to move the loop towards the begin of the track or 
press (Alt)+(Æ) to move it towards the end of the track 

•	 Hold the SHIFT button on your U-MIX CoNTRol PRo 2 controller and 
turn the Loop encoder.

9.4 Using Cue Points 
If you load a track for the first time, Cross  will create a cue point at the beginning 
of the track. The cue point is symbolised on the waveform and in the full track dis-
play by a cue marker, which looks a little bit like a flag on a flagstaff. 
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Cue/Stop

you can use the Cue/Stop button to start the playback at the position of the cue 
point and to set the cue point position.

NoTE The Cue feature is not available if the player is currently configured 
for timecode usage.

Setting the Cue Point 
Use the Snap button and the Snap length selector on the player to enable/disable 
the Snap feature. Then perform one of the following actions to set the position of 
the cue point:

•	 Click the Cue/Stop button while the track is paused.

•	 Press the shortcut (ª)+(C).

•	 Hold the SHIFT button on U-MIX CoNTRol PRo 2 and press the CUE button 
while the track is playing. When the player is paused press the CUE button. 
(Note: SHIFT+CUE also works.)

TIP The last cue point that you set in a track is automatically stored in the 
peak files.

Jumping to Cue Point and start Playback 
Perform one of the following actions to jump to the cue point and to start playback:

•	 Press the (¢) key.

•	 Hold the SHIFT button and press PLAY/PAUSE on U-MIX CoNTRol PRo 2 to 
activate Cue/Play from the controller.

•	 Hold the CUE button and press the PLAY/PAUSE button on U-MIX CoNTRol 
PRo 2. Playback will continue when you release both buttons.
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Jumping to Cue Point and start Playback temporarily 
Perform one of the following actions to jump to the cue point and to start playback. 
All actions set the play marker to the cue point position. The track is playing as 
long as the button/key is pressed. If you release the button/key, playback is paused 
and the play marker is set to the cue point position again. 

•	 Click the Cue/Stop button in the player while the track is playing. 

•	 Press the shortcut (C), while the track is playing.

•	 Press the CUE button on U-MIX CoNTRol PRo 2 while the track is playing. 

9.5 Using Locators (Hot Cues and Loops)
Several of the professional CDJ players allow you to store cue points in a track 
either on a memory card or in the memory integrated into the CDJ player. you can 
jump to a stored cue point – sometimes called hot cue – by pressing a button on 
the CDJ player.

Cross allows you to store cue points as well; stored cue points are called locators. 
A locator can either be a normal cue point, or a loop, or the IN point of a loop.

The locators are managed in the locator section below the players. If the locator 
section is not visible, press the Locators button on one of the players. The locator 
section informs you of the number and the position or name of the locators in the 
currently loaded track.

NoTE If you use timecode in absolute mode when you jump to a locator, 
Cross will switch automatically to relative mode because after the jump the 
playback position of the control media and the playback position in the track 
are no longer the same.

Locator Section

Locator Markers

Click to open/close
Locator Section
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Creating Locators and Jumping to Locators
Perform the following steps to create a locator:

1 Use the Snap button and the Snap Length selector in the Sync zone to en-
able/disable the Snap feature. If the Snap feature is enabled, the new loca-
tor will snap to the next beat or portion of a beat depending on the Snap 
Length value that has been selected.

2 Set the playback marker to the position where you wish to set the locator or 
wait until playback reaches the desired locator position. 

3 Perform one of the following steps. Please note that you can only set a loca-
tor if the locator button is not currently being used.:

•	 Click one of the locator buttons in the locator panel 

•	 Use the (ÿ) key to set the focus to the player where you wish to set a 
locator. Press (1) to set locator 1, (2) to set locator 2 etc. 

•	 Make sure that the LoC/SMP button on your U-MIX CoNTRol PRo 2 is 
set to LoC. Press one of the locator buttons 1, 2, 3, 4 to set locator 1, 
2, 3, or 4.

Toggle between Locators/Sample Pads

BUTTON ONLY: Set/Select Locator
SHIFT+BUTTON: Delete Locator

 The position of the locator (time) is shown on the locator button. you can 
assign a name to the locator; this will help you to keep your locators orga-
nized.

NoTE If looP is currently oN, the current loop will be stored and 
not the current location. See section “Creating and Using locators for 
loops” on the next page for more information.

4 Move the mouse onto the button with the number of the locator and click. 
the number. Select Rename in the menu, enter the name for the locator 
and press (¢).

 you can use the same steps to change the name of the locator at any time.

The same keys/buttons from step 3 can be used to jump to a locator, once it is set.
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Creating and Using Locators for Loops
Perform the following steps to store a loop as a locator:

1 Create the loop you want to store by using the steps explained in section 9.3 
on page 122 and onwards.

2 Click one of the locator buttons in the locators panel, or use the keyboard 
shortcuts or your U-MIX CoNTRol PRo 2 controller as explained on the 
previous page.

 The IN point of the loop is stored as the position of the locator.

once the loop is stored, you can click the corresponding locator button to jump to 
the beginning of the loop; the loop is automatically activated.

Changing the Order of the Locators
If you wish to change the order of the locators, you can do so by using the mouse. 

1 Point with the mouse to the button with the number of the locator you wish 
to move.

2 Click the number of the source locator and drag it onto the number of the 
target locator.

3 Release the mouse button. The positions of the source and the target loca-
tor are swapped.

Deleting Locators
Perform one of the following actions to delete a locator:

•	 Click the Delete button (with the X) next to the locator that you wish to delete.

•	 Use the (ÿ) key to set the focus to the player where you wish to delete a loca-
tor. Press (ª)+(1) to delete locator 1, (ª)+(1) to delete locator 2 etc.

•	 Make sure that the LoC/SMP button on your U-MIX CoNTRol PRo 2 is set to 
LoC. Hold the SHIFT button and press one of the locator buttons 1, 2, 3, 4 on your  
U-MIX CoNTRol to delete locator 1, 2, 3, or 4.

9.6 Recording
Cross has an integrated recorder that, if you use internal mixer mode, you can use 
to record your mixes. Additionally Cross also allows you to record the audio from 
each player. If you have an external mixer and wish to record your mixes you can 
connect the Record out or Booth output to an external recorder. This sections ex-
plains the settings for the mix recorder and how to record your mixes.
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Configuring the Mix Recorder
Before recording your first mix it is a good idea to open the Preferences dialog and 
to configure the recording settings. 

1 Go to the menu and click File/Preferences. Click the Recording 
button to open the settings panel for the mix recorder.

2 option Automatically start recording is disabled by default. In 
this configuration recording starts as soon as you press the Rec 
button in the recorder panel. If you activate Automatically start recording, 
clicking the Rec button puts the recorder in a waiting state; recording will 
start as soon as you start playback in any of the two players. 

3 Click the Browse button next to Recording directory to set the folder where 
Cross shall save the recording.

 If you use Windows the default folder is “My Music/MixVibes/Cross/Record-
ings” below your documents folder. on oS X the default folder is “Music/
MixVibes/Cross/Recordings” below your home directory.

4 Click into the Naming pattern text box, if you wish to change the change 
the naming pattern that Cross shall use for your recordings. The default 
filename is composed from the date/time the recording started.

 Hover your mouse over the textbox Naming pattern to see the placeholders 
that you can use in the pattern.

5 open the list Audio Format and select one of the four formats that Cross 
provides. 

 If you select oGG (ogg Vorbis format) you will see a slider where you can set 
the quality: a higher number delivers better audio quality for the price of a 
larger file size.

6 Select which audio streams shall be recorded by clicking the correspond-
ing buttons in section Record Input. 

 you can record any combination of Audio from Player A, Audio from Player 
B, and Audio from Master Mix. Each stream is recorded into a separate file. 
If you record more than one stream, each filename will be extended by the 
stream name (Player A, Player B, Master Mix).
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Recording your Mix
once you have configured your recording settings follow these steps to record your 
mix:

1 Click the button Start/stop recording in the toolbar to start recording.

2 If you activated Automatically start recording, start playback on any of the 
players to start recording. otherwise recording will start when you press 
the Start/stop recording button.

 During the recording you can see the duration of the recording next to 
Start/stop recording button in the toolbar.

3 Click the button Start/stop recording again to stop recording.

TIP Digitize your Vinyl you can use the recorder to digitize your vinyl. 
Connect your turntable to the corresponding inputs of your audio interface, 
then configure the external audio source as described in section “Cross and 
U46MK2 with External Audio Sources”. Play your vinyl on the connected turn-
table and let the Mix recorder digitize it.

9.7 Using Autoplay
Cross can automatic play the tracks you selected and moved into the Autoplay 
panel. you can move tracks to Autoplay by selecting them in listview and drag and 
drop them onto the Autoplay button in the dock. you can also right-/ctrl-click on 
one track or on several selected tracks and choose Add to Autoplay in the context 
menu. 

Then click the Autoplay button in the dock to open the Autoplay panel.

you can change the order of the tracks by dragging them as you would in any other 
listview. Use the Fade Time slider to configure the timing of the automatic fading. 
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The A/B selector (next to the MIX button) must be set to a player that is currently 
not playing. Finally click on MIX to start Autoplay.

If you wish to start again with the first track, once the last track in your 
Autoplay has ended, click the Repeat button in the right area of the Auto-
play list button bar.

To change the playback order randomly, click the Shuffle button. The new 
playback order of the tracks will be indicated by the numbers in the # 
column of the track list. .

you can click the SYNC button if you want that Cross automatically per-
forms BPM transitions between the tracks. Please note that this feature 
works best if the tracks in the autoplay list have a similar BPM.
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10/ 
Using the  
Effects

Cross provides two effect units that can be freely assigned to the two players and 
the two samplers. For example, you can use one effect unit for one player and the 
other effect unit for one of the samplers. or you can assign both effect units to the 
same player or sampler, allowing you to change the audio signal by use two differ-
ent effects at the same time.

When you are using Cross in internal mixer mode, you can assign the effect units 
to the master signal. In this configuration the effect can be added to the audio from 
both players and both samplers at the same time. 

10.1  Effect Unit Assignment and FX Selection
All controls for the effect units can be found in the FX zone on the Cross user inter-
face. If the FX zone is not visible, open the View menu and select Show/Hide FXs. 

The effect units can be operated in two different modes: in one-dimensional mode 
you control all FX parameters with one knob, the Amount knob. This makes using 
the effects very easy and is the optimum configuration if you use one of the Mix-
Vibes U-MIX CONTROL controllers, as they have one knob. This configuration is 
shown in the following figure:

In bidimensional mode the FX zone looks like this:

In this mode you can use the Amount knob and the Depth knob to change the pa-
rameters for the selected effect.

you can switch between one-dimensional and bidimensional mode by opening the 
Preferences/General dialog and disabling/enabling the checkbox Use bidimen-
sional FX.
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To use an effect perform the following steps:

1 open the FX Assignment dropdown list of FX1 or FX2 and select the input 
channel for the effect. 

 If you have the U-MIX CoNTRol PRo 2 controller, hold SHIFT and turn the 
left or right FX SELECT encoder, to select the input for FX1 or FX2.

2 open the Effect Select dropdown list, and click the name of the effect you 
wish to use. 

 on your U-MIX CoNTRol controller turn the left or right FX SELECT knob 
until the effect name is shown in section FX1 or section FX2.

3 If you wish to fade the effect signal into your mix, make sure that the 
AMoUNT knob and/or DEPTH knob is at the Min position.

4 Click the oN button for FX1 or FX2, or press the left/right FX SELECT en-
coder on your U-MIX CoNTRol to activate the effect.

5 Turn the AMoUNT knob and/or the DEPTH knob clock wise to make the ef-
fect signal audible and to change the effect specific parameters.

The AMoUNT knob and the DEPTH knob control the dry/wet ratio and other effect 
parameters. The common behaviour of the knobs is, that at the min position only 
the dry signal (the original signal from the player) can be heard.

NoTE In case you are missing the Bi-Filter option in the effect selection 
list shown above: The bi-polar filter is now always available for each player 
and each sampler. Use the knobs and buttons that can be found in the mixer 
section to switch the filter on and to change it’s parameters.
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10.2  The different Effects
The following sections give you more background information about the various 
parameters that the AMoUNT and DEPTH knob change. To better understand this 
section, you may wish to load some tracks and play with the effects, while you are 
reading. 

Low-Pass
Low-Pass is a Low-Pass filter (= High-Cut filter) that dampens the high frequen-
cies, i.e. the low and the middle frequencies can pass through the filter.

Hi-Pass
Hi-Pass is a High-Pass filter (= Low-Cut filter), which dampens low frequencies, 
i.e. the middle and the high frequencies can pass through the filter. 

Echo
The Echo and the Delay effect (see next section) are delay effects where copies of 
the original signal are inserted into the output. This results in an echoic impres-
sion.

 
Dry Signal

Wet Signal
Dry/Wet

Feedback Loop

Delay Effect

The Echo effect has a nice trail: keep the amount knob open and pause the player 
to hear it.

Delay
The Delay effect is the second delay effect in the Cross FX suite; one of the main 
differences between Echo and Delay is that Delay uses a fixed delay time of 1/2 
beat; the delay time is in sync to the tempo of the current track. .

Phaser
The Phaser effect uses a phase-shifted copy of the input and mixes it with the origi-
nal signal. When the original and the phase-shifted signal are combined it creates 
one or several notches in the frequency spectrum; those frequencies are elimi-
nated in the output signal. This creates the typical frequency sweep of the Phaser. 
To get the phase shifted copy the signal is sent through an all-pass filter; this filter 
type lets all frequencies pass through, but it changes the phase response.
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X-Phaser
The X-Phaser effect is a variation of the Phaser effect. Unlike the Phaser effect, 
X-Phaser uses a fixed feedback value and the rate of the LFO used for the effect is 
beat-synced to the current playing track. 

Flanger 
The Flanger effect adds a time-delayed copy of the original signal and the very 
short delay time continuously changes. Because the delay time is very short this 
isn’t perceived as an echo. Instead the delay creates kind of a filter effect produc-
ing notches in the frequency spectrum. The result is that groups of frequencies are 
filtered. And because the delay time is changing those notches in the frequency 
spectrum change as well. This in turn creates the typical dynamic swirl effect of 
the Flanger.

Jet
The Jet effect is a variation of the Flanger effect. 

Transform
Transform is a tremolo-style effect: it repetitively changes the amplitude (level) of 
the player’s audio signal. The change of the amplitude sounds as if the audio needs 
to pass a gate, those doors are rhythmically opened and closed.

Chopper
The Chopper effect is an auto filter that allows you to control the LFO rate and the 
frequency ranges of the filter all with one knob. The Chopper effect uses a sine 
waveform to control the lFo. 

Crush
Crush is a distortion effect; changing the sample rate and the bit depth of the origi-
nal audio signal creates the distortion. 

Bliss
The Bliss effect is a white noise generator that is perfectly suited to build drama 
into a mix. 
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Brake
The Brake effect simulates the stopping of a turntable. The AMoUNT knob is used 
to set the brake time, i.e. the time that it takes until the virtual turntable comes to a 
complete stop. The duration can be set in a range from 6 seconds to half a second. 
Set the brake time first, and then switch the effect on. While the brake effect is ac-
tive, you can still shorten or lengthen the brake time by turning the AMoUNT knob.

Roll
The Roll effect is a beat repeater. When you engage the effect by pressing FX on 
(the AMoUNT knob can be at the outermost left position), Cross takes an audio 
sample (2 beats) from the player and stores it in an internal buffer. 

Then, when you turn the AMoUNT knob clockwise, the audio from the player is 
muted and only the sampled audio can be heard. The sampled audio is always 
beat-synced to the BPM of the currently playing track.

you can use the AMoUNT knob to change the beat-length of the audio, which is 
repetitively outputted by the effect. The length of the repeated loop is 2 beats while 
the knob position is between 0 and 20; it is 1 beat when the knob is between 20 and 
40; it is 1/2 beat between 40 and 60; it is 1/4 beat when the knob is between 60 and 
80; and finally it is 1/8 beat when the knob is between 80 and 100.
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11/  
Using the  
Cross  
Samplers

Welcome

The Cross samplers allow you to playback short audio files, samples, in your DJ 
set. There are two samplers in Cross; you can load and use up to eight different 
samples in each sampler. The content of a sampler can be saved as a sample bank 
allowing you to load all eight samples quickly during a gig.  

11.1 Overview
let’s start this chapter with a quick overview of the user interface of the Cross 
samplers. If the samplers are not visible on your screen, open the View menu and 
select Samplers.

Select and Load Sample Bank                       Beatclock

Enable/Disable Link

One Sample Pad

Save Sample Bank                                         Sync To Player

The image above shows sampler C. At the top of the sampler you see the Sample 
Bank list showing the name of the currently loaded bank. When you made changes 
to the bank, for example by loading a new sample into one of the pads, Cross adds 
an asterisk (*) to the name, indicating that the changes made are not yet saved 
in the sample bank. At any time that changes are being made the Save button is 
shown: clicking the button saves the changes. The Save button is automatically 
hidden if there are no unsaved changes.

In the heading of the sampler the Enable/Disable Link button is shown. If the En-
able/Disable Link button is highlighted, all samples in the sampler can be syn-
chronised (tempo and cycle) automatically to the tempo and beatclock of the player 
above the player; i.e sampler C is synchronised to player A, and sampler D is syn-
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chronised to player B. This mode is called Full link mode and explained in more 
detail on page 145 and onward

While the player and the sampler are synchronised, the circle of the beatclock is 
yellow. If the player and the sampler are not in sync, the circle of the beatclock is 
drawn in white. you then can press the SYNC button to re-sync the sampler to the 
player.

you can click the Enable/Disable Link button to enable/disable the link between 
the player and the sampler. If you are using the U-MIX CoNTRol PRo 2 control-
ler, hold the SHIFT button and press the SYNC button to disable/enable the link 
feature.

When the link feature is disabled, the header of the sampler show more controls 
to change the BPM and to change sync options of the sampler. The synchronisation 
features are covered in greater detail further onwards in this chapter.

The largest area of a sampler is used by the eight sample pads. Each pad can con-
tain one sample. If a sample is loaded into a pad, the name of the sample and its 
waveform is visible on the pad.

 
Mute/Unmute       Playback Mode
           Volume

Rolling Frequency

Pitch Mode setting
for current pad

Clicking the pad number opens a context menu where you can set the Sync Mode 
for one pad. For example, when you have loaded loops and 1-Shot samples, the 
loops can be played at the same tempo that is used in the player, and the 1-Shot 
samples can be played at their original speed. We will cover this later when we 
discuss the synchronisation options available to you.

With the three buttons in the lower area of a pad you can control the volume, mute/
unmute a pad, you can set the playback mode (loop, 1-Shot, Hold) and you can 
change the rolling frequency, which is the length of the looping range.

11.2 Loading and Hot-Sampling
All pads in a sampler are empty when you start Cross. To load a sample from your 
collection into a pad perform one of the following actions:

1 Open the collection and find the sample you wish to load. 

2 Drag the sample from the browser onto the pad.
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The Hot-Sampling feature allows you to capture samples from a track loaded in a 
player into a sample pad:

1 Use the Auto-Loop section in the player above the sampler to define the 
length of the audio, that shall be captured. 

2 Perform one of the following actions:

•	 Create a loop and activate it, if you wish to hot-sample the exact loop.

•	 Start playback of the player if you wish to capture on the fly.

3 Click the pad the sample shall be copied to. If you are using U-MIX CoN-
TRol PRo 2 make sure, that the LoC/SMP button is set to SMP, and press 
one of the buttons 1 to 4 to copy the sample into pad 1 to 4.

 If you capture on the fly, wait until the playback position in the player has 
reached the start point of the audio that you wish to capture, before clicking 
the pad.

 Please note that the target pad must be empty if you use the Hot-Sampling 
feature.

New samples that are created by Hot-Sampling are not automati-
cally saved. If you wish to save a sample for later use, click the pad 
number to open the context menu and then click Save to disk. The 
sample will be saved in your Cross sample directory. 

The default location of the sample directory is the folder MixVibes/
Samples below the music folder in your user‘s directory. you can 
change this location by performing the following steps.

1 Click the Preferences icon in the toolbar, to open the Preferences dialog.

2 open the General tab.

3 Click the Browse button in section User samples directory:

4 Browse to the folder that you wish to use as your sample folder and click 
open.

11.3  Changing Playback Parameters of Samples
once a sample is loaded into a pad, you can change several playback parameters. 
Three of the parameters can be accessed with the three buttons in the lower area 
of the pad.

Start/Stop Click the waveform area of the pad to start/stop playback of the sam-
ple. If you are using U-MIX CoNTRol PRo 2 make sure, that the LoC/SMP button is 
set to SMP. Then press the buttons 1 to 4 to toggle the corresponding pad between 
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playing and paused. If the sample is playing in, the border around the pad will be 
blinking (playback modes HolD and looP) or highlighted (1-SHoT mode). 

Mute  Click the icon with the speaker to mute/unmute the pad. 

Volume Move the mouse on the speaker icon of a pad. Cross 
shows the volume fader for the pad. Move the slider to change 
the pad’s volume.

Sample Playback Mode
The middle button in the lower area of each pad shows the current playback mode. 
you can change the playback mode by pressing the button. If you are using U-MIX 
CoNTRol PRo 2, make sure, that the loC/SMP mode button is set to SMP. Then 
hold the SHIFT button and press one of the buttons 1 to 4 to cycle through the dif-
ferent playback modes.

The following playback modes are available:

•	 LooP In loop mode the playback of the sample starts if you click the pad. 
Playback continues until you click the pad again to stop playback. The rolling 
frequency of the sample (see below) is taken into account. If you start playback  
of the sample the exact start position is dependent on the Quantize parameter 
that you can configure in the Sync Zone: If quantize is enabled Cross ensures, 
that the start position matches the configured quantize value. If the current 
quantize setting causes a delayed start, the border of the pad will blink at a 
high frequency to indicate that the pad is waiting for the next quantize value. If 
quantize is disabled, playback starts immediately. While the sample is playing 
the border of the pad will blink at a low frequency.

•	 HOLD In hold mode the sample starts to play when you click the pad; playback 
stops when you release the mouse button. If you are using U-MIX CoNTRol 
PRo 2 the buttons 1 to 4 behave as if the sample corresponding to the pad is set 
to hold mode. In hold mode the sample is always looped. If you have configured 
a rolling frequency for the pad, this setting is taken into account. While the 
sample is playing the border of the pad will blink at a low frequency

•	 1-SHOT If you set playback mode to 1-SHoT, clicking the pad triggers play-
back until the end of the sample. Playback is automatically turned off when the 
end of the sample is reached. The border of the pad is highlighted (on) while 
the sample is playing.

Rolling Frequency Parameter
The rolling frequency setting is available for all samples where the playback mode 
is set either to LOOP or to HOLD. The rolling frequency parameter defines the 
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range in the sample that is looped. The default setting of the rolling frequency is 
FUll; this means that the complete sample is played.

let‘s assume, you have a kick drum that is 1 beat long and wish to use it in your 
gig. If you play this sample with the rolling frequency set to FUll, the kickdrum 
can be heard on any beat measure. If you decide that the kick is only to be heard 
on the first beat of a bar, open the rolling frequency menu and select 4. Then the 
sample is played every bar. If you select 16, the sample is played every cycle (= 4 
bars = 16 beats).

you can use the rolling frequency parameter to shorten the audible part of a sam-
ple. let’s assume you have a sample with a length of 8 beats. If you load it into a 
pad and if the rolling frequency is set to FUll, playback of the sample starts every 
8th beat. For this sample the rolling frequency settings FULL and 8 have the same 
effect. If you set the rolling frequency setting to 4, at every 4th beat the playback 
position of the sample is reset to the beginning of the file. The results is, that you 
have shortened the sample: now only the first half of it can be heard. If you set the 
rolling frequency to 2, the looping range is now only one quarter of the original 
length of the sample.

If the looping range is shorter than the original length of the sample, Cross shows 
two white lines on the waveform of the sample: The first line is the start point of 
the looping range, the second one is the end point. An example can be seen in the 
following figure.

Click to open
Rolling Frequency 
menu

White lines show
current looping range

11.4  Using Sample Banks
Sample banks make using the Cross samplers much more convenient. The sam-
ple bank contains all the information about the samples loaded in the pad and all 
playback parameters that can be changed. 



11/ Using the Cross Samplers

142

Sample banks can be easily loaded by opening the Sample Bank selector at the top 
of the sampler and selecting the sample bank you wish to use. Furthermore, you 
can manage the sample bank by re-ordering the samples in the pads.

Saving the current content of a Sampler as new Sample Bank
Perform the following steps to save the content of a sampler as a sample bank:

1 Click the Save to disk icon in the heading of the sampler. 

 The sample bank is saved under the name ‚New Sample Bank‘. If there are 
already sample banks with the same name in the collection, Cross adds a 
unique number to the name.

2 open the Cross browser by clicking the Collection button in the dock. Go to 
the tree and open the node Sample Banks, if it is not already open.

3 Double-click the name of the new sample bank to enter edit mode.

4 Type a meaningful name and press (¢).

When you select a sample bank in the Sample Banks node, the list view on the right 
side of the browser shows the samples, that are part of the sample banks, and 
some attributes for each sample, that you can change (see image above). We will 
discuss this further onwards in this section.

Creating an Empty Sample Bank
If you prefer, you can create an empty sample bank in the collection, and the use 
different methods to populate the sample bank with samples:

1 Click the Collection button in the dock.
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2 Right-click on the node Sample Banks and select Create New Sample 
Bank context/action menu.

 A new sample bank with the name “Sample Bank” is created and the name 
is selected.

3 Enter the desired sample bank name and press [¢].

NoTE If you wish to change the name of an existing sample bank, double-
click its name to enter edit mode, make your changes and press [¢].

Creating a Sample Bank from inside the Listview
If you are currently in listview and see some samples that should be in a new 
sample bank, proceed as follows:

1 Select the sample or samples in the browser list.

2 Right-click the selection and choose Add to New Sample Bank. Cross 
opens the following window:

3 Enter a name for the sample bank and click oK.

 The new sample bank is created and the selected samples are added to this 
sample bank.

Adding and deleting Samples
Samples can be added to a sample bank by selecting them in the listview, then by 
dragging them onto the icon of the sample bank in the Treeview. If you have added 
a sample bank button for the target bank to the dock, you can drag and drop the 
selected tracks onto this button. 

Another way to add samples to a sample bank is by using the context menu in 
listview. Select the sample/s you wish to add to an existing sample bank. Then 
right-/ctrl-click the selection. Click Add to Sample Bank and then select the de-
sired sample bank in the submenu of this command.

To delete a track from a playlist, right-/ctrl-click the track and choose Remove 
from Sample Bank.
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Changing Sample Properties
If you open a sample bank in the browser list by clicking the name of the sample 
bank in the Sample Banks node, the right side of the browser shows the sample 
banks pane with all the information about the contained samples.

Unlike the list view for playlists for example, you can change several properties 
that affect how the samples are shown in the sampler, and how they will playback.

Use the Title column to change the text that is displayed on the pad. Use the col-
umns Type and Instrument to categorize your samples. For example, you could 
use “drumloop”, “fxs”, or “vocal” for the type property and “drum”, “synth”, and 
“voice” for the instrument property. You can then use the Column Browser to filter 
your samples collection by the attributes you entered. (The procedure for using the 
Column Browser for samples is actually the same as for tracks and is explained 
in chapter 8.)

If necessary you can also change the BPM of the sample: double-click in the BPM 
cell for the sample you wish to change and enter the new BPM. To change the gain 
value, double-click in the Gain cell of the sample that you wish to change. Then 
lick the little Gain knob that is shown in the cell and drag up or down, to change 
the Gain value.

Use the Pad Index column to change the assignment between a sample and its pad 
in the sampler. Click the Pad Index cell for the sample you wish to move and select 
the new index. The selected sample is moved to the new index. If another sample 
was assigned to the target pad, this assignment is removed and set to No Index 
(the Pad Index cell for this sample will be empty.)

The one setting that has not been covered yet, the Pitch Mode, is important as it 
influences the way that samples are synchronized.

11.5  Samplers, Synchronisation, and Pitch Mode
The last section of this chapter covers the synchronisation of the samplers and the 
players, and how individual samples in a sample bank are synchronized to the rest.
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Link Mode
The Link mode defines if the beatclocks of player A and sampler C are linked to-
gether or not, and if the beatclocks of player B and sampler D are linked or not. you 
can enable/disable link mode for A/C and B/D independently. To change the link 
mode setting for the left side, click the Enable/Disable Link button on sampler C. 
To change it for the right side, click the Enable/Disable Link button on sampler D.

Regarding the link mode settings, we can distinguish the following scenarios:

•	 Full Link Mode The BPM and the beat cycle of the player 
and sampler on one side are linked and they are in sync. In 
this state the circle of the beatclock in the header of the 
sampler is drawn in yellow (sampler C) or in red (sampler D)..

•	 Relative Link Mode The system was in full link mode 
when a transport operation like smart seek was triggered 
in the linked player that was not cycle quantized. In rela-
tive link mode the tempo of player and sampler are the same, but they loose 
the cycle sync state. In this state the circle of the beatclock in the header of the 
sampler is drawn in white.

•	 Independent Mode The player and the sampler are not linked. Player and 
sampler can use their own tempo (BPM) and they use their own beatclock.

Both Sides are working in Full Link Mode
This image shows the two samplers when Full link mode is engaged for both sides 
of the Cross user interface:

Both Enable/Disable Link buttons are highlighted, they look as shown in the previ-
ous image, and the circle in the Sync Meter on the samplers are drawn in yellow 
(sampler C) or red (sampler D). Because A/C and B/D are linked, pressing the 
SYNC button on player A or player B also performs a synchronization of the linked 
sampler:

•	 If you press SYNC on player A the BPM and phase of player B is used to syn-
chronize player A and sampler C.

•	 If you press SYNC on player B, the BPM and phase of player A is used to syn-
chronize player B and sampler D.
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There are some exceptions. Take the first example and assume, that player B is 
not running when you press SYNC. Then the beatclock of sampler D is used for the 
synchronization process.

One Side was switched to Relative Link Mode
Cross will switch the link mode between player and sampler automatically from 
Full link Mode to Relative link Mode when on the player any action is performed 
that breaks the full link. In this mode the BPM remains shared between the player 
and its linked sampler, only the cycle sync is lost.

When Cross switches the sampler to Relative link Mode you 
will see that the circle in the Cycle Meter of the sampler is 
drawn in white. To recover the Full link mode and get back to 
a sampler “cycle-synced” to the player, you only need to click the SYNC button in 
the header of the sampler.

one of the actions that can lead to the mode switch is a smart seek with a seek 
length other than 16 beats. For example, if you seek by one beat, than the cycle 
synchronisation between the player and the sampler is lost. However, player and 
sampler are still playing at the same BPM. It can happen as well when the sam-
pler was playing and the player was paused, and if you then start a new track in 
the player.

If you use a quantize value of 16 beats the automatic switch to relative link mode 
can be avoided.

One Side is linked, Player and Sampler on the other side are 
independent
The following image shows a scenario, where player B and sampler D (right side) 
are linked, and where player A and sampler C (left side) are independent.

The change in the link settings has an impact on what happens, when you use the 
SYNC button:

•	 If you press SYNC on player A, the BPM and phase of player B is used to syn-
chronize player A only. Sampler C is not synchronized as the left side is not 
linked.
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•	 If you press SYNC on player B, the BPM and phase of player A is used to syn-
chronize player B and sampler D, as the right side is linked.

The same rules apply if A/C are linked but B/D are not. you only need to swap 
player/sampler in the rules above.

As player A and sampler C in this example are independent, you see additional 
controls next to the Sync Meter. you can use these controls to start/stop the me-
ter. Additionally, you can use the two pitch bend buttons to pitch bend the tempo of 
the sampler up and down. And you can use the BPM field in the sampler‘s header 
and enter a BPM for the sampler here. The pads in the sampler will follow the 
tempo changes you make.

Independent Mode: Player and Sampler are not linked
Another Link configuration is shown in the following figure:

Here neither A/C nor B/D are linked. In this setup using the SyNC button on either 
player A or player B, leads to a synchronisation of the two players only. Tempo and 
beat cycle of sampler C and sampler D are not changed in any way by the synchro-
nisation. The Sync Meter, pitch bend buttons and BPM field are now available in 
both samplers, and you can use them to perform any necessary synchronisation 
manually.

Click to return to Full Link Mode

Click to switch Cycle Meter 
between 4 or 16 Beats

Click and type new BPM
Start Beatclock/
Reset Beatclock

Stop Beatclock

Pitch Bend Up/Down

Setting the Pitch mode for individual Pads
No matter which link setting you use, it is important to understand, that each of 
the pads in a sampler has it‘s own pitch mode. you can see the pitch mode for each 
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pad either in the sample pane (open it by clicking on the name of a sample bank in 
the Sample Banks node of the tree view in the browser). Then click in column Pitch 
Mode for the sample you wish to change and click the mode you want to assign:

you can also click on the pad number of a sample in the sampler: this opens a 
context menu, where the current mode is shown and where you can change the 
mode if necessary.

If you use Master Tempo or Speed, the BPM of the sample is still synchronized 
to the sampler (when the link mode is off) or to the player linked to the sampler 
(when link mode is on). The difference between Master Tempo and Speed is the 
same as in the pitch setting of the players: in Speed mode any tempo changes 
resulting in a playback tempo that is different than the original tempo of the sam-
ple, results in a pitch change of the audio. In Master Tempo mode, Cross uses a 
time stretching engine, which allows playback of audio at different tempos without 
changing the tonal key. 

option None (disabled) is useful especially for 1-SHoT samples such as vocals 
or other special effect samples that often sound better when played back at the 
original tempo. If you choose this sync mode option the sample is always played 
at the original tempo: this setting overrides any link setting that is made for the 
sampler. Also, any changes that you make to the BPM of the sampler while it is not 
linked to the player, have no effect on samples where the sync mode is set to None.
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12/  
Backup  
your Data

It is good practice to back up the data files Cross creates, as well as your audio 
tracks of course. In case of a hard drive failure a backup will help you to get your 
Cross setup back to a running state very quickly.

To create a backup of the data files of Cross make sure to include the two follow-
ing folders:

•	 Collection Folder The collection folder is the folder where the collection files 
reside that you create with Cross. The collection files use the extension .db and 
can be found in the following location:

•	 oSX /users/[UserName]/Music/Cross 

•	 Windows XP C:\Document and Settings\[UserName]\Music\Cross 

•	 Windows 7 C:\Users\[UserName]\Music\Cross 

The collection file contains information about your tracks, their location and the 
tags of your media files.

•	 Peak Folder In the default configuration the Peak folder resides below the 
Collection folder. As long as you haven’t changed the Peak Files location on the 
Preferences/General dialog, it is sufficient to save the content of the Collection 
folder and all its subfolders.

In the case that you have changed the location of the Peak files you should 
check its current location on the Preferences/General dialog and make sure, 
that this folder is included in your backup scenario as well.

The peak files contain information that Cross gathers during the track analysis 
and all playback information that you create. These are: the peaks/transients of 
the track, the tempo (BPM), the locators, cue point, the track gain and informa-
tion about any loops you have set.

In the worst case of a hard drive failure you want to ensure that the audio files of 
the tracks that you imported into the collection are restored to your original loca-
tion.
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A/  
Default  
Keyboard  
Shortcuts

Collection and Track Management

Function Windows Mac oS X

Import File (Ctrl)+(I) (cmd)+(I)

New Collection (Ctrl)+(N) (cmd)+(N)

open Collection (Ctrl)+(O) (cmd)+(O)

Save Collection (Ctrl)+(S) (cmd)+(S)

Save Collection As (ª)+(Ctrl)+(S) (ª)+(cmd)+(S)

Switching Layouts, Open Preferences

Function Windows Mac oS X

Full Screen (F11) (ª)+(cmd)+(F)

Expand/Collapse Collection (F7) —

open Preferences dialog (Ctrl)+(,) (cmd)+(,)

Player: Activating, Loading and Playback

Function Windows Mac oS X

Toggle active Player (ÿ), (ª)+(ÿ) (ÿ), (ª)+(ÿ)

Toggle active browsable (Ctrl)+(æ), 
(Ctrl)+(Æ)

(cmd)+(æ), 
(cmd)+(Æ)

Scroll through Collection (Ctrl)+(¼), 
(Ctrl)+(½)

(cmd)+(¼), 
(cmd)+(½)

load into Player A (ª)+(Ctrl)+(æ) (alt)+(cmd)+(æ)

load into Player B (ª)+(Ctrl)+(Æ) (alt)+(cmd)+(Æ)

Empty Player A (ª)+(Alt)+(æ) (ª)+(alt)+(æ)

Empty Player B (ª)+(Alt)+(Æ) (ª)+(alt)+(Æ)
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Function Windows Mac oS X

Play/Pause active player (________) (spacebar) (________) (spacebar)

Play/Pause all players (ª)+(________) (ª)+(________)

Smart Seek Backward (Alt)+(æ) (Alt)+(æ)

Smart Seek Forward (Alt)+(Æ) (Alt)+(Æ)

Vinyl Mode (V) (V)

Player: Cue Points, Looping

Function Windows Mac oS X

Set IN point (I) (I)

Set oUT point (O) (O)

loop on/off (L) (L)

Auto loop, select length (J), (K) (J), (K)

Auto loop, trigger (U) (U)

Player: Tempo, Pitching and Synchronisation

Function Windows Mac oS X

Tap Tempo (T) (T)

Tempo up, normal/fine (F), (ª)+(F) (F), (ª)+(F)

Tempo down, normal/fine (R), (ª)+(R) (R), (ª)+(R)

Tempo, reset pitch fader (ª)+(0) (zero) (ª)+(0) (zero)

Pitch Mode (P) (P)

Pitch Bend up (D) (D)

Pitch Bend up, fine (ª)+(D) (ª)+(D)

Pitch Bend up, coarse (Ctrl)+(D) (cmd)+(D)

Pitch Bend down (E) (E)

Pitch Bend down, fine (ª)+(E) (ª)+(E)

Pitch Bend down, coarse (Ctrl)+(E) (cmd)+(E)

Match active player to other (M) (M)

Sync active player to other (S) (S)
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Player: Cue Points and Locators

Function Windows/Mac oS X

Cue (C)

Cue/Play (¢)

Set Cue (ª)+(C)

Set/Delete locator 1 (1)/(ª)+(1)

Set/Delete locator 2 (2)/(ª)+(2) 

Set/Delete locator 3 (3)/(ª)+(3)

Set/Delete locator 4 (4)/(ª)+(4)

Set/Delete locator 5 (5)/(ª)+(5)

Set/Delete locator 6 (6)/(ª)+(6)

Set/Delete locator 7 (7)/(ª)+(7)

Set/Delete locator 8 (8)/(ª)+(8)

Mixer

Function Windows Mac oS X

Cue/Monitor Player A (A) (B)

Cue/Monitor Player B (B) (B)
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B/  
Troubleshooting 
and FAQ

B.1  Software related Questions

The audio tracks are not playing back

•	 Make sure you have selected the correct audio interface in the audio preferen-
ces window.

•	 Make sure you selected the correct audio inputs and outputs of your audio in-
terface in the audio preferences window.

•	 Make sure you selected the correct Routing Mode in the audio preferences win-
dow.

There is no sound coming out of the speakers

•	 Check for activity on the output meter of the internal mixer. If there is no res-
ponse from the meter, check all the controls of the mixer: faders, gain, kills, 
etc.

•	 If you are in external mixer mode, check the connections from your audio inter-
face to your mixer and from your mixer to your sound system. Make sure you 
have the proper inputs selected on your mixer.

There are some audio dropouts or slow response

•	 Change the buffer size setting in the Audio preferences. If you hear crackling 
sounds, it means your latency setting is too low, choose a larger buffer size and 
test again.

•	 Close all applications that are not needed.

•	 Disable your anti-virus, spyware and firewall software.

•	 Turn off your computer’s wireless card (or disconnect from the Internet).

•	 Close all background processes that are currently not needed. For example on 
Windows, press (Ctrl)+(Alt)+(Del), open the Task Manager, go to the Pro-
cesses tab and close the processes.
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•	 If you are very serious about DJing, the first thing to do is partition your hard 
drive and dedicate a clean install only to MixVibes. Make sure not to use the 
internet if you have booted your system from the dedicated Cross partition. This 
will avoid all potential worms and backdoors that can considerably slow down 
your application.

Where do I find my license key/serial number?
The license key is printed on the back of the installation CD sleeve.

How do I recover my lost license key/serial number? 
We recommend keeping your license key/serial number by registering on the fo-
rum, and entering it in the space provided. We’ll be able to recover it for you in case 
you lose it. Please note that we cannot provide additional serial numbers.

How do I get software updates? 
To download the latest version of your MixVibes software, you will need to be reg-
istered on the MixVibes Forum.

Follow these steps to register:

1 Go to the MixVibes at http://forum.mixvibes.com

2 Click on Register in the Board Index sidebar. 

3 Read the terms and click on “I agree to the terms”.

4 Fill out your profile with your user name, a valid e-mail address, and a 
password. 

IMPoRTANT you will need your software license key to complete the 
registration. You will find the key on the back of your installation CD 
sleeve.

5 you will receive an e-mail with an activation link to complete the registra-
tion. 

Follow these steps to download and install the update:

1 login to the forum and go to the Download Center.

2 Select your version of the MixVibes software and find the latest update.

3 Click the Download button near the bottom of the page.

4 Once the download is finished, extract the folder and run the EXE (PC) or 
DMG (MAC) file.
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Why do I hear an electrical sound while nothing is playing? 
If you hear a rumbling sound in the background, this is a grounding problem. This 
happens with laptops that have a power supply with a ground connection (3-pin 
plugs). To correct this problem, use a ground loop isolator on the master output 
of your mixer.

I have a particular MP3 that won’t play/plays badly/takes a 
long time to load/crashes the program. What should I do? 
In most cases the cause of this symptom is a corrupted file and it could be neces-
sary to delete this file from your collection. There are some free tools available 
that can check if a MP3 file is defect or not. Use your favourite search engine and 
search for “mp3 checker”, download one of the available tools and test the MP3 file 
that doesn’t play or that causes Cross to crash.

If you find the file that caused the problem, please go to the MixVibes forum and 
inform our support team about the issue. By reporting damaged or corrupt files, 
you can help the developers to improve Cross’ ability to handle damaged MP3 files 
in future versions.

The time code quality is bad

•	 Check for proper connections of your turntables’ ground wires.

•	 Make sure your needles are clean and not damaged.

•	 Make sure there is no dust on your records and needles.

•	 Make sure your cables are in good condition. Troubleshoot by using a different 
cable.

•	 Make sure your decks are properly connected to your audio interface.

•	 Make sure the right and left channels are not inverted.

•	 Make sure your control media is not scratched.

B.2  Controller related Questions

The U-MIX CONTROL controller has no effect on Cross
If the Power lED is oFF:

•	 Check that the PoWER switch on the rear of the controller is not set to oFF or 
to the AC position.

•	 Check/change the USB cable and turn the PoWER switch on the rear to the 
USB position. 

•	 Use an adaptor and set the PoWER switch on the rear to the AC position. 
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If the Power lED is oN:

•	 Try to connect the controller to another USB port. 

•	 Close the software. Reconnect the USB cable of the controller and make sure 
that it is powered correctly. Restart Cross.

How can I determine the firmware version of  
U-MIX CONTROL PRO 2 and U-MIX CONTROL 2?
1 Make sure your controller is connected via USB to the computer.

2 Power the device oFF.

3 Press and hold the buttons SHIFT and BASS_B on the controller.

4 Switch the controller on while pressing the buttons SHIFT and BASS_B. 

5 The firmware version (X.Y.) is encoded into the LEDs. The LEDs for player A 
show the major version number (X), the lEDs for player B the minor version 
number (y). 

•	 X (on player A): 1 (PITCH MoDE), 2 (SElECT), 3 (loCAToR1), 4 (loCA-
ToR2), 5 (loCAToR3), 6 (VINyl), 7 (BEND-), 8 (BEND+), 9 (SyNC)

•	 y (on player B): 1 (PITCH MoDE), 2 (SElECT), 3 (loCAToR1), 4 (loCA-
ToR2), 5 (loCAToR3), 6 (VINyl), 7 (BEND-), 8 (BEND+), 9 (SyNC)

6 Press SHIFT to return to normal mode.

How can I upgrade the firmware of my controller?
1 Make sure your controller is connected via USB to the computer.

2 Power the device oFF.

3 Press and hold the buttons SHIFT and BRoWSE on the controller.

4 Switch the controller on while pressing the buttons SHIFT and BRoWSE. 

5 Release the buttons SHIFT and BRoWSE. The buttons Source A and Source 
B should light up now.

6 A new drive named “midiUpgDisk” should be found on your system.

7 Drag and drop the firmware file onto the “midiUpgDisk” drive. Make sure 
that you use the correct firmware file for your controller.

•	 The firmware files for U-MIX CONTROL PRO 2 use the following naming 
pattern: U-MIX_PRo2_*V*.bin

•	 The firmware files for U-MIX CONTROL PRO use the following naming 
pattern: U-MIX_PRo_*V*.bin

•	 The firmware files for U-MIX CONTROL 2 use the following naming  
pattern: U-MIX_2_*V*.bin



B/  Troubleshooting and FAQ

157

8 Once the firmware file is dropped the upgrade process begins. LEDs on the 
controller inform you about the update progress:

•	 Update Data 30% = KILL BASS A/B are flashing

•	 Update Data 60% = KILL MID A/B are flashing

•	 Update Data 90% = KILL TREB A/B are flashing

•	 Update Success = LOAD A/B are flashing

•	 Update Error = loAD A/B are off

9 After the firmware is updated, the LEDs will turn off.

Can I use U-MIX CONTROL PRO or U-MIX CONTROL 2 with other 
DJ software than CrossDJ/CrossDJ LE?
yes, both U-MIX CoNTRol controllers are standard MIDI controllers that send 
MIDI commands. U-MIX CoNTRol PRo and U-MIX CoNTRol 2 can be used with 
any software that accepts MIDI commands.
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C/ 
list of MIDI  
Messages

The controls in the two player sections, in the mixer section and in the general 
section of U-MIX CoNTRol PRo 2/U-MIX CoNTRol 2 send their messages on the 
following MIDI channels:

•	 Player A: MIDI channel 1

•	 Player B: MIDI channel 2

•	 Mixer: MIDI channel 3

•	 Shift + Player A: MIDI channel 4

•	 Shift + Player B: MIDI channel 5

•	 Shift + Mixer: MIDI channel 6

Player Section (Controller to Computer)

Control Name Message Type Key/Note/Value MIDI Channel

Cue Note on/off 0x1 A=1, B=2

Play Note on/off 0x2 A=1, B=2

Sync Note on/off 0x3 A=1, B=2

Pitchbend – Note on/off 0x4 A=1, B=2

Pitchbend + Note on/off 0x5 A=1, B=2

Pitchbend Slider Pitchbend 0xE A=1, B=2

Jog (Vinyl) 1 Note on/off 0x7 A=1, B=2

loC/SMP 2 Note on/off 0x8 A=1, B=2

Pitch Mode 3 Note on/off 0x8 A=1, B=2

loop (push) Note on/off 0xD A=1, B=2

loop (turn) 4 Control Change 0xD A=1, B=2

FX Select (push) Note on/off 0xE A=1, B=2

FX Select (turn) 4 Control Change 0xE A=1, B=2

FX Amount Control Change 0xF A=1, B=2
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Control Name Message Type Key/Note/Value MIDI Channel

Select 3 Note on/off 0x9 A=1, B=2

locator 1 (Select = off) 3 Note on/off 0xA A=1, B=2

locator 2 (Select = off) 3 Note on/off 0xB A=1, B=2

locator 3 (Select = off) 3 Note on/off 0xC A=1, B=2

locator 4 (Select = off) 3 Note on/off 0x18 A=1, B=2

locator 5 (Select = off) 3 Note on/off 0x19 A=1, B=2

locator 6 (Select = off) 3 Note on/off 0x1A A=1, B=2

Button 1 (loC/SMP = off)2 Note on/off 0x9 Shift off: A=1, B=2 
Shift on: A=4, B=5

Button 2 (loC/SMP = off)2 Note on/off 0xA Shift off: A=1, B=2 
Shift on: A=4, B=5

Button 3 (loC/SMP = off)2 Note on/off 0xB Shift off: A=1, B=2 
Shift on: A=4, B=5

Button 4 (loC/SMP = off)2 Note on/off 0xC Shift off: A=1, B=2 
Shift on: A=4, B=5

Button 1 (loC/SMP = on)2 Note on/off 0x18 Shift off: A=1, B=2 
Shift on: A=4, B=5

Button 2 (loC/SMP = on)2 Note on/off 0x19 Shift off: A=1, B=2 
Shift on: A=4, B=5

Button 3 (loC/SMP = on)2 Note on/off 0x1A Shift off: A=1, B=2 
Shift on: A=4, B=5

Button 4 (loC/SMP = on)2 Note on/off 0x1B Shift off: A=1, B=2 
Shift on: A=4, B=5

1
 Button is labelled VINyl on U-MIX CoNTRol PRo and U-MIX CoNTRol 2 and 

labelled JoG on U-MIX CoNTRol PRo 2.
2 This button is available on U-MIX CoNTRol PRo 2 only.
3 This button is available on U-MIX CoNTRol PRo and U-MIX CoNTRol 2 only.
4
 Relative Encoder, see section on page 161.

Jogwheels (Controller to Computer)
The jogwheels on U-MIX CoNTRol PRo 2 are touch sensitive and the jogwheels on 
U-MIX CoNTRol 2 are not. For this reason the messages sent by the jogwheels are 
slightly different. The first table shows the MIDI messages for U-MIX CONTROL 2:
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Condition Message  
Type

CC Number Value MIDI Channel

Wheel is touched 
and turned

Control 
Change

0x16 Forward:  
0x41 – 0x7F 
Rewind: 
0x3F–0x00

A=1, B=2

Wheel is no longer 
turned 

Control 
Change

0x16 0x40 A=1, B=2

The following table shows the MIDI messages sent by U-MIX CoNTRol PRo 2 :

Condition Message  
Type

Key/Note, 
CC Number

Value MIDI Channel

Wheel detects an 
initial contact

Note on/ 
Note off

0x16 0x00 = release,  
0x7F = push

A=1, B=2

Top wheel is  
touched and wheel 
is turned 

Control 
Change

0x16 Forward:  
0x41 – 0x7F 
Rewind: 
0x3F–0x00

A=1, B=2

Top wheel is no 
longer turned

Control 
Change

0x16 0x40 A=1, B=2

outer wheel is 
touched and  
turned

Control 
Change

0x17 Forward:  
0x41 – 0x7F 
Rewind: 
0x3F–0x00

A=1, B=2

outer wheel is no 
longer turned 

Control 
Change

0x17 0x40 A=1, B=2

Mixer Section (Controller to Computer) 

Control Name Message Type Key/Note MIDI Channel

Headphones Monitor Note on/off 0x10 A=1, B=2

Gain Control Change 0x11 A=1, B=2

EQ Treb (turn) Control Change 0x12 A=1, B=2

EQ Treb Kill (push) Note on/off 0x12 A=1, B=2

EQ Mid (turn) Control Change 0x13 A=1, B=2

EQ Mid Kill (push) Note on/off 0x13 A=1, B=2

EQ Bass (turn) Control Change 0x14 A=1, B=2
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Control Name Message Type Key/Note MIDI Channel

EQ Bass Kill (push) Note on/off 0x14 A=1, B=2

Volume Fader Control Change 0x15 A=1, B=2

Cross Fader Control Change 0x1 3

Master Volume Control Change 0x3 3

Monitor Mix (Front Panel)Control Change 0x7 3

Browser Section (Controller to Computer) 

Control Name Message Type Key/Note MIDI Channel

Browse (push) Note on/off 0x4 3

Browse (turn) 1 Control Change 0x4 3

load A Control Change 0x5 3

load B Note on/off 0x6 3

Shift Button Note on/off 0x2 3

1 Relative Encoder, see section below.

Relative Encoders
Several of the knobs act as relative encoders, i.e. their value field will indicate a 
relative change. 0 means that no change occurred, values 01 to 63 describe a posi-
tive change and values 127 down to 64 describe a negative change.

Value Description

0x00 No change occurred. Control is stationary.

0x01 The controller incremented its value by 1 since the last report

0x02 The controller incremented its value by 2 since the last report

… …

0x3F The controller incremented its value by 63 since the last report

0x40 The controller decremented its value by 64 since the last report

0x41 The controller decremented its value by 63 since the last report

0x7E The controller decremented its value by 2 since the last report

0x7F The controller decremented its value by 1 since the last report
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LED (Computer to Controller) 
The following table shows the MIDI messages for the different lEDs on the con-
troller.

Control Name Message Type Key/Note MIDI Channel

Master Clip Note on/off 0x3 3

Treb Note on/off 0x12 A=1, B=2

Mid Note on/off 0x13 A=1, B=2

Bass Note on/off 0x14 A=1, B=2

FX * Note on/off 0xE = yellow 
0x1C = red  
0x1D = orange 

A=1, B=2

loop Note on/off 0xD A=1, B=2

* on U-MIX CoNTRol PRo and U-MIX CoNTRol 2 the FX lED is always yellow for  
player A and always red for player B. The three-colour lED is available only on 
U-MIX CoNTRol PRo 2.

you can send a value to these lEDs and to all buttons with an integrated lED to 
control the lED state. The following table shows the values you can use:

Value LED Status

0x7F (=127 decimal) lED is on

0x00 (=0 decimal) lED is off

0x14 (=20 decimal) lED blinks every 0,2s

0x28 (=40 decimal) lED blinks every 0,4s

0x3C (=60 decimal) lED blinks every 0,6s

0x50 (=80 decimal) lED blinks every 0,8s

0x64 (=100 decimal) lED blinks every second 
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D/ 
U46MK2  
Technical  
Specifications

D.1  Key Features
•	 4-in 6-out multi purpose USB audio interface

•	 2 Phono inputs and 4 line inputs

•	 MIC inputs with gain control

•	 +48V phantom power for condenser microphone

•	 Direct instrument input for electrical guitars (Hi-z) with gain control

•	 6 line level analog outputs with separate Mix outputs

•	 Headphone out with level control

•	 4 channel recording and 6 channel playback at the same time – Full Duplex

•	 4-in 6-out at 44.1 kHz, 4-in 4-out at 48 kHz.

•	 Compatible with Microsoft® Windows XP (Service pack 2 strongly recommend-
ed), Windows Vista, Windows 7 and Mac oSX.

•	 WDM, MME, ASIo, DirectSound and CoreAudio support.

D.2  U46MK2 Front Panel
� �

�

�

1	 Channel 1/2 Input Connector 

•	 Input source (MIC/LINE/PHONO) selector  
This is where you select input sources of channel 1/2.
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•	 MIC input connector  
Connect your Microphone to this balanced 1/4” connector.

•	 Gain control for MIC input  
Control input level of microphone

2	 Channel 3/4 Input Connector 

•	 Input source (Hi-Z/LINE/PHONO) selector  
This is where you select input sources of channel 3/4. 

•	 Hi-Z input connector  
Connect an electric guitar or bass guitar to this unbalanced 1/4” con-
nector. only an unbalanced 1/4” phone jack connection is available for 
this setting. 

•	 Gain control for Hi-Z input:   
Control the input level of the E-guitar input

3	 Headphone output with Headphone volume control 

Monitor all input sources and output sources through the headphone out-
put. output level can be adjusted with the control knob.

4	 Power Switch 

D.3  U46MK2 Rear Panel

�

�

�

�

�� �

1	 External Power Supply Connector

If you use a microphone that requires phantom power, especially with a 
laptop computer, it is strongly recommended to use a DC +9V/500mA 
adapter (not included). When you turn on the U46MK2 or when you turn on/
off phantom power, the current peak level might go over 500mA.

2	 USB Connector

Connects the USB cable to the computer.
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3	 Mix out

you can monitor all input sources and output sources through the Mix out-
put. Usually, you would use Mix out to connect to powered monitor speak-
ers.

4	 output 1–6

you can use these outputs to connect to various external devices or to a 5.1 
surround system.

5	 Input 1–4

The turntable inputs and line level inputs share the same connectors. The 
RCA turntable inputs feed an RIAA equalized preamp designed to accept 
moving magnet type phono cartridges.

6	 Mix Ground Plug 

When you use a turntable, connect the ground lead from your turntable to 
the ground plug to help prevent ground hum.
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E/ 
U-MIX CoNTRol 
PRo 2 – Technical 
Specifications

General Information

•	 Dimensions: 375mm (W) X 202.6mm (D) X 64 mm (H)

•	 Weight: 1.86kg

•	 Power Source DC: 6V, 1.5A

•	 Ambient Temperature 23 +/- 2 degC

•	 Relative Humidity 65% +/- 5%

•	 NoTE: Measurements can be carried out between 5 degC to 35 degC and 45% 
to 85% relative humidity.

Features

•	 USB MIDI Controller + Digital Mixer

•	 2 touch sensitive Jogwheels

•	 2 external Phono/line Input

USB Slave Player Section  
(Signal Format: MP3, 128KBPS, SONY SOUND FORGE8.0)

•	 output Level  
output 1/2/3/4: 2V +/-1dB (1 KHz, 0dB, TCD782 TRK2)  
Phones out: 1.3V +/-1dB (1 KHz, 0dB, TCD782 TRK2)

•	 Frequency Response:  
output 1/2/3/4: 17-16 KHz +/-2dB (TCD781 TRK1, 4, 16)

•	 THD+N: 
output 1/2/3/4: less than 0.02% (TCD782 TRK2, W/20KHz lPF, A-WEIGHTED)

•	 SN Ratio:  
output 1/2/3/4: more than 70dB (TCD782 TRK2, 8, W/20KHz lPF, A-WEIGHTED)

•	 LR Separation:  
output 1/2/3/4: more than 70dB AT 1KHz (TCD782 TRK2, 9, 11, W/20KHz lPF, 
A-WEIGHTED)
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Recording And Playback

•	 Line 1 KHz, 6dBV Input  
output1/2/3/4: 5dBV (2V) +/-2dB   
THD+N: less than 0.05% (W/20KHz lPF, A-WEIGHTED)

•	 Phono 1 KHz, -41dBV Input  
output1/2/3/4: 0dBV (1V) +/-2dB  
THD+N: less than 0.05% (W/20KHz lPF, A-WEIGHTED)

Maximum Input  
(1 KHz, Master Output, THD=1%, EQ Flat, Maximum Gain) 

•	 line: more than +4dBV

•	 Phono: more Than -36dBV

Maximum Output  
(EQ Flat, Maximum Gain, THD=1%, Load=100K Ohm) 

•	 output 1/2/3/4: more than +6dBV (2V) 

•	 Phones: more than +1.6dBV (1.2V) loAD=32 oHM

Mic Player Section

•	 Mic level: 10K ohm/-54dBV (out1/2/3/4:0dB (1V)+/-1dB)

•	 Mic THD+N: less than 0.15%@1KHz (w/20kHz lPF, A-WEIGHTED)

•	 Mic S/N: more than 64dB

Note
The specifications are subject to change to any improvement by negotiations in 
advance.
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F/ 
Safety  
Instructions

These safety instructions apply if you are using the controllers U-MIX CoNTRol 
PRo 2 and U-MIX CoNTRol 2 or the USB audio interface U46MK2. 

•	 Read these Instructions.

•	 Keep these Instructions.

•	 Heed all Warnings.

•	 Follow all Instructions.

•	 Do not use this apparatus near water.

•	 Clean only with a damp cloth.

•	 Do not block any of the ventilation openings. Install in accordance with the 
manufacturer’s instructions.

•	 Do not install near any heat sources such as radiators, heat registers, stoves, 
or other apparatus (including amplifiers) that produce heat.

•	 Do not defeat the safety purpose of the polarized plug. The wide blade is provi-
ded for your safety. If the provided plug does not fit into your outlet, consult an 
electrician for replacement of the obsolete outlet.

•	 Protect the power cord from being walked on or pinched particularly at the 
plug, convenience receptacles, and point where they exit from the apparatus.

•	 Only use attachments/accessories specified by the manufacturer.

•	 Use only with a cart, stand, tripod, bracket, or table specified by the manufactu-
rer, or sold with the apparatus. When a cart is used, use caution when moving 
the cart/apparatus combination to avoid injury from tip-over.

•	 Unplug this apparatus during lighting storms or when unused for long periods 
of time.

•	 Refer all servicing to qualified service personnel. Serving is required when the 
apparatus has been damaged in any way, such as the power-supply cord or 
plug is damaged. Also if liquid has been spilled or objects have fallen into the 
apparatus, the apparatus has been exposed to rain or moisture, does not ope-
rate normally, or has been dropped.
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WARNING

To reduce the risk of the fire or electric shock, do not expose this apparatus to 
rain or moisture. The apparatus shall not be exposed to dripping or splashing 
and that no objects filled with liquids, such as vases, shall be placed on the 
apparatus.

    

CAUTION

  

CAUTIoN   To reduce the risk of electric shock, 
do not remove any cover. No user-serviceable 
parts inside. Refer servicing to qualified service 
personnel only.

The lightning flash with arrowhead symbol within the equilateral 
triangle is intended to alert the use to the presence of uninsulated 
“dangerous voltage” within the product’s enclosure that may be of 
sufficient magnitude to constitute a risk of electric shock.

The exclamation point within the equilateral triangle is intended to 
alert the user to the presence of important operation and mainte-
nance (servicing) instructions in the literature accompanying this 
appliance.

CAUTIoN

To prevent electric shock, do not use this polarized plug with an extension cord, 
receptacle or other outlet unless the blades can be fully inserted to prevent the 
exposure of a blade.
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1-Shot, sample playback mode  140

A
Absolute Mode  90
Add Beatgrid  89
Add track to playlist  111
Album Browser  108
Amount, effect  132
Analyze all  85
Analyze Beatgrid/BPM only  85
Analyze Gain only  85
Analyze Peak only  85
Analyzing media files  84
ASIo4All  45
Audio Cache, setting  92
Audio Files

analyzing  84
moving in  101

Audio Sources, external   18
Automatically start recording  129
Automatic loops  122
Autoplay  130

repeat  131
shuffle  131
sync  131

B
Backup  149
Backwards Playback and Timecode  20
Bar, synchronisation mode  99
Beatgrid

add  89
analysis  85
delete  89
expand/shrink  87
move downbeat  88
show on player and Beatmatcher  96
user beatgrids  89

Beatgrid Tools  86
Beatmatcher  77, 95
Beat Repeater  136
Beat, synchronisation mode  99
Bi-Filter, effect  136
Bi-polar filter  79
Bliss, effect  135
BPM Detection Range  86
BPM Display and timecode  20
Brake, effect  136
Browser

active properties  108
create new folder  109
dock  104

Browser Panel  106
Buffer size  46

C
Calibrate  39
CDJ Player

integration of  18
Master Tempo  20

CD Mode, player  101
Channel fader  79
Chopper, effect  135
Coarse, pitch bending  121
Collection Folder  149
Collection View Expanded  81
Column Browser  107
Constant Power, crossfader setting  

100
Constant Volume, crossfader setting  

100
Control Deck  38
Controller, mapping architecture  23
Control Mode

absolute  90
flexible  91

Index
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Control Mode (cont.)
internal  90
relative  90

CRoSS
Remote Apps  63
software versions  7

Crossfader  80
curve preset  99
U-MIX CoNTRol PRo 2  80

Crush, effect  135
Cue/Monitor buttons  79
Cycle, synchronisation mode  99

D
Data backup  149
Define Downbeat  88
Delay, effect  134
Delete  

beatgrid  89
track from playlist  111

Depth, effect  132
Digitize your Vinyl  130
Distortion Effect  135
Dock in Browser  104

customizing  105
Dual Stereo, routing mode  16, 26, 47

E
Echo, effect  134
Effects

amount  132
Bliss  135
Brake  136
Chopper  135
Crush  135
Delay  134
depth  132
Echo  134
Flanger  135
Hi-Pass  134
Jet  135
low-Pass  134
master channel  133
Phaser  134
Roll  136
Transform  135

Effects (cont.)
Use bidimensional FX  132
X-Phaser  135

Enable/Disable link  145
End of Track Alarm, setting  101
Equalizer  79
External Audio Sources   18
External Mixer Cue, routing mode  18, 

35, 47
External Mixer Mode  16

configuring U-MIX CONTROL  
PRo 2  27

signal flow  16
timecode  22

External Mixer Sampler, routing mode  
17, 35, 47

F
Flanger, effect  135
Flexible Mode  91
Folder, create new  109
Forward Playback and Timecode  20
Full link Mode  145
Full Screen  81
FX zone  77, 132

G
Gain analysis  85
Gain knob  79

H
Hi-Pass, effect  134
Hold, sample playback mode  140
Hot Cues, see locators
Hot-Sampling  138
Hybrid, Pitch Mode  119

I
Import

collections from other  
DJ software  83

Directory  82 
file  82
folders  82
playlist  82 
tracks from iTunes  82
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Independent Mode  145, 147
Input 1, setting  42
Input 2, setting  42
Input Gain, sliders  43
Installation

Mac oS X  13
Windows  10

Internal Mixer Mode  15
Signal flow  16

iTunes  82

J
Jet, effect  135

L
language setting  76
lead In/lead out, setting  101
license Key  14
limiter, toolbar  76
link mode, sampler  145
load

sample from collection  138
tracks  91

locate missing tracks  116
locators  126

and snap setting  127
change order  128
change/set name  127
deleting  128
for loops  128
jumping to  127
setting  127

loop
create  122
move  124
sample playback mode  140

low-Pass, effect  134

M
Master Channel, effects  133
Master Tempo 

and CDJ-Player  20
Pitch Mode  118

MIDI messages  23
MIDI Presets  49
Missing tracks  116

Mix, crossfader setting  100
Mixer

bi-polar filter  79
channel faders  79
cross fader  80
Cue/Monitor buttons  79
equalizer  79
gain knob  79
Mute button  79

Mixer Mode
external  16
internal  15

Mixer panel  79
Mix Recorder

configuration  129
recording  130

Move tracks in playlist  111
MP3 Player, integration of  18
Mute button, mixer panel  79
Mute sample  138

N
Naming Pattern, recording  129

P
Pad Index, sample bank  144
Peak analysis  85
Peak Folder  149
Phaser, effect  134
Pitch Bending  120
Pitch Fader  119
Pitch Mode  118, 147
Playback mode, sample  138
Player

CD mode  101
end of track alarm  101
lead in/lead out  101
overview  77
vinyl mode  101
waveform scroll mode  101
waveform zoom  101

Playlist
add tracks  111
create empty  110
create from iTunes  111
create from listview  110
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Playlist (cont.)
delete tracks  111
move tracks  111

Preview Player  102

Q
Quality of the track  106
Quantization  121

R
Range, pitch fader  119
Recording,  see Mix Recorder
Rekordbox playlist  83
Relative link Mode  145
Relocate  116
Remote Apps  63

setup on Windows 7  67
setup on Windows XP  64

Roll, effect  136
Rolling Frequency Parameter  140
Routing Mode  47

S
Sample

change Instrument property  144
change Type property  144
hot-sampling  138
load from collection  138
mute  138
pitch mode  147
playback mode  138, 140
rolling frequency  140
save to disk  139
start/stop  139
unmute  138

Sample Banks
change pad index  144
create empty  142
create from listview  143
edit sample properties  144
load  142
rename  142
save  137, 141

Sample directory, setting  139

Samplers
link mode  145
open samplers panel  137
overview  79
using effects  133

Save changes in Tags  115
Searching for Tracks  108
Security Mode, setting  93
Show Beatgrids  96
Simple Stereo, routing mode  47
Smartlists  111

create new  114
edit  112

Smart Seek  101
Snap length  121
Snapping  121
Speed, Pitch Mode  118
Split Mono, routing mode  48
Start sample  139
Stop sample  139
Synchronisation

players and samplers  144, 147
select mode  98

Sync Meter  97
in sampler  147

Sync zone  77
Quantize  121
Snap  121

T
Timecode

CDJ Master Tempo  20
detecting forward/backwards  20
external mixer  22
functional princip  20
playback speed  20
position detection  21
timecode signal  20
turntable flutter  20

Timecode Control Mode
absolute mode  90
flexible mode  91
relative mode  90

Timecode Settings  38
Timecode Setup  36
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Toolbar  76
limiter  76
volume section  76

Track Meta Information  115
Tracks Resolver  116
Traktor collection  83
Transform, effect  135
Turntable Brake, effect  136

U
U46MK2 ,technical specifications  163
U-MIX CoNTRol PRo 2  23

activate effect  133
activate loop  123
change sample playback mode  140
configuring for external mixer  

mode  27
crossfader curve  80
enable/disable link between player 

and sampler  138
hot-sampling  139
loading tracks  91
master volume  76
MIDI messages  158
move loop  124
pitch bending  120
pitch controls  94
select effect  133
select input for FX  133
select loop length  123
smart seek  102
start/stop sample  139
SyNC button  94
technical specifications  166
using cue points  125
using locators  127

Unmute sample  138
Use bidimensional FX  132
User sample directory, setting  139

V
Vinyl Mode, player  101
Virtual DJ database  83
Volume, sample  138
Volume section, toolbar  76

W
Waveform Scroll Mode, button  101
Waveform zoom  101
White Noise Generator  135

X
X-Phaser, effect  135
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